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About this guide

This user guide contains the instructions necessary to operate and maintain your BD® FACSymphony™ S6 cell
sorter. Because many instrument functions are controlled by BD FACSDiva™ software, this guide also contains
basic software information needed for instrument setup. For detailed information on software functions, see
the BD FACSDiva Software Reference Manual.

This user guide assumes you have a working knowledge of basic Microsoft® Windows® operation. If you are
not familiar with the Windows operating system, see the documentation provided with your computer.
Before using the BD FACSymphony™ S6 cell sorter for the first time, review the following information:

e System components (page 11) to become familiar with system components

¢ Theory of operation (page 33) to understand how the instrument works and to learn about the software
components used to control different subsystems

e Using BD FACSDiva™ software (page 55) to see where software controls are located

Instructions for routine acquisition, analysis, and sorting can be found in Chapters 4 and 5.
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Conventions

The following tables list conventions used throughout this guide. The first of the following tables list the
symbols that are used in this guide or on safety labels to alert you to a potential hazard. Text and keyboard
conventions are shown in the second table.

Meaning

Caution: hazard or unsafe practice that could result in material damage, data loss, minor or severe

injury, or death

Electrical danger

Laser radiation

Biological risk

Pinch hazard

> B> > B> B

1 Although these symbols appear in color on the instrument, they may be in black and white throughout the
printed user guide; their meaning remains unchanged.
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Technical assistance

For technical questions or assistance in solving a problem:

¢ Read the section of the user guide specific to the operation you are performing.

¢ See Troubleshooting (page 169)

If additional assistance is required, contact your local BD Biosciences technical support representative or
supplier. Visit our website, bdbiosciences.com, for up-to-date contact information.

When contacting BD Biosciences, have the following information available:

¢ Product name, part number, and serial number

* Any error messages

¢ Details of recent system performance

Limitations

This instrument is for Research Use Only. Not for use in diagnostic or therapeutic procedures.

BD Biosciences is providing software without warranty of any kind on an as-is basis. The software and
workstations are intended for running the instruments supplied by BD Biosciences. It is the responsibility of the
buyer/user to ensure that all added electronic files including software and transport media are virus-free. If the
workstation is used for internet access or purposes other than those specified by BD Biosciences, it is the
buyer/user’s responsibility to install and maintain up-to-date virus protection software. BD Biosciences does not
make any warranty with respect to the workstation remaining virus-free after installation. BD Biosciences is not
liable for any claims related to or resulting from the buyer/user's failure to install and maintain virus protection.

9
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System components

The following topics are covered in this chapter:

BD FACSymphony™ S6 Cell Sorter system (page 12)
Workstation (page 12)

Biosafety cabinet (page 13)

Flow cytometer (page 13)

Emergency stop button (page 31)
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BD FACSymphony™ S6 Cell Sorter system

The BD FACSymphony™ S6 cell sorter is a high-speed fixed-alignment benchtop cell sorter. With its fixed-optics
design and digital electronics, the BD FACSymphony™ S6 cell sorter enables multicolor analysis of up to 60
parameters, including two scatter parameters.

The system consists of three main components: the BD FACSymphony™ S6 cell sorter, the optional Biosafety
Cabinet (BSC), and the workstation, as shown in the following figure.

Workstation

Data acquisition and analysis, as well as most BD FACSymphony™ S6 cell sorter functions, are controlled by
BD FACSDiva™ software on a PC workstation. The workstation is equipped with the following applications:

¢ Microsoft® Windows® operating system
« BD FACSDiva™ software, version 9.5 or later
° Data acquisition and analysis
°  Automatic fluidics startup, shutdown, and cleaning modes
° Sort setup, stream monitoring, clog detection, and recovery
o BD® Cytometer Setup and Tracking (CS&T) module for setup and tracking performance

 Supporting documentation for the software
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For information about software features specific to the BD FACSymphony™ S6 cell sorter, see Theory of
operation (page 33) and Using BD FACSDiva™ software (page 55). For general software information, see the
BD FACSDiva™ Software Reference Manual.

BD FACSDiva™ software includes a BD® CS&T Research Beads module. For information on running the

BD® CS&T Research Beads module with the BD FACSymphony™ S6 cell sorter, see Checking cytometer
performance (page 99). For information about the BD® CS&T Research Beads module, see the BD® Cytometer
Setup and Tracking Application Guide.

Note: For easy access to the online BD FACSDiva™ Software Reference Manual, select Help > Documentation >
Reference Manual.

Biosafety cabinet

The optional BSC for the BD FACSymphony™ S6 cell sorter has been verified to meet personnel and product
protection standards for a Class II Type A2 biosafety cabinet, the National Sanitation Foundation International
Standard 49, and the Australian Standard® AS 2252.2-2009. The BSC is suitable for work with Biosafety Level
(BSL) 1, 2, and 3 (low to moderate risk) infectious agents.

The BSC has an integrated Aerosol Management System (AMS). See Aerosol Management System (page 210)
for information.

Flow cytometer

The BD FACSymphony™ S6 cell sorter consists of three subsystems (fluidics, optics, and electronics). The
cytometer requires only a 20-A electrical outlet and an in-house air source (or optional compressor) for the
fluidics. The following figure shows a view of the BD FACSymphony™ S6 cell sorter without the optional BSC.

Flow cell access door

Sort collection
chamber door
with air filter

Optics Fluidics chamber
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See the following sections for more information on each subsytem:
* Fluidics system (page 14)

¢ Optics system (page 25)

¢ Cytometer electronics (page 29)

Fluidics system

The fluidics system supplies sheath and cleaning fluids, and collects waste from the cytometer. The contents of
the fluidics drawer and the fluidics components located inside the cytometer make up the fluidics system.

Fluidics drawer

The fluid containers, lines, and filters, and the connectors panel are located inside the fluidics drawer. The
fluidics drawer slides out for easy access to its contents. Press down the yellow lever on the top right side of the
drawer to release the lock and slide the drawer out or in.
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Containers

The fluidics drawer holds a 10-L stainless steel sheath tank, a 5-L stainless steel ethanol shutdown tank, a 10-L
waste container, and three 5-L auxiliary cleaning fluid containers.

Item number | Component

1 DI water tank

2 BD FACSClean™ solution tank

3 Connector panel

4 Ethanol shutdown tank

5 Ethanol tank

6 Sheath tank with pressure gauge
7 Waste tank
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Pressure gauge

A pressure gauge is located on the sheath fluid tank to confirm that the tank is pressurized.

Fluid filters

The fluid filters for DI water, BD FACSClean™ cleaning solution, and ethanol are located in the outside left panel
of the fluidics drawer.

Connectors panel

The connectors panel is located in the top right section of the fluidics drawer. A fluid line and a sensor connect
each container to the panel.

-
Wil

Fluid m) Simath

- - - _ -
@9 ? % ? ©@©
Sensor Sensor Sensor Waste line Fluid out

Fluid in Fluid in Fluid in Waste out Waste sensor Sensor

Fluidics components

When the fluidics system is activated, the sheath fluid from the pressurized sheath tank is forced from the
fluidics drawer up into the cuvette flow cell where hydrodynamic focusing forces particles from the sample
injection chamber through the cuvette in a single-file stream.
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Within the cuvette flow cell, laser light is focused on the sample core stream. Fluorescent molecules excited by
the different laser wavelengths are detected by the optics and analyzed by the electronics. Particles are then
either transported to waste reservoirs via the waste aspirator, or sorted into a collection device within the sort
collection chamber.

The following fluidics components are described in this section. For more information about fluidics, see Fluid
movement (page 34).

¢ Sample injection chamber (page 17)

¢ Tube holders (page 18)

¢ Cuvette flow cell (page 19)

¢ Integrated nozzle (page 19)

¢ Sort block (page 20)

¢ Sort collection devices for 2- and 4-way sorting (page 22)

Sample injection chamber

The sample injection chamber is where sample is introduced into the flow cytometer. During acquisition, the
chamber is pressurized to force sample toward the cuvette flow cell.

Samples can be agitated and temperature-controlled within the sample injection chamber using controls in the
software (see Fluidics controls (page 56)). You can view the amount of fluid remaining in your sample tube by
pressing the chamber light button shown in the following figure.

A Do not use the chamber light for long periods with samples stained with light-sensitive reagents.
Sample
injection ——
chamber
—————
f | Chamber light
button

Tube holder Sample access
door

Sample
loading
port

Bubble detector

The bubble detector is an optical sensor that detects air bubbles from the sample tube. Located on the sample
line just before the pinch valve, it triggers the pinch valve to close, cutting off sample flow and preventing
bubbles from entering the flow cell. When a bubble is detected, the bulk injection chamber light and LED in the
button blink to alert the operator.

17
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Bubble detector

Tube holders

A variety of tube holders are provided with the cytometer to accommodate tubes from 15-mL centrifuge tubes
to 1.0-mL microtubes.

To load a tube, install the appropriate-size tube holder onto the loading port, and place a tube in the holder.
Make sure to press the tube holder down firmly onto the metal rod in the loading port, so the tube holder is
seated correctly each time a tube is installed.

When the Load button is clicked in the software (see Acquisition controls (page 68)), the loading port rises to
enclose the tube within the chamber. The chamber is then pressurized so that sample will flow to the flow cell.

1.5mL
1.2 x 75 mm
L h et
Tube holders
T
L

1 mL microtube

After a tube is loaded, the Load button changes to Unload. Click the Unload button to lower the loading port
after data has been recorded. After each tube is unloaded, sheath fluid flushes the sample tubing inside and
out to reduce potential sample carryover.
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A To prevent injury from moving parts, keep your hands and clothing away from the loading port when

a tube is loading or unloading. Do not place objects under the loading port.

Cuvette flow cell

The BD FACSymphony™ S6 cell sorter system includes a next-generation flow cell. The cuvette flow cell is the
heart of the BD FACSymphony™ S6 cell sorter. Within the flow cell, hydrodynamic focusing forces particles
through the cuvette in a single-file stream, where laser light intercepts the stream at the sample interrogation
point.

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser control
software to put the lasers in standby and then close the laser control software. This will turn off the laser diode,
but will keep the diode temperature constant.

Flow cell

Laser beams Lil ) )
| Interrogation point

| Nozle

Nozzle locking

O lever

The unique flow cell design permits particles to flow through the cuvette at a low velocity (approximately 6
meters per second for the 70-micron sort setup), allowing longer exposure to laser energy. The cuvette is gel-
coupled to the fluorescence objective lens to transmit the greatest amount of emitted light from the
interrogation point to the collection optics (see Optics system (page 25)). After passing through the cuvette, the
stream is accelerated (to approximately 30 meters per second with the 70-micron sort setup) as it enters the
nozzle tip, where the drop drive breaks the stream into droplets for sorting.

Integrated nozzle

The BD FACSymphony™ S6 cell sorter next-generation flow cell requires integrated nozzles that have been
optimized for it.

The integrated nozzles are available in four sizes (70, 85, 100, and an optional 130 pm) to accommodate a
variety of particle sizes, plus a closed-loop nozzle for use in cleaning and shutdown procedures. The nozzle is
keyed to a fixed position at the lower end of the cuvette. Because the nozzle is below the interrogation point,
optical alignment is not affected when the nozzle is changed.

~—T ] \~—/'\| MS indicates integrated nozzle for
© % the BD FACSymphony™ S6 cell sorter
—J flow cell

Bottom view of nozzle

19
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See these sections for more information on the nozzle:
¢ Changing the integrated nozzle (page 155)
¢ Cleaning the integrated nozzle (page 156)
¢ Handling the integrated nozzle (page 158)

Sort block

After leaving the nozzle, particles pass through the sort block where they are either transported to waste via the
waste aspirator, or sorted into a collection device in the sort collection chamber. The sort block houses the high-
voltage deflection plates, along with the aspirator and aspirator drawer.

Deflection plates

Adjustment screws

Aspirator

Aspirator drawer

Sort collection
device

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser control
software to put the lasers in standby and then close the laser control software. This will turn off the laser diode,
but will keep the diode temperature constant.

The entire sort block assembly can be rotated on a fixed pivot point to adjust the position of the stream in the
waste aspirator. If the keyed stream position differs between different nozzles, the stream might not hit the
center of the aspirator after the nozzle is changed. In this case, you can change the angle of the sort block by
loosening the adjustment screws on both sides of the deflection plates and rotating the sort block. An Allen
wrench is provided in the accessory kit. Tighten the screws when the stream is re-centered in the aspirator.

Deflection plates

The high-voltage deflection plates are used to deflect side streams during sorting. The plates are turned on and
off using the Voltage control in the Side Stream window (see Side Stream Formation (page 47)). A red warning
light is illuminated whenever the plate voltage is on.
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A A 12,000-volt potential exists between the deflection plates when they are on. Contact with the
charged plates results in serious electrical shock. Do not touch the deflection plates when the voltage
warning light is illuminated, or when the software indicates that the plate voltage is on. The plates

remain energized even when the sort block door is open.

Aspirator drawer

The aspirator drawer keeps the sort collection tubes covered until sorting begins. You can open and close the
drawer using a control in the Sort Layout or Side Stream window (see Using Sorting Controls (page 74)). When
the Sweet Spot is on and a clog is detected during sorting, the drawer automatically closes to protect the sort
collection tubes. For information on how to handle a clog, see Sorting (page 127).

fé To avoid pinching your hands or fingers in the drawer, keep your hands away from the sort block
during sorting.

| |

@, é@

-

—

o T &

Aerosol management

During sample acquisition and sorting, the sort block door and flow cell access door should be kept closed to
help contain potential aerosols.

Cell sorters that use droplet generation methods, such as the BD FACSymphony™ S6 cell sorter, can
produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal
precautions at all times. Keep the sort block door closed during sorting. If you need to access the sort
block and you are working with highly infectious samples, consider turning off the stream before
opening the sort block door.

21
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Hydrophobic
filter, included
with the AMO
Deflection plates
warning light
Sort block

Additional aerosol removal is provided by either the AMS or the BD® Aerosol Management Option (AMO).

The AMS is integrated into the BSC and contains a high efficiency particulate air (HEPA) filter. See Operating
the AMS (page 211) for instructions.

The AMO is an optional device for systems without a BSC. The AMO evacuates the sort collection chamber
during sorting and is equipped with an ultra-low penetrating air (ULPA) filter to trap aerosolized particles. See
BD® Aerosol Management Option (page 191) for complete information on using this option.

Sort collection devices for 2- and 4-way sorting

Collection devices are installed in the sort collection chamber to collect sorted samples. The collection devices
are designed in two pieces with a universal top that can be used with different tube configurations. The
universal top has three holes on the back side that help with aerosol evacuation when an AMO or AMS is
installed.
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1 Enclosed top (front view)

2 Enclosed top (back view)

3 Four-way 1 mL (optional)

A Four-way 12 x 75 mm

5 Four-way 1.5 mL Eppendorf
6 Two-way 12 x 75 mm

7 Two-way 15 mL
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Sort collection devices for 4- and 6-way sorting

i & BD sore \ 2 @ BD sore

@
@

BBD sonr ®

1 Upper tube holder mount

2 6-way 12 x 75 mm

3 6-way 1.5 mL

4 Left: 50 mL; Right: 3-way 12 x 75 mm

5 4-way; Outside: 12 x 75 mm; Inside: 15 mL
6 Four-way 15 mL
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A transparent amber 6-way sort collection device with integrated tube holder mount is also available as shown
in the following diagram.

—0

o o S
- e ® @ S

— =

1 6-way 5 mL tube holder top

2 6-way 5 mL amber tube holder

An automated cell deposition unit (ACDU) holds multi-well plates and slides for sort collection. The sort
collection chamber door should be kept closed when sorting onto a plate. The door keeps the chamber free of

dust and other airborne particles, and seals the chamber during aerosol evacuation for cytometers equipped
with the AMO.
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Optics system

The BD FACSymphony™ S6 cell sorter uses innovative designs for both the excitation and collection optics.
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Excitation optics
The excitation optics consist of lasers, beam steering optics, and focusing lenses.
For information about how signals are generated, see Signal generation (page 36).

The BD FACSymphony™ S6 cell sorter uses air-cooled and solid state lasers that do not have special power or
cooling requirements.

The system also supports up to 9 installed lasers.

& Lasers emit intense, coherent electromagnetic radiation that can cause irreparable damage to skin
and eyes. To prevent retinal burns and possible blindness, do not remove laser shielding, defeat
interlocks, or attempt to service the cytometer in any location where laser warning labels are
attached. See the BD FACSymphony™ S6 cell sorter Safety and Limitations Guide for the placement of

laser warning labels.

Steering optics direct the laser light in a precise and constant manner onto a focusing lens. The lens focuses the
laser light onto the sample core stream within the cuvette flow cell. The lasers are positioned on the sample
stream for optimal generation of signals. Since the optical pathway and sample core stream are fixed,
optimization is constant from day to day.

Collection optics

From the cuvette flow cell, laser light is collected by a fluorescence objective lens that is gel-coupled to the
cuvette to transmit the maximum amount of light. The lens collects and focuses fluorescent light emitted at
each of the laser focal points onto individual collection fibers. These fibers transfer the emitted light to the
collection optics, as shown in the following figure.

Stream ~

/ Cuvette flow cell
Individual collection
fibers

\ -

Fluorescence objective lens

Nozzle

The collection optics are set up in high-parameter cascade (HPC) arrays that are engineered to maximize signal
detection from each laser. This is accomplished by transmitting the highest wavelengths to the first
photomultiplier tube (PMT), and reflecting lower wavelengths to the next PMT through a series of longpass
dichroic mirrors. Bandpass filters in front of each PMT allow fine-tuning of the spectral wavelengths that need
to be collected. Since reflection is more efficient than transmission, this design greatly increases the multicolor
detection capabilities of the cytometer.
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Detectors

The following figure shows the locations of detector arrays in a 5-laser system on the electronics cabinet.
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Stream-viewing optics

The BD FACSymphony™ S6 cell sorter is equipped with optical components that are used to view the stream.

e The upper camera generates an image used to monitor drop formation. It is focused on the stream, just
below the nozzle, to provide an image of the drop breakoff.

¢ The lower camera generates an image used for the BD FACS™ Accudrop option. It enhances the ability to
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see the side streams and assists in setting an accurate drop-delay value.

w "0 N .
T g )

= |
¥ .I‘- 4

Upper
camera

A T
Diode T :
laser Pk Ilhii

. o
4

Micrometer dial Lower camera viewing window

Special image-processing software allows you to view the stream images from each camera within separate
windows in BD FACSDiva™ software. See Sorting (page 43) for more information about viewing the streams
and to learn how Accudrop components are used to determine the drop delay.

Cytometer electronics

The electronic components consist of the power and air supply panels along with processing boards in the card
cage. The power and air supply panels are located on the right side of the cytometer base in the lower left
corner. Other electronic components are embedded within the cytometer and do not need adjustment. This
section describes only adjustable cytometer electronics. For more information about the electronics, see Signal
detection (page 37).

Power and operation
Power to the BD FACSymphony™ S6 cell sorter is supplied by a power cord plugged directly into a standard
electrical outlet. The optional BSC is hard-wired to the in-house electrical system.

Power panel

The power panel contains the power button, a USB port for BD service, an ethernet connection, connectors for
the stream-viewing cameras, and a serial communications cable.

29
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Power panel for analog cameras:

Outlet for serial
communications
cable

Power Laser Ethernet  Connectors to
button connection to PC upper and
USB lower cameras

Power panel for digital cameras:

Power Connections to Ethernet Outlet for serial
button digital cameras and laser to PC communications
cable
Air supply panel

The air supply panel is located to the right of the power panel. The air supply panel contains the external air
reqgulator, air pressure gauge, power cord, external air input connector, and the cytometer circuit breaker. Air
pressure is adjusted using BD FACSDiva™ software.

" -

Connecting to the external air supply

The BD FACSymphony™ S6 cell sorter system requires an external (in-house) air source or optional compressor
to operate.
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To connect the fluidics to the external air supply, switch on the external air, if necessary. Attach the external air
line to the external air input connector. The external air supply must provide 6.6—-6.9 Bar (95-100 PSI)
regulated. The source of the compressed air must deliver clean (<5 ppm) dry-filtered (oil-free) air at stable
pressures.

Emergency stop button

The emergency stop button is a safety feature that can be used to stop the movement of the loading port and
ACDU stage. The emergency stop button is located on the front of the optics drawer. The button lights up when
a tube is loading to remind you to keep your hands away from the loading port.

Emergency 7y
stop button ™

The following occur when this button is pushed:
¢ The software displays the following message:

() System
Emergency stop button is engaged.

' ! Fluidics and sorting have stopped.
- Disengage the emergency stop button to continue.

¢ The tube is unloaded from the sample injection chamber.

e The ACDU stage (if in use) stops moving.
¢ The stream is turned off.
¢ The deflection plate voltage is turned off.

e The aspirator drawer (if open) closes to protect the sort collection tubes.
Note: The emergency stop button does not turn off the lasers or shut down the cytometer main power.

To reset the button, slowly turn the button clockwise until the light turns off and the button returns to its
original position.
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Theory of operation

This chapter describes how the BD FACSymphony™ S6 cell sorter works and how BD FACSDiva™ software

controls are used to operate different system components. For a general overview of the software, see Using
BD FACSDiva™ software (page 55).

See the following sections for a description of these BD FACSymphony™ S6 cell sorter functions:
¢ Fluid movement (page 34)

 Signal generation (page 36)
 Signal detection (page 37)
¢ Sorting (page 43)
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Fluid movement

The fluidics system is responsible for moving particles from the sample injection chamber through the cuvette
flow cell for interrogation, and then to waste or into a collection device during sorting. The following sections
describe the controls used to move fluids through the BD FACSymphony™ S6 cell sorter fluidics system.

SHEATH FLOW SAMPLE FLOW

sheath tank sample tube

U U

sample injection

sheath filter

chamber
pinch valve
cuvette flow
cell
interrogation
point
. I tor <_/ x sample collection
asteleiRirato chamber

I

collection tube
or plate

Sheath flow

When you turn on the cytometer, the external air compressor must be turned on or house air must be supplied
to the system. The fluidics system is activated when you select the Fluidics Startup command in BD FACSDiva™
software. During fluidics startup, sheath fluid is forced from the pressurized sheath tank through a filter and is
delivered to the cuvette flow cell at a constant pressure. You can view the current sheath pressure setting by
selecting Cytometer > Sheath Pressure.
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After fluidics startup, sheath flow is controlled using the Stream button in the Breakoff window. When clicked,
the button changes from a red “X” to a green check mark, and sheath flows through the cuvette flow cell at the
rate that is specified in the Sheath Pressure dialog. (See Drop Formation (page 43) for a complete description of
the Breakoff window.)
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As a general rule, the sheath pressure level is set by selecting a sort setup mode from the Sort menu, rather than
by adjusting the sheath pressure control. Each sort setup mode is optimized at a preset sheath pressure. If you
change the sheath pressure, a multitude of other values will be affected and need updating, including the drop-
drive frequency, drop-delay value, laser delay, area scaling factor, and other values. For more information, see
Sort setup (page 70).

Sample flow

Sample is introduced into the cuvette when the Load button is clicked on the Acquisition Dashboard. After Load
is clicked, the loading port rises to enclose the tube within the sample injection chamber. The chamber is
automatically pressurized and the chamber pressure forces sample through the sample line into the cuvette
flow cell. To stop sample flow after a tube is loaded, click the Stop Acquiring button.

The sample flow rate is specified using the Flow Rate field on the Acquisition Dashboard. You can adjust the
flow rate from 1-11, which corresponds to approximately 10-80 pL/minute.
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Note: The relatively longer sample tubing on the BD FACSymphony™ S6 cell sorter results in a different flow
rate between cells and beads. Thus, absolute counting using BD Trucount™ Beads can yield erroneous results.

Hydrodynamic focusing

In the flow cell, pressurized sheath fluid surrounds the sample fluid to hydrodynamically focus the core stream
of suspended cells into the center of the cuvette, where the particles are intercepted by the laser beam.

The difference in pressure between the sheath fluid and the sample fluid can be used to vary the diameter of
the sample core. A lower difference results in a relatively narrow core stream, while a higher difference results in
a wider sample stream.

Sheath flow Sheath flow Shieath flow Sheath flow

\ Sample flow sample flow
v \

Laser beams - Laser beams

Low flow rate High flow rate
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Ideally, you want the core stream at its minimum diameter so that cells pass through the laser beam in a single-
file stream. However, depending on your application, a lower resolution might be acceptable in order to acquire
the data more quickly. For example, with this three-laser configuration, a higher flow rate is generally used for
qualitative measurements such as immunophenotyping—the data is less resolved but is acquired more quickly.
A lower flow rate is generally used in applications for which greater resolution is critical.

Signal generation

The following sections describe how signals are generated when cells or particles intercept the laser within the
cuvette flow cell.

Light scatter

When a cell or particle passes through a focused laser beam, laser light is scattered in all directions. Light that
scatters axial to the laser beam is called forward scatter (FSC). Light that scatters perpendicular to the laser
beam is called side scatter (SSC). FSC and SSC are related to certain physical properties of cells:

» FSCindicates relative differences in the size of the cells or particles.
e SSCindicates relative differences in the internal complexity or granularity of the cells or particles.

Fluorescence signals

When cells or particles stained with fluorochrome-conjugated antibodies or other dyes pass through a laser
beam, the dyes can absorb photons (energy) and be promoted to an excited electronic state. In returning to
their ground state, the dyes release energy, most of which is emitted as light. This light emission is known as
fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the excitation wavelength. The
difference between the excitation wavelength and the emission wavelength is known as the Stokes shift. Some
fluorescent compounds such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and emitting
red light (675 nm), while other fluorochromes such as FITC have a smaller Stokes shift, absorbing blue light and
emitting green light (530 nm).

The emission spectra for some commonly used fluorochromes are shown in the following figure.
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Signal detection

From the cuvette flow cell, scattered and fluorescent light is collected by the fluorescence objective lens. The
lens collects and focuses fluorescent light emitted at each of the laser focal points onto individual collection
fibers. These fibers transfer the emitted light to the individual detector arrays.

The following sections describe how laser light is detected and translated into signals that can be displayed in a
plot.
Detector arrays

The BD FACSymphony™ S6 cell sorter has HPC detector arrays. Each detector array houses dichroic and
bandpass filters, which steer and filter the emitted light, and PMTs, which detect light signals.
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Filters

Optical filters modify the spectral distribution of light scatter and fluorescence directed to the detectors. Three
kinds of filters are used in the detector arrays. Longpass (LP) filters are used to steer light between the detectors
within a detector array, while bandpass (BP) and neutral density (ND) filters allow fine-tuning of the spectral
wavelengths that need to be collected.

Longpass filters

LP filters pass wavelengths longer than the filter rating and reflect shorter wavelengths. For example, a 500 LP
filter permits wavelengths longer than 500 nm to pass through it and reflects wavelengths shorter than 500
nm.

1061

Dichroic filters that are used to direct different color light signals to different detectors are called dichroic
mirrors or beam splitters.

Although dichroic mirrors have the properties of LP optical filters, you cannot necessarily use any type of LP
filter as a beam splitter. A beam splitter must have a surface coating that reflects certain wavelengths, but
many types of LP filters are absorbance filters that do not have any specific reflective characteristics. Also,
optical filters and beam splitters are rated at a specific angle of incidence. When used as a beam splitter, they
are placed at an angle relative to the light source. Their optical properties are therefore designed for that angle
of incidence.

The detector arrays use LP dichroic mirrors to steer progressively shorter wavelengths of light to the next PMT in
the array. For example, in the HPC array, light first passes through a 735 LP filter in the A position, followed by a
655 LP filter in the B position. Thus, wavelengths longer than 735 nm are detected at PMT-A. All wavelengths
<735 nm are reflected to PMT-B. Wavelengths between 655 nm and 735 nm are detected at PMT-B. All
wavelengths <655 nm are reflected to PMT-C, and so on.

Bandpass filters

BP filters transmit a relatively narrow range or band of light. Bandpass filters are typically designated by two
numbers. The first number indicates the center wavelength and the second refers to the width of the band of
light that is passed. For example, a 500/50 BP filter transmits light that is centered at 500 nm and has a total
bandwidth of 50 nm. Therefore, this filter transmits light between 475 and 525 nm.
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Discriminating (DF) filters have the same general function—they transmit a relatively narrow band of light. The
principal difference between BP and DF filters is their construction. DF filters have more cavities or layers of
optical coatings, resulting in a steeper transmission curve than the curve for a BP filter. This steep slope means
that a DF filter is better at blocking light outside the rated bandwidth of the filter.
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In the detector arrays, DF filters block high-intensity laser light and filter the remaining light to ensure that only
the required wavelengths reach their intended detector. For example, in the HPC array, PMT-A has a 780/60 DF

filter in front of it, which transmits light of 750-810 nm. Thus, the only wavelengths that will reach the A
detector are those between 750 and 810 nm.

For optimal detection of fluorescent light, a bandpass filter must always be installed in front of each detector.

Neutral density filters

ND filters transmit a fixed percentage of light, reducing the transmitted intensity of all wavelengths equally. ND
filters are neutral with respect to wavelength.

5 @
. 2 107

The ND1 filter on the BD FACSymphony™ S6 cell sorter allows approximately 10% of the light to be transmitted.

The FSC detector has an ND filter placed in front of the 488/10 BP filter. The percentage of light needed for
detection is based on particle size. For applications involving small particles (for example, bacteria or platelets),
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you might need to remove the FSC ND filter. For applications involving large particles for which events appear
off scale on the FSC axis with a gain of zero, a higher value ND filter is needed to decrease the FSC signal and
keep the events on scale.

The system comes with three ND filters: 1.0, 1.5, and 2.0, where the transmission percentage is 10%, 3%, and
1%, respectively. See Removing or installing the FSC ND filter (page 168).

Detectors

Detectors within each detector array convert light signals into electrical signals that can be processed by the
electronics system.

There are two types of signal detectors in the BD FACSymphony™ S6 cell sorter flow cytometer: the photodiode

and PMTs. The photodiode is less sensitive to light signals than the PMTs, and is used to detect the stronger FSC
signal. The photodiode detects FSC light from the blue laser, and is stored outside the detector arrays. PMTs are
used to detect the weaker signals generated by SSC and all fluorescence channels.

In BD FACSDiva™ software, the Cytometer Configuration window lets you define which fluorochromes or cell
parameters will be measured at each PMT detector. If more than one fluorochrome is measured using the same
PMT, you can add additional parameters to your configuration and select the appropriate fluorochrome within
your software experiment. See Cytometer configuration (page 59) for more information.

Electronic processing

As cells or other particles pass through the focused laser beams, they scatter the laser light and can emit
fluorescence. Because each laser beam is focused on a small spot and particles move rapidly through the flow
cell, the scatter or fluorescence emission has a very brief duration—only a few microseconds. The PMTs convert
this brief flash of light into an electrical signal called a pulse.

SR

No. Description

1 A pulse begins when a particle enters the laser beam. At this point, both the beam intensity and signal intensity
are low.
2 The pulse reaches a maximum intensity or height when the particle reaches the middle of the beam, where the

beam and signal intensity are the brightest. The peak intensity, or height of the pulse, is measured at this point.

3 As the particle leaves the beam, the pulse trails off.

Pulse parameters

A parameter is a pulse property that is generated by a single PMT or photodiode, measuring fluorescent or
scattered light. You can measure three characteristics of a pulse: area, height, and width. The pulse height
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measures the maximum digitized value for the pulse, the pulse area calculates the sum of all height areas for
the pulse, and the pulse width measures the time that the signal is above the threshold.

A

intensity ———>

signal

pulse height

pulse
area

Y

> time —=>
pulse
width

You can select which pulse characteristics you want to measure for each parameter using the Parameters tab.
Pulse area (A) is measured by default. The Parameters tab also contains voltage controls that allow you to
amplify signals by applying a voltage to PMTs or an electronic gain to the FSC signal. As the voltage is
increased, the detector sensitivity increases, resulting in increased signal. As the voltage is decreased, the
detector sensitivity decreases, resulting in decreased signal.
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Digital data is displayed on an 25-bit linear scale, from 2.6-33,554,432. Select the Log checkbox to convert the
display to a log scale. The Experiment Inspector contains an option to display log data on a four- or five-decade
scale. (See the BD FACSDiva™ Software Reference Manual for more information.)
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Laser delay

Sample interrogation takes place within the cuvette flow cell. Fiber optic cables are used to direct laser light
through a series of prisms that focus each laser on the stream at a separate position. This allows optimal
detection of fluorescence signals from each laser with minimal cross-contamination from the other beams.

In a three-laser system, the red laser intercepts the stream first, followed by the blue and then the violet laser.
Because the laser signals are spatially separated, there is a slight delay between the detection of each laser’s
signal.

Cell enters and leaves i i Red

the first laser intercept

Cell enters and leaves ﬂ
the second laser intercept Blue
Cell enters and leaves
the third laser intercept ﬂ
Violet
Time = i

The delay factor in BD FACSDiva™ software is used to realign the signals so they can be measured and
displayed on the same time scale. Signals are aligned with respect to the blue laser, so some lasers may have a
negative delay value.

Laser delay is set automatically when you use the CS&T module. For information about manually adjusting the
laser delay, see Manual adjustment of laser delay (page 116).
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Sorting

While sorting, drop-drive energy is applied to the stream to break it into highly uniform droplets. Droplets
detach from the stream a few millimeters downstream from the nozzle. The time between when a particle
intercepts the laser and when it reaches the droplet breakoff point is determined using BD FACS™ Accudrop
technology (see Drop-Delay Overview (page 49)).

When a particle is detected and meets the predefined sorting criteria, an electrical charge is applied to the
stream just as the droplet containing that particle breaks off from the stream. Once broken off from the stream,
the droplet—now surrounded by air—still retains its charge. The charged droplet passes by two strongly
charged deflection plates. Electrostatic attraction and repulsion cause each charged droplet to be deflected to
the left or right, depending on the droplet’s charge polarity. Uncharged droplets are not affected by the electric
field and pass down the center to the waste aspirator.

The following sections describe how the BD FACSymphony™ S6 cell sorter creates and charges drops, how the
drops are deflected, and how sorting populations are identified.

L "
(—"1"11/!
Mt [ wE) | 1) No. | Description
| | :I {a e 1 Charge is applied via the stream-charging wire in the barb.
iy 1)
la - I b 2 The sample generates light scatter and fluorescence signal.
| The signal is analyzed.
_' 3 The charged droplet breaks off.
! -~ 5x' 4 Deflection plates attract or repel the charged droplet.
= = ..r—|. 5
o i e 5 Uncharged droplets pass to waste.
f 1 L 1 = 6 Charged drops containing particles of interest are collected.
r .

Drop Formation

The BD FACSymphony™ S6 cell sorter constantly applies drop-drive energy to the stream. Droplets form as soon
as you turn on the stream. Sample interrogation takes place upstream of the stream vibration so that analysis
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is not affected by the drop drive.

A drop breakoff image is created using an LED strobe and a video camera. The image is displayed in the
Breakoff window (see Breakoff Window (page 45)). Patented Sweet Spot technology analyzes the drop breakoff
image and provides feedback to the appropriate controls.
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Breakoff Window

Use the Breakoff window to control a number of aspects related to drop formation.

Control Description
Stream Turns the stream on and off. ol
button
B
Sweet Spot Enables automatic adjustment of the drop-drive amplitude to maintain the §
button stability of the breakoff point.
3 i When the Sweet Spot is on, the Amplitude and Frequency fields are disabled. The ‘
o el amplitude is automatically adjusted by the software. To enable the fields, turn off *
the Sweet Spot.
L
Amplitude Adjusts the amplitude or intensity of the drop drive, from 1.0-80.0 volts.
field
The drop-drive amplitude determines the breakoff point. A higher amplitude value L
results in a shorter stream breakoff. A lower amplitude results in a longer stream
breakoff. Typically, the amplitude is set once, at the beginning of a sorting ®
experiment, and then maintained using the Sweet Spot. e
Frequency Determines the number of drops formed per second and the size of the drops. 8
field (Drop size is also influenced by the nozzle size.)
The drop-drive frequency can be adjusted from 1.0-102.0 kHz. The higher the s - =31
frequency, the more drops are generated per second and the smaller the drops. The | |r= -
lower the frequency, the fewer drops generated per second and the larger the : =i
drops.
Frequency In general, the drop-drive frequency should not need adjustment. We recommend using the default
field values that are entered with each Sort Setup mode.

(continued)

Drop 1 field | The distance between the top of the image and the center of the first broken-off drop, from 100-600
pixels.
When you enter a value and turn on the Sweet Spot, the cytometer automatically adjusts the amplitude
to attain your target value.
NOTE Not all Drop 1 targets are attainable. The Drop 1 value jumps in whole increments of
approximately 57 pixels according to your drop spacing.
The same Drop 1 setting can be used from day to day. A difference of up to 10 pixels between the target
value and the actual value is acceptable.

Gap field This represents the gap between the stream breakoff and the top of the first drop.

The default Gap setting for a 70-micron nozzle is 6 pixels.
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Breakoff Functionality

The upper camera transmits an image of the drop breakoff to the Breakoff window, where video image
processing software converts the visual characteristics of the image into numerical properties. The drop
breakoff is analyzed for two key features: Drop 1 and Gap.

Drop 1 is defined as the number of pixels from the top of the image to the center of gravity of the first broken-
off drop. A thin gray line on the image is used to identify this drop. The number shown to the right of the Drop 1
field at the bottom of the window is the actual pixel location of the gray line. The number entered into the Drop
1 field is the user-defined Drop 1 target.

The Gap is defined as the number of pixels from the first discontinuity in the stream to the next stream object,
generally the first broken-off drop. A gray line of varying thickness represents the Gap. The number shown to
the right of the Gap field is the pixel width of the gray line. The number entered into the Gap field is a user-
defined target.

FE When the Sweet Spot is turned on, the drop-drive amplitude (Ampl) is automatically

e adjusted to approximately match the target Drop 1 and Gap values. The amplitude is

H | Sweet Spot
A initially adjusted in larger increments until Drop 1 is achieved. The amplitude is then
adjusted in smaller increments until the cytometer attains the target Gap. The Sweet Spot
function will make adjustments as necessary to maintain the required breakoff conditions

bap throughout the day.

Gap is out of range, sorting is paused until the values are back within range. This ensures

| Drop 1

Y ‘ The Sweet Spot performs two other functions during sorting. When sorting, if the Drop 1 or
6 that sorting occurs only under the proper breakoff conditions. If a more severe problem

such as a clog is detected by the Sweet Spot, the stream is shut off and sorting is stopped,

the deflection plates shut off, the aspirator drawer closes, and the sample tube is unloaded.

Pre-programmed values can be downloaded to the Breakoff window by selecting one of the
nozzle sizes (70, 85, 100, or 130 micron) from the Sort > Sort Setup menu.

Changes to values in the Sort Setup windows (Breakoff and Side Stream) are automatically
and Sweet Spot controls, which always default to off. For more information, see Sort setup
(page 70).

Typically, when setting up for sorting, use the Amplitude to set the required drop breakoff,

L

L

Py saved. At startup, the last settings used on the cytometer are restored, except the Stream
o

A

Freg

==|

and copy the generated Drop 1 value to the target field. Then, turn on the Sweet Spot to

Dy 1 | 150

maintain the drop breakoff. When the Sweet Spot detects a >1-pixel difference between the

target Gap setting and the actual Gap, it adjusts the amplitude to reduce the Gap. When a
>2-pixel difference is detected, the Sweet Spot stops sorting temporarily (stops charging the
Target  Actual
u::ﬂa wi.. stream) until the Gap is restored. Note that when the sort is paused, the sample continues

to flow. Once the Gap is back within range, sorting automatically resumes.

For information on setting the breakoff, see Setting up the breakoff (page 92).
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Side Stream Formation

Side streams are formed when the voltage is on and a sort is in progress, or when you click Voltage, then Test
Sort in the Side Stream window.

The Side Stream window displays an image of the side streams as transmitted by the lower camera. In addition
to the stream image, the Side Stream window contains the controls used to adjust electrical charges and to
determine the drop delay using Accudrop, as described in Drop-Delay Overview (page 49).
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Controls in the Side Stream window are described in the following table. You can send different values to the
Side Stream window by selecting a nozzle size from the Sort > Sort Setup menu.

Note: Changes to values in the Sort Setup windows (Side Stream and Breakoff) are linked to the sort setup and
are automatically saved. At startup, the last settings used on the cytometer are restored, except the states of
the Voltage, Test Sort, and Optical Filter buttons, which always default to off. For more information, see Sort
setup (page 70).
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Control

Description

Voltage button

B

Turns the plate voltage on and off.

Test Sort button

PO

Generates test side streams based on test sort pulses.

Optical Filter button

- a

Controls the position of the optical filter in front of the lower (Accudrop) camera.

Attenuation button

i

Decreases the amplitude of the drop drive. At lower pressures, you may need to turn on
attenuation to dampen the amplitude.

Waste Drawer button

Opens or closes the aspirator drawer depending on its current state. The default state is closed.
For more information, see Aspirator drawer (page 21).

Drop Delay field

Sets the amount of time between when an event is measured and the breakoff point, from 10—
140 drops. The drop-delay value determines which drop will be deflected.

The drop-delay value is set in an experiment using BD FACS Accudrop technology.

Auto Delay

Opens the Auto Drop Delay dialog.

Voltage sliders (far left,
left, right, far right)

Set the percentage of charge to be applied to the corresponding stream (as a percentage of
maximum).

Voltage Center slider

Adjusts the relative voltage between the left and right plates which moves the streams slightly
to the left or right as a whole. In general, this slider rarely needs adjusting.

Plate Voltage field

Adjusts the total voltage difference between the plates, which determines the angle of stream
deflection. The voltage values change with different nozzle sizes.

2nd, 3rd, 4th Drop
fields

Apply a correction factor for the drop charge as a percentage of the previous drop, from —100%
to 100%.

Phase field

Adjusts the phase between drop generation and charging of the droplets from 0-360°.

The selected value is sent to both the drop-charging electrode and the drop strobe. In general,
the Phase does not need adjusting. You can keep the default value of zero.

Select Device

Collection device menu for setup of aspirator digital reference lines linked to a specific
collection device.
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Drop-Delay Overview

The BD FACSymphony™ S6 cell sorter includes integrated Accudrop technology to assist in setting an accurate
drop delay value. Accudrop components consist of the following:

¢ Adiode laser, mounted to the left of the sort block

¢ A camera that provides an image of the side streams

* An emission filter for viewing the fluorescence from BD FACS™ Accudrop Beads

The emission filter is installed in front of the lower camera and can be moved in and out by clicking the Optical
Filter control. When the button is green (? ), the filter is out. This position is used to view the center and side
streams.

Click the button to move the filter in front of the camera when you are determining the drop delay. The button

changes to red (7). To determine the drop delay, the streams are illuminated by the diode laser just below the
point of deflection. Specialized fluorescent particles (Accudrop Beads) can be viewed in the center and left side
streams as the delay is adjusted. The best delay yields the most particles in the left stream and the fewest in
the center stream.

See Determining the drop delay — manual method (page 123) for more information.

Auto Drop Delay

The Auto Drop Delay feature enables the system to optimize the drop delay automatically. See Determining the

drop delay — automatic method (page 126).

Drop Charging

Drops are charged when an event is detected and meets the defined sorting criteria, as specified in the Sort
Layout window.

The Sort Layout window contains all sorting instructions and controls. The sort layout designates which device
will be used to collect sorted particles and which particles will be sorted into each sort location. Up to six sort
counters can be displayed in the window to give ongoing status during a sort. Depending on your system’s
configuration, your setup values may vary.
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Target events are identified by drawing gates around populations of interest in plots. The Sort Layout window
specifies which gated population should be sorted into each sort collection tube or spot in a plate or on a slide.
During sorting, when an event is identified within one of the sort gates, the drop containing the particle of
interest is charged by the stream-charging wire attached to the flow cell.
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Stream-charging wire

The amount and type of charge determine where the drop will be sorted. For example, in a four-way sort, drops
with the most charge will be deflected into the outer streams, while drops with less charge will be deflected into
the inner streams.

Conflict Resolution During Sorting

During sorting, the cytometer deflects drops based on the characteristics of the particles in each drop and
where the user wants to deflect them. Conflicts can occur depending on the type of target particle, where the
particle is located within a drop, or whether the drop is free of contaminating particles. BD FACSDiva™ software
accurately measures particle position to within 1/32 of a drop.

Mask settings determine how drops are deflected when sorting conflicts occur. There are three mask settings,
each of which addresses a different type of conflict. These settings are combined to define sort precision
modes. Each mode is made up of a set of masks. Precision modes are defined in the Sort Precision dialog,
accessed from the Sort menu.
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Yield Mask

The yield mask setting defines how close to the edge of the drop, in 1/32-drop increments, a particle of interest
can be located before sorting an additional drop. Half of each yield mask setting defines an equal area at each
end of the drop.

For example, when the yield mask is set to 16 and an event is within 8/32 from the beginning of a drop, the
previous (leading) drop will be sorted. If an event is within 8/32 from the end of a drop, the following (trailing)
drop will be sorted.

Trailing drop: not sorted Drop being interrogated Leading drop: not sorted

— —
Yield Yield
mask mask

Target particle
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If the yield mask were set to 8 for the same target particle, the target particle would fall outside the yield mask.

Therefore, no additional drops would be sorted.

Trailing drop: not sorted Drop being interrogated Leading drop: not sorted

i

—/ —
Yield Yield
mask mask
Target particle

When the yield mask is set to zero, only one drop (the drop containing the target particle) will be deflected.

When the mask is set to 32, two drops will always be deflected. Yield masks between 0 and 32 will sort either
one or two drops.

Yield masks cannot be used in conjunction with phase masks. Therefore, when the yield mask is greater than
zero, the phase mask automatically reverts to zero.
Purity Mask

The purity mask setting defines how close, in 1/32-drop increments, a contaminating drop can be located
before ignoring the drop being interrogated.

For example, when the purity mask is set to 16, the drop being interrogated will not be sorted if a non-target
particle falls within the first or last 8/32 of the leading or trailing drop. In the following example, a non-target
particle falls within the first 8/32, so the interrogated drop will not be sorted.

Trailing drop Drop being interrogated Leading drop
N—
Purity (Not sorted) Purity Non-target particle
mask mask

If the purity mask were set to 8 for the same target particle, the non-target particle would fall outside the purity
mask, so the interrogated drop would be sorted.

Trailing drop Drop being interrogated Leading drop
~ Sorted — .
Purity ( ) Purity Non-target particle

mask mask

With any purity mask greater than zero, the drop being interrogated must be free of contaminating particles or
the drop will not be sorted. If the purity mask is set to zero, a droplet containing the event of interest will be
sorted regardless of contaminating particles.

Phase Mask

Particles near the drop edge can affect the breakoff and alter the trajectory of the deflected drop. The phase
mask restricts drop deflection when an event is too close to the edge of a drop or when there are events close to
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the edge of adjacent drops. A phase mask is used to improve counting accuracy and side-stream quality at the
expense of yield.

For example, when the phase mask is set to 16, the drop being interrogated will be sorted only if the target
particle falls outside the phase mask.

Trailing drop (Drop sorted) Leading drop
N— 0/ N— —
— Phase mask —
Trailing drop Leading drop

/7 N\

N\

(Drop not sorted)

Decreasing the phase mask to 8 allows more drops to be sorted. However, because the target particle is closer
to the edge of the drop, there is more variability in drop trajectory.

Trailing drop (Drop sorted) Leading drop

\T/—Phase maskj

Note: We recommend using a phase mask of at least 8 when sorting single cells.

Phase masks cannot be used in conjunction with yield masks. Therefore, when the phase mask is greater than
zero, the yield mask automatically reverts to zero.
Sort Precision Modes

Mask values can be combined in many different ways. By default, six sort precision modes are already defined:
Purity, 4-Way Purity, Yield, Single Cell, Initial, and Fine Tune.
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Precision Mode
Purity 4-Way Purity Yield Single Cell Initial Fine Tune
Yield Mask 32 0 32 0 32 0
Purity Mask 32 32 0 32 0 0
Phase Mask 0 0 0 16 0 0
Single Cell - - - X -

Purity mode. The yield mask is set to the maximum to obtain the greatest number of particles. Because the
purity mask is also set to the maximum, only drops free of contaminating particles will be sorted. Sorting in
Purity mode results in a sorted sample that is highly pure, at the expense of recovery and yield.

4-Way Purity mode. The purity mask is set to the maximum, so only drops free of contaminating particles
will be sorted. The yield mask is set to zero to ensure that residual charges from adjoining drops do not
degrade the quality of side streams. The 4-Way Purity mode is recommended for 4-way sorting and 6-way
sorting, when precise deflection is required.

Yield mode. Only the yield mask is used at its maximum value. Recovery and yield are optimized at the
expense of purity. The yield mode could be used as a first round sort for enrichment of target particles,
followed by a sort for purity.

Single Cell mode. The purity mask is set to the maximum, so only drops free of contaminating particles will
be sorted. The phase mask is set to half the maximum, so only particles centered within the sorted drop are
deflected. Drop trajectory and count accuracy are optimized at the expense of yield. This mode is
recommended for plate sorting or situations when precise counting is required.

The remaining modes are used mainly during drop-delay determination. Initial mode is equivalent to Yield
mode, but it is named differently as a reminder to use this as the initial mode when using Accudrop to set the
drop delay.

Initial mode. Only the yield mask is used at its maximum value. Recovery and yield are optimized at the
expense of purity.

Fine Tune mode. All masks are set to zero to deflect the maximum number of drops. This mode is used to
fine-tune the drop-delay value. See Determining the drop delay — manual method (page 123) for more
information.

Defining New Precision Modes

Default precision modes cannot be edited or deleted. However, you can create new modes and then select them

from the Precision Mode menu.

1.

2.

3.

Select Sort > Sort Precision.
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Click Add.
The current sort mode is duplicated and the Mask fields are enabled.
(Optional) Change the name of the mode in the Precision Mode field.
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4. Enter values for Yield Mask, Purity Mask, and Phase Mask.
5. Select the Single Cell checkbox, if needed.
6. Click Close.

The new mode is added to the Precision Mode menu.

To delete a mode, select it from the Precision Mode menu and click Delete.



Using BD FACSDiva™ software

Many BD FACSymphony™ S6 cell sorter functions are controlled using BD FACSDiva™ software. This chapter
provides a general overview of the workspace components and describes software controls that are unique to
the BD FACSymphony™ S6 cell sorter cytometer. For an in-depth description of software components not
described in this chapter, see the BD FACSDiva™ Software Reference Manual.

The following topics are covered in this chapter:

e Workspace components (page 56)

¢ Cytometer controls (page 56)

¢ Sorting controls (page 69)

¢ Reference line setup for digital cameras (page 77)

¢ Sort alignment software for analog cameras (page 80)
e Templates (page 85)
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Workspace components

When you start BD FACSDiva™ software, the workspace opens. For a general overview of the workspace and to
get started using the software, see the tutorials and quick reference guides located in the Resource Library on
the BD Biosciences website (bdbiosciences.com). When running BD FACSDiva™ software with the

BD FACSymphony™ S6 cell sorter, two additional windows can be displayed by clicking the Sorting button on
the Workspace toolbar. See Sorting controls (page 69) for a description.
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Cytometer controls

Most BD FACSymphony™ S6 cell sorter—specific cytometer controls are accessed through the Cytometer menu.
Controls on the Cytometer menu are described in the following sections:

¢ Fluidics controls (page 56)

e Cytometer configuration (page 59)

e Cytometer status report (page 60)

The Cytometer Details and the Catalogs menu commands are described in the BD FACSDiva™ Software

Reference Manual. Additional cytometer controls are located on the Acquisition Dashboard. See Acquisition
controls (page 68).

Fluidics controls

Fluidics control of the BD FACSymphony™ S6 cell sorter is partially automated by BD FACSDiva™ software. The
software contains pre-programmed fluidics protocols that are activated by selecting the corresponding menu
command from the Cytometer menu. In addition, fluidics level indicators are available in the Cytometer
window. See Fluidics level indicators (page 58).

Fluidics Startup

During fluidics startup, waste and sheath levels are verified and the fluidics system is primed with sheath
solution. The fluidics status is displayed at the bottom of the main window.


http://www.bdbiosciences.com/
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See Cytometer startup (page 88) for more information.

Fluidics shutdown

Fluidics shutdown removes sheath fluid from the lines, replaces it with ethanol, and cleans the cuvette with a
cleaning solution. See Fluidics Shutdown (Weekly or As Needed) (page 142) for more details.

Change sample filter

Sample line filters can be installed to filter a sample before sorting. This selection opens the Sample Filter
Change wizard, which guides you through the process. See Installing or removing a sample line filter (page 159)
for the instructions.

Cleaning modes

BD FACSDiva™ software contains pre-programmed cleaning modes that are activated by selecting the
corresponding menu command from the Cytometer > Cleaning Modes menu. See Internal cleaning (page 144)
for more information.

Sheath pressure

The sheath pressure determines how quickly particles pass through the laser beam. Select Cytometer > Sheath
Pressure to view the current sheath pressure and change the pressure for custom sort setups.
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A Each sort setup option is optimized at a preset sheath pressure. If you change the sheath pressure,
many other values will be affected and need updating, including the drop-drive frequency, drop-delay
value, laser delay, and area scaling factor. For proper cytometer operation, change the sheath
pressure by selecting an option from the Sort > Sort Setup menu. Do not adjust the pressure using

controls in the Sheath Pressure dialog.

Note: The Sheath Pressure command is disabled when the Sweet Spot is on.

Sample agitation

Select Cytometer > Sample Agitation to specify the speed at which samples are agitated. You can select from
one of the specified values, or select Off to turn off agitation.
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- Sork Help

Fluidics Startup

Fluidics Shukdown

Change Sample Filker

Cleaning Modes ]

Sheath Pressure...

Sample Agitation OFf

Sample Temperature »|  300rpm

Cykometer Details. .. 200rpm

Wiew Configurations. ..
5T,

Performance Tracking (L)...
Catalogs...
Standby

Sample temperature

Use the Sample Temperature command to set the temperature inside the sample injection chamber. You can
select from one of the specified values, or select Off to turn off temperature control.

WG Sork Help

Fluidics Startup
Fluidics Shutdown
Change Sarmple Filker

Cleaning Modes ]
Sheath Pressure...
Sample Agitation ]
Sample Temperature Cooling/heating
Cytometer Details, ., 4C unit for sample
Wiews Configurations. .. 20C injection chamber
5T I

42 C

Performance Tracking {L1)...

Catalogs...
Skandby

The cooling/heating unit is designed to maintain the temperature of a sample tube. It is not designed to cool or
heat the sample. It takes approximately 45 minutes to reach the required temperature inside the chamber,
during which time the chamber must be kept closed.

To cool or heat the chamber, install a sample tube and click Load. Click Stop Acquiring to keep the chamber
closed and stop running the sample. To maintain the temperature, do not leave the chamber open for extended
periods while changing sample tubes.

The sample temperature retains the last setting after startup. For example, if it was set to 20 °C the last time
the system was used, then it will return to that setting the next time the system is started up.

Fluidics level indicators

BD FACSDiva™ software provides fluidics level indicators in the Cytometer window. The sheath and waste
indicators provide an approximate indication of the fluid levels in each tank. The DI, bleach, and ethanol tank
indicators appear full until the fluid level is below 20% of the tank capacity. When this occurs, the corresponding
level indicator changes to black.

Note: The stainless steel ethanol shutdown tank does not have a level sensor. It must be checked manually.
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Sheath Waste DI Bleach Ethanol

\ | /
iZykometer Connected ‘ . . - i ‘

When the sheath is low or the waste is full while the stream is running, the corresponding indicator turns red
and the following warning message is displayed every 5 minutes until the stream is turned off. If the warning
message is not closed, the system automatically turns off the stream after 15 minutes.
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‘@ Do not close the warning message without refilling the sheath or emptying the waste. If you
continue to run the cytometer after closing the message, the system could shut down.

Cytometer configuration

The menu selections shown in the following figure open the CS&T module in a separate window. The CS&T
module enables you to perform multiple functions related to cytometer configuration.

Note: When the CS&T module is open, BD FACSDiva™ software goes into a holding mode and does not accept
any user input. When CS&T is closed, BD FACSDiva™ software becomes active again.

¢ View Configurations. Opens the Cytometer Configuration window within the main CS&T window. See the
following section for an overview of this function.

 CST. Opens the CS&T module. See the BD® Cytometer Setup and Tracking Application Guide for complete
information on using BD® CS&T Research Beads.

¢ Performance Tracking (LJ). Opens the performance tracking feature within the main CS&T window. See the
BD® Cytometer Setup and Tracking Application Guide for complete information on using this feature.

Cytometer configuration window

The BD FACSymphony™ S6 cell sorter cytometer is equipped with a specific set of lasers, filters, and dichroic
mirrors. The Cytometer Configuration window lets you define which fluorochromes or cell parameters will be
measured at each PMT detector. Within this window, you can define the filters and assign the fluorochromes to
the detectors.
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Select Cytometer > View Configurations to open the window. Click the Parameter tabs for a list of
parameters. Click the Filters and Mirrors tab for the list of optics.

The Cytometer Configuration window also displays the following settings:

¢ Sheath pressure

¢ Nozzle size

¢ Window extension

See Custom configurations (page 61) for more information on editing configurations, including adding
parameters, mirrors, and filters.

Before you start any experiment, verify that the cytometer configuration contains the appropriate parameters
for the samples you are running and that the cytometer optics match the current configuration. You cannot
modify an existing configuration once it has been baselined. However, you can copy, paste, or modify a
configuration as described in Custom configurations (page 61).

Q For accurate data results, the cytometer optics must match the current cytometer configuration.

Selections in the Cytometer Configuration window determine which parameters are available for your
experiment.

“aaa PEEEET  Testeki (s Compeeston  Foa

P vl C ]

Cyiomater Corracted .ll.l

Cytometer status report

The Cytometer Status Report provides a list of all cytometer settings at the time the report was created. The
cytometer must be connected to create the report. In an open experiment, click to set the current tube pointer
and select Cytometer > Cytometer Status Report. The report is displayed in a separate window with a menu
bar above the report header. The header lists the cytometer name, type, serial number, and the date and time
the report was generated.

For a full description of the Cytometer Status Report, see the BD FACSDiva™ Software Reference Manual. A
BD FACSymphony™ S6 cell sorter cytometer report includes the following additional information: user access
privileges, cytometer information, cytometer settings, and sorting settings. The report can be printed or
exported.

e The User Access Privileges section lists access settings for the current user.

e The Cytometer Info section lists values for laser delay, area scaling, window extension, FSC area scaling,
sheath pressure, and sample flow rate.

¢ The Parameters section displays settings for the current acquisition tube.
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¢ The Sort Settings section lists all sort setup values, along with the Plate Voltage and Voltage Center values. If
the Sweet Spot is off, Breakoff and Gap values are shown. If the Sweet Spot is on, Drop 1 and target Gap

values are shown.
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Custom configurations

Before you can record data, you must first ensure that the cytometer configuration is appropriate for the
experiment. If needed, you can create custom configurations to add parameters or filters and mirrors that are
not listed in the base configuration. You will also need to create custom configurations for each sheath pressure

you would like to run.

When creating custom configurations, use descriptive names that make it easy to identify the configuration.
See the BD FACSDiva™ Software Reference Manual and the BD Cytometer Setup and Tracking Application
Guide for more information.
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Preparing for custom configurations

Custom configurations can be created only by users with administrator access. The easiest way to create a
custom configuration is to copy and edit a base configuration. You can also create a new, blank configuration.

1.

2.
3.
4

Adding parameters, filters, and mirrors

Before creating a custom configuration, verify that the necessary parameters, filters, and mirrors required for
the custom configuration are defined.

1.

Log in to the software as an administrator.

Select Sort > Sort Setup and select the setup mode that matches the nozzle size you are using.

Verify that the correct nozzle is installed, then start the stream.

Select Cytometer > CST.

The Cytometer Configuration window opens (see Cytometer configuration (page 59)). For users with
administrator access, the window displays the Parameters and Filters and Mirrors tabs, which are not visible

to users with operator access.

When you create a new configuration in CS&T, you need to run a new baseline for that configuration. Once
the baseline is established, you cannot edit any of the settings in the configuration.

To add new parameters, do the following in the Parameters tab:
a. Click Add.
b. Enter a parameter name in the field provided.
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2. To add filters or mirrors, do the following in the Filters and Mirrors tab:
a. To add afilter, click Add under the Filter list. To add a mirror, click Add under the Mirror list.

and Mirrors |

Mirrars:

Pass Type | Wavelength
Long Pass 755
Long Pass 750
Long Pass 740
Long Pass 735
Long Pass 710
Long Pass 685
Long Pass 675
Long Pass 670
Long Pass 655
Long Pass 635
Long Pass 630
Long Pass 610
Long Pass 600
Long Pass 595
Long Pass 575
Long Pass 556
Long Pass 550
Long Pass 545
Long Pass 505
Long Pass 502
Long Pass 475
Long Pass 470

Long Pass
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b. Select a pass type and enter a wavelength in the field provided.

'Conﬁguraﬁons\ (Parameters| Filters a

Filters:

Pass Type | Wavelen... !Ll
Band Pass 510/80
Band Pass 510/50
Band Pass 488/15
Band Pass 488/10
Band Pass 485/22
Band Pass 480/20
Band Pass 450/50
Band Pass 450/40
Band Pass 450/20
Band Pass 448/45
Band Pass 445/15
Band Pass 440/40
Band Pass 405/20
Band Pass 71222
Band Pass 675/26
Band Pass 586/16
Band Pass 586/15 B
Band Pass 545/20
Band Pass 540/30
Band Pass 510/10
Band Pass 4880
Band Pass 485/25
Band Pass 485/20
Band Pass 445/0

Copying a base configuration

You cannot edit or delete your base configuration. However, you can use it as a starting point to create a
custom configuration.

1. In the Configurations tab, right-click the Base Configurations folder and select New Folder.

2. Rename the new folder Custom Configurations.

3. Right-click the base configuration and select Copy.

Configurations | parameters | Fiters and Mirrors

=+ Base Configurations

Bl - ! 3, 405, 375 Bass

=H=| Training class configurations hlew Folder
@ F0urn-70psi-433-405 Export Configuration, ..
|@]| 55um-4Spsi-455-405 Print ...

[E3) Practice configurations

= |

4, Right-click the Custom Configurations folder and select Paste.

A copy of the base configuration is added to the Custom Configurations folder.
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5. Enter a descriptive name and press Enter.

For example, use the name 70-70, meaning 70-micron nozzle at 70 PSL. If you need to rename the
configuration, right-click the new configuration and select Rename.

Editing the copied configuration

Once the base configuration is copied, you can customize the parameters, filters, and mirrors in the

configuration.

1. In the configuration list, right-click the new configuration and select Edit Configuration.

The following window opens.

T g AT e
P ormeie bw e etedTE
g gy g

Famm K

Al ianm Bard rues I L
Albram | CEEbm] | Wl
[E

PR
]
W

o N Sl S OEEN le-e

S— Rl o R—— rmf

e R
Tl L L ] L =
{ i} ianar Horva Var Fd
2 L | Sren Viows B
Boiea Nl 10
A Pl B
Brna Vo T

g

A e
AT fa FE
ALy
AT
ArC

[ E

1
d

mi
FEEsaAEEE B
EERRAE
it

b - 1
L

EEP
——

R
-
R

MEHEH
i

L LTEEF

65



66 | BD FACSymphony™ S6 Cell Sorter User Guide

Use the tabs at the bottom of the window to view each laser’s detectors separately.The following is an
example when the Blue tab is selected:
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2. To edit the nozzle size and sheath pressure for this configuration:
a. Enter the appropriate sheath pressure value at the bottom of the configuration window.

b. Select the appropriate nozzle size.

Sheath Pressure [psi) 20.00 % window Extenzsion [pe); 200 %

MNozzle Size [p); 100 v

3. To change the parameter label for a detector, select a parameter from the Parameters list and then drag
and drop the parameter onto a detector (one of the discs labeled A-H) for the appropriate laser. You can
assign multiple parameters by using Ctrl+click to select individual parameters or Shift+click to select a
contiguous range.

4. To change afilter, drag and drop a filter in the Filter list menu onto a detector, as in step 3.
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5. To change a mirror, drag and drop an item in the Mirror list for that detector onto a detector, as in step 3.

To verify that you have selected the correct configuration, do the following.
1. Select Cytometer > CST.
2. Select the appropriate configuration and select Set Configuration.
3. Select File > Exit to exit CS&T.
A mismatch dialog is displayed.
4, Select Details, and then select Use CST Settings.

Verifying that the configuration matches the sort setup

To verify that the sheath pressure in the sort setup matches the sheath pressure in the configuration:
1. Select File > Exit to exit CS&T.
2. Select Sort > Sort Setup, and select the sort setup that matches the nozzle size listed in your configuration.

Cytomete Sot Help

Select the sort setup that
matches the nozzle size
listed in your configuration.

B il

100 cuntm

15 cumtom

200 %

3. Select Cytometer > Sheath Pressure and verify that the pressure matches the pressure in your
configuration. Enter a new sheath pressure, if needed.

The new sheath pressure is automatically saved with the current sort setup mode.
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Shealh Foaur Myt

Eniter the same sheath prassure that was
entered in the configuration,
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The name of the configuration is displayed at the top of the BD FACSDiva™ workspace. If you use a
descriptive name for each configuration (such as 700-15-Custom, for nozzle size-sheath pressure-sort setup
mode), it will be easier to verify that the appropriate settings match without going back to view the
configuration.

Acquisition controls

Along with the controls described in the BD FACSDiva™ Software Reference Manual, the following acquisition
controls are available for the BD FACSymphony™ S6 cell sorter cytometer.
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¢ Load. Lifts a tube into the sample injection chamber, starts sample agitation (if agitation is turned on), and
starts acquisition of the sample.

When a tube is already loaded, the button changes to Unload. Clicking Unload stops acquisition of the
sample, turns off the agitator, and lowers the tube from the sample injection chamber.

Note: The Load button is enabled only when the workstation is connected to the cytometer, an experiment is

open, the stream is turned on, and the current tube pointer is set to a tube.
¢ Stop Acquiring. Stops sample acquisition without unloading the sample tube.
The Acquire Data button functions only when a tube is loaded.
¢ Flow Rate. Controls sample flow rate, from 1.0-11.0 (10-80 pL/min).
Do one of the following to change the flow rate:
© Select the value in the field and enter a new value.
° Click the pointer in the slider bar and drag it to a new value.

© Use the mouse to click the up and down arrows or press the arrow keys on your keyboard to increase or
decrease the values in small increments.
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Sorting controls

All sorting on the BD FACSymphony™ S6 cell sorter cytometer is controlled by BD FACSDiva™ software. See the
table after the following figure for explanations of each area.

@
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No. | Description

The Sort menu provides access to the sort setup and sort precision modes, sort layouts, sort reports, and sort
devices used with the ACDU unit. See Sort menu (page 69).
The Sort Layout window contains controls to turn on index sorting and designates which device will be used to
collect sorted particles and which particles will be sorted into each sort location. Depending on your system’s
configuration, your setup values may vary.
The Breakoff window displays an image of the stream and contains controls to adjust drop formation. See Drop
Formation (page 43).
The Side Stream window displays an image of the side streams, and contains controls to adjust electrical charges
and the drop delay. See Side Stream Formation (page 47).

Sort menu

Select commands in the Sort menu for the following:
e Sort Setup. Downloads the most recently used settings for the selected nozzle size. See Sort setup (page 70).

¢ Sort Precision. Opens a dialog where you can select or define a sort precision mode for handling sorting
conflicts. See Conflict Resolution During Sorting (page 50).
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¢ New Sort Layout. Opens the default 2-Tube Sort Layout window where other sort layouts can be selected.
(Clicking the Sort Layout button on the Browser toolbar performs the same function.)

¢ Open Sort Layout. Opens an existing sort layout. A sort layout must be selected in the Browser for this menu
command to be enabled. Alternatively, double-click any sort layout to open it.

* Home Device. Opens a dialog containing commands to move the tray support arm, either manually or to the
home position. See Setting up the stream (page 133).

¢ Custom Devices. Opens a dialog where custom devices can be defined. See Creating a custom device (page
135).

¢ Sort Report. Displays a report showing the sort settings, acquisition counters, and sort layout information
from the current sort. See Sort report (page 75).

Sort setup

Sort setup values for four different nozzle sizes can be downloaded using the Sort > Sort Setup command.
Default settings are provided for each sorting option, along with a custom setting for each option.

As a general rule, for optimal results when sorting large or fragile cells, use a larger nozzle size and lower
pressure. To increase throughput and yield when sorting smaller or less fragile cells, use a smaller nozzle size
and higher pressure.

Sort Setup Name Nozzle (microns) Default Pressure (PSI)
70 micron 70 70
85 micron 85 45
100 micron 100 20
130 micron 130 10

™

If you make changes to any of the settings, the changes are automatically saved when you exit BD FACSDiva
software or when you switch to a different sort setup mode. When you restart, the most recently used set of
values is restored.

In addition, the Sort Setup menu has following menu items: 70 Custom, 85 Custom, 100 Custom, and 130
Custom. Initially, all of these new setups are exact copies of the corresponding original setups with the same
defaults. This allows you to create two sets of sort values (pressure, for example) for the same nozzle size.
A Do not use a nozzle size that is different from the sort setup setting. The gap values and sensitivity
algorithms are optimized for particular nozzles and are not suitable for other nozzle sizes. The system

performance could be unstable.

The following table shows default sort setup values. Depending on your system’s configurations, your setup
values may vary. We recommend optimizing these settings for your system’s configurations.
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Setting 70 micron 85 micron 100 micron 130 micron
Sheath pressure 70 45 20 10
Amplitude 60 32 12 24
Frequency 87 47 30 12
Drop 1 150 150 150 150
Gap (upper limit) 6 (14) 7017) 10 (21) 12 (21)
Attenuation Off Off Off Off
Drop delay 47.00 30.00 27.00 16.00
Far left voltage 1007 1007 80 60

Left voltage 70 35 30 20
Near left voltage 30 35 30 20
Near right voltage 30 35 30 20
Right voltage 70 35 30 20

Far right voltage 100* 1007 80 60
Plate voltage 6,000 6,000 4,500 4,500
2nd drop 20 20 10 0

3rd drop 10 10 5 0

4th drop 0 0 0 0
Laser delay (blue) 0.00 0.00 0.00 0.00
Laser delay (red) -40 -35 -40 -40
Laser delay (violet) 40 35 40 40
Laser delay (UV) 78 71 80 78
Laser delay (yellow green) | -80 -80 -80 -80
Area scaling (blue) 0.60 0.60 0.60 0.60
Area scaling (red) 0.60 0.60 0.60 0.60
Area scaling (violet) 0.60 0.60 0.60 0.60
Area scaling (UV) 0.60 0.60 0.60 0.60
Area scaling (yellow green) [ 0.80 0.80 0.90 0.95
Window extension 2.00 2.00 2.00 4.00

* For 3.5-inch deflection plates, the value needs to be set to 85 or less. Otherwise the plates may get wet, which could cause arcing.

The Sort Layout window contains all sorting instructions and controls. The sort layout designates which device
will be used to collect sorted particles and which particles will be sorted into each sort location. Up to four sort
counters can be displayed in the window to give ongoing status during a sort.
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Only one sort layout can be open at a time, but you can create several layouts for a single tube, as long as each
sort layout has a different name. Sort layouts can also be added to global worksheets.

Sort layouts are available for up to 12 default collection devices (shown in the following figure). Additional
custom devices can be defined. See Creating a custom device (page 135).
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Examples of sort layouts for different devices are shown in the following figures. Instructions for setting up a
sort layout can be found in Setting up a sort layout (page 73).
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Setting up a sort layout

Sort layouts can be added to tubes or global worksheets.

¢ Create tube-specific layouts if you are sorting different populations or using different sort devices for each

tube in the experiment.

¢ Create global worksheet—specific layouts if you are sorting the same populations into the same sort device

for all tubes in the experiment.

Note: To create a tube-specific sort layout, make sure a normal worksheet (white tab) is shown in the
Worksheet window before you create the layout.

To set up a sort layout:

1.

Select the icon for a tube or global worksheet in an open experiment and click the New Sort Layout button
on the Browser toolbar.

In the Sort Layout window, select the type of device from the Device menu.

Default sorting devices are listed along with any defined custom devices. The Sort Layout window changes
depending on the selected device. The number of rows and columns in the window matches the number of
tubes, wells, or spots in the collection device.

Select the sort precision mode from the Precision menu.
For more information, see Sort Precision Modes (page 52).
Enter the number of events to be sorted in the Target Events field.

Once entered, the number of events can be selected from the Target Events menu. For continuous sorting,
select Continuous from the Target Events menu.

Select one of the following options from the Save Sort Reports menu:
¢ Save None. Sort reports are not saved.
¢ Save All. Automatically saves a sort report each time the sort is stopped.

¢ Ask User. Prompts the user each time the sort is stopped to select whether or not to save the sort report.
This is the default option.

This setting is saved with the sort layout.
Select the field(s) corresponding to the tube(s), well(s), or spot(s) where the population will be sorted and
select a defined population from the Add menu.

When you click in a sort location field, a menu opens allowing you to add, delete, or clear all populations in
the field.
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After you add a population, the population and the number of target events are added to the corresponding
sort location field.

Note: Select a row or column header to select all fields in that row or column. When you add a population, it
will be added to all selected fields at once.

73



74 | BD FACSymphony™ S6 Cell Sorter User Guide

7. Specify whether to save sort conflicts by selecting the Save Conflicts checkbox.
When selected, all sort conflicts are sorted into a default location.
¢ For a two-tube layout, conflicts are sorted to the right.
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¢ For a four-tube layout, conflicts for the far left tube are sorted to the left, and conflicts for the far right
tube are sorted to the right.
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¢ Six-tube layouts do not support conflict sorting.

Editing a sort layout

¢ To change the number of events for any population, click in the Sort Location field(s) containing the
population, then select a number from the Target Events menu or enter a new number.

¢ Toremove a population from a sort location field, select the field, then select the corresponding population
from the Delete menu.

¢ To clear all populations from a field, select the field, then select Clear All.

Using Sorting Controls

Sorting controls are located at the bottom of the Sort Layout window. Use these controls for the following
functions.
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« Sort. Starts sorting events for the current acquisition tube. All counters reset to zero when this button is
clicked. Events are sorted until the requested number of sorted events has been reached.

Click the Sort button again to stop sorting before reaching the requested number of events. The counters
stop at the number of sorted events. If you click Sort to restart sorting, the counters reset to zero.

¢ Pause/Resume. Stops sorting, but not acquisition. Sort counters and sort timers freeze when the Pause
button is clicked. Click the Resume button to continue sorting and to continue incrementing the sort
counters and timers. See Pausing and resuming a sort (page 130).
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¢ Access Stage. When the ACDU stage is in the back, the stage is moved forward to put a plate on or take a
plate off the stage. When the stage is in the front, the stage is moved to the back and out of the way so you
can install a collection tube holder.

¢ Move Drawer. Moves the aspirator drawer in (closed) or out (open) depending on its current state. The
default state is in. For more information, see Aspirator drawer (page 21).

Using counters

Counters provide ongoing status during sorting. Counter fields cannot be edited. To display fewer counters in

the Sort Layout window, click the View Counters button and select a menu option. The corresponding counter is

hidden. (Only counters with a checkmark next to the name are displayed.)
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Counters display the following information:

« Sort Rate. Number of events per second that met the sort criteria and were sorted.

¢ Conflict Count. Number of events that met the sort criteria but were not sorted because of conflicts.
¢ Conflict Rate. Number of conflicts per second.

 Efficiency. Number of sorted events/(sort conflicts + sorted events) x 100.

Monitoring a sort

During sorting, each sort location field displays the number of actual sorted events. When a target number is
specified, the field displays the actual number of events along with the number of target events.

A progress bar opens behind the sort rate counter field showing the progress of the sort.
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Sort report

Select Sort > Sort Reports to view all of the saved reports for the current sort layout. A sort report can be
printed or exported. The Sort Reports menu option is enabled if either of the following is true: a sort layout is
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selected in the Browser (even if experiment is closed), or a sort layout is open. If both conditions are true, the
Browser selection takes precedence.

A sort report contains the following:

Header information. Experiment name, specimen name, tube name, sort layout name, software name and
version, the date and time of printing, type of collection device, user ID, and cytometer.
« Sort Settings. Sort setup values, precision mode, mask definitions, etc.
Acquisition Counters. Threshold count, processed events count, electronic conflicts count, and elapsed time.
e Sort Counters. Counter values per sort destination, or total sort count if sorting sequentially.
e Sort Layout. Population(s), sort count, and target event count for each sort location field.

—

-
| s g

- (e e
. .
= =
[
-
.
-
T - e vaa wasia
an . e
- W
e o -

The Sort Report window contains a File menu where you can select to print or export the report. Exported
comma-separated value (CSV) files can be opened with a spreadsheet application such as Microsoft® Excel®.
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Reference line setup for digital cameras

For digital cameras, reference line adjustment is performed using the Reference Line Setup tab in the
Cytometer window. This tab adds reference lines to the BD FACSDiva™ Side Stream window, providing a point
of reference to center and align the sort streams into the collection devices.

Note: The Reference Line Setup tab is only present if the user is logged in as an Administrator.

Preliminary operations

Set up the cytometer for sorting with the appropriate nozzle configuration, breakoff, and BD FACSDiva™
software settings. Use the instructions given in the following sections:

1. Starting the stream (page 91)
2. Setting up the breakoff (page 92)
3. Setting up for sorting (page 120)

Selecting an existing sort device

The following procedure can only be performed by a user with Administrator privileges.
1. Inthe Cytometer window, select the Reference Line Setup tab.

2. Select a device from the Collection Device dropdown list.

The number of sliders displayed is device-dependent. For example, four slider controls for the Four Tube
device, similar to the following :

Four Tube device Six Tube device
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3. Set up the reference lines as described in Setting the reference lines (page 78).

Creating a new sort device
The following procedure can only be performed by a user with Administrator privileges.
1. Inthe Cytometer window, select the Reference Line Setup tab.

2. From the Collection Device dropdown list, select New Device.
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3. Click the New Device button at the bottom of the window.
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The software displays a New Deflection Device dialog:
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4, Inthe Device Name text box, type a system-unique device name as prompted.

If the device name already exists, the software will display a warning dialog, which can only be dismissed by
clicking OK.

5. Inthe Deflections dropdown list, select the number of sidestreams corresponding to the sort device.
6. Click OK to close the dialog.

7. Set up the reference lines and save the device settings as described in Setting the reference lines (page 78).

Setting the reference lines

Your BD Field Service Engineer (FSE) positioned the reference lines around the centered streams for BD-
provided sort devices. Use this procedure if you want to readjust the reference lines in an existing device or to
initialize the values in a new device.

Note: For existing devices, this correction is only necessary if aligning the streams to the reference lines places
the streams off center of the actual sort collection device. The procedure can only be performed by a user with
Administrator privileges.

Cell sorters that use droplet generation methods, such as the BD FACSymphony™ S6 cell sorter, can
produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal
precautions at all times. Keep the sort block door and the sort collection chamber door closed during
sorting.

A@ You might need to raise the sash of the biosafety cabinet (BSC) above the safe-access opening of
8 inches to do this procedure.
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Ensure that the appropriate collection device is selected on the Reference Line Setup tab of the Cytometer
window—see Selecting an existing sort device (page 77) or Creating a new sort device (page 77). Reference
lines corresponding to the selected collection device will display in the Side Stream window.

Before aligning the Side Stream reference lines, verify that the aspirator reference lines are centered around
the stream. If necessary, align the stream to the aspirator reference lines by adjusting the sort block
position.
Insert the sort collection device under the sort block with tape or lids covering tubes.
Perform a one-drop test sort:
a. Turn on the high-voltage plates.

Open the waste drawer.

c. Click Test Sort once to simultaneously deposit a drop for each side stream and then quickly click the
button again to turn it off.
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Remove the sort collection device and check whether each drop deposited is centered on the collection tube.
If not, adjust the voltage slider for each stream to the appropriate setting. Re-insert the sort collection
device and repeat the preceding step until all side streams are centered.

Close the waste drawer and click Test Sort to start the test-sort operation..

On the Reference Line Setup tab of the Cytometer window, adjust the sliders to center the collection device
reference lines around each corresponding side stream.

On the Reference Line Setup tab of the Cytometer window, click Save Device.

The software displays a Save Deflection Device dialog.

To confirm the save operation, click Yes or cancel the operation by clicking No or Cancel.
Click Test Sort to stop the test-sort operation.

Turn off the high-voltage plates.

Deleting a sort device

The following procedure can only be performed by a user with Administrator privileges.

1.
2.
3.

In the Cytometer window, select the Reference Line Setup tab.
From the Collection Device dropdown list, select the sort device to be deleted.

Click Delete Device.
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The software displays a Confirm dialog:
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4. Click OK to complete the operation.

Sort alignment software for analog cameras

The Sort Alignment software adds functionality to BD FACSDiva™ software version 8.0 or later.

Note: The Sort Alignment software is only applicable to analog cameras.

Overview

The Sort Alignment software adds reference lines to the BD FACSDiva™ Side Stream window, providing a point
of reference to center and align the sort streams into the collection devices. Your BD FSE installed the software
and positioned the reference lines around the centered streams. The following figure shows the reference lines
in the Side Stream window.
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Aligning the streams

Cell sorters that use droplet generation methods, such as the BD FACSymphony™ S6 cell sorter, can
produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal
precautions at all times. Keep the sort block door and the sort collection chamber door closed during
sorting.

1. Set up the cytometer for sorting with the appropriate nozzle configuration, Breakoff, and BD FACSDiva™
software settings. Use the instructions given in the following sections:
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¢ Starting the stream (page 91)
¢ Setting up the breakoff (page 92)
¢ Setting up for sorting (page 120)

2. Start the Sort Alignment software by clicking the icon in the Microsoft Windows taskbar located in the
bottom left corner of the computer monitor.

| EEONCN N0
This adds the Sort Alignment icon to the Notification area.

3. Click the Sort Alignment icon in the Notification area located in the bottom right corner of the computer
monitor, and select your collection device from the menu that opens.

4. With the sort block door closed, use the Side Stream window to verify that the aspirator reference lines are
centered around the stream. If necessary, align the stream to the aspirator reference lines by adjusting the
sort block position.
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5. Align the side streams to the center of each of the collection device’s reference lines by moving the voltage
slider for each stream to the appropriate setting.

6. For more information on setting up the side streams, see the instructions given in Setting up for bulk sorting
(page 120).

Setting the reference lines

Your BD FSE positioned the reference lines around the centered streams. If you want to readjust the reference
lines, use this procedure.

Note: This correction is only necessary if aligning the streams to the reference lines places the streams off
center of the actual sort collection device.

A@ Cell sorters that use droplet generation methods, such as the BD FACSymphony™ S6 cell sorter, can
produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal
precautions at all times. Keep the sort block door and the sort collection chamber door closed during

sorting.

A@ You might need to raise the sash of the biosafety cabinet (BSC) above the safe-access opening of

8 inches to do this procedure.
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Make a backup copy of the existing BD FACSDiva™ sort alignment settings.

You can re-import them later, for example, after re-installing BD FACSDiva™ software. (Re-installing
BD FACSDiva™ software deletes the settings.)

a. Navigate to C:\Program Files\BD FACSDiva Software.
b. Select the following .txt files:

c. Copy the files and paste them into C:\Libraries\Documents\BD Sort Alignment Tool.

Note: Create the directory if it does not exist.

2. Set up the cytometer for sorting.
3. Once the stream is centered to the aspirator drawer and the breakoff is set, turn on the Sweet Spot.

Navigate to C:\Program Files\BD FACSDiva Software\jarfiles, and double-click SortDeviceControl.exe to
start the Sort Alignment software.

The Stream Aiming Device Setup window opens.
Dievicr:  Foum Tube

Left Near Left Wt Bkt Right

Select the appropriate collection device from the Device selection menu. Reference lines corresponding to
the selected collection device will display in the Side Stream window.

Before aligning the Side Stream reference lines, verify that the aspirator reference lines are centered around
the stream. If necessary, align the stream to the aspirator reference lines by adjusting the sort block
position.

Insert the sort collection device under the sort block with tape or lids covering tubes.
Perform a one-drop test sort:

a. Turn on the high-voltage plates.

b. Open the waste drawer.

c. Click Test Sort once to simultaneously deposit a drop for each side stream and then quickly click the
button again to turn it off.



10.
11.

12.
13.
14.
15.

Chapter 4 Using BD FACSDiva™ software

- " .
B o B Test Sort [T Oplcsl Fites krawnanion ] vimis Cravp  Crog-Dalay AL EE = | Dy

Writmge Carrier Pl g LA :'r

i Ty i 5 - i
el v g N 1 o Dy e s

Remove the sort collection device and check whether each drop deposited is centered on the collection tube.

If not, adjust the voltage slider for each stream to the appropriate setting. Re-insert the sort collection
device and repeat the preceding step until all side streams are centered.

Close the waste drawer and click Test Sort to start the test-sort operation.

Use the Reference Line sliders to center the collection device reference lines around each corresponding side

stream.
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Click Test Sort to stop the test-sort operation.

Turn off the high-voltage plates.

Repeat steps 5-13 for each collection device configuration to be used.
Close the Sort Alignment software.

Reinstalling the Sort Alignment software

The Sort Alignment software is installed by your FSE. If you need to re-install the software, use this procedure.

1.
2.
3.

Close BD FACSDiva™ software if it is open.

Navigate to C:\Program Files\BD FACSDiva Software\jarfiles.

Double-click IconSortDeviceControl.exe to start the application.

The Sort Alignment icon is displayed in the Windows taskbar and the systems tray.
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Note: When starting the Sort Alignment software for the first time, the Sort Alignment icon might be
displayed in the hidden area of the systems tray. If this occurs, drag the icon onto the systems tray.

Right-click the Sort Alignment icon in the Windows taskbar, and select Pin this program to taskbar from the

menu that opens.
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5. From the Windows Start menu, select Settings. On the Windows Settings screen select Personalization ->
Taskbar. On the right pane, in the Notification area section, click Select which icons appear on the taskbar.
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6. Ensure that you turn OFF the button for “Always show all icons in the notification area” and turn ON the
button for “IconSortDeviceControl”.
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7. Navigate to Aligning the streams (page 80) for how to use the software.

Troubleshooting

Observation

Possible cause

Recommended solution

The aspirator reference lines
are off-center

The side stream window camera

needs realignment

Call BD customer service.

The sort alignment settings
are gone

BD FACSDiva™ software was
reinstalled

Reposition the digital reference lines. See Setting the
reference lines (page 81)




Chapter 4 Using BD FACSDiva™ software

Templates

When you install BD FACSDiva™ software for the BD FACSymphony™ S6 cell sorter cytometer, the following
additional experiment templates are installed in the BD Export\Templates directory:

¢ Accudrop Drop Delay template. Contains a single specimen and tube, a gated plot on a standard
worksheet, and a predefined sort layout. This experiment is used for setting the drop delay during sorting as
described in Determining the drop delay — manual method (page 123).
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Startup and running samples

The following topics are covered in this chapter:
e Cytometer startup (page 88)

¢ Checking cytometer performance (page 99)
¢ Application settings (page 103)

¢ Data collection (page 108)

e Data recording and analysis (page 111)

¢ Manual adjustment of laser delay (page 116)
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Cytometer startup

Follow these steps to start up your BD FACSymphony™ S6 cell sorter.

Note: Ensure that the instrument is plugged into the provided power conditioner and select proper voltage
setting before turning on the main power.

1.

S wN

w

Turn on the cytometer main power.

Power panel for cytometers with analog cameras:

Outlet for serial
communications
cable

Power  Laser  Erhemet
switch Connection s pr

Us8

Connectors to upper
and lower cameras

Power panel for cytometers with digital cameras:

Power Connections to Ethernet Outlet for serial
button digital cameras and laser to PC communications
cable

If the cytometer was just shut down, wait until the system is fully depressurized (stops hissing) before you
turn on the main power.

Switch on the house air or the optional compressor.
Start up the workstation.

Press the LASER MAIN button on the front of the optics drawer to turn on the lasers you will be using. Wait
30 minutes for the lasers to warm up.

If your system includes the BSC and it is not already on, turn on the blower by pressing the power button on
the Cabinet Controls panel.

A green light indicates the power is on.
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(Optional) If you are using the temperature control option, turn it on. See BD FACSymphony™ S6
Temperature Control Option (page 217).

Log in to Windows 10.
a. Select BDOperator login or BDAdmin login.

b. Type the password. On initial installation, the BDOperator password is Welcome#1 and the BDAdmin
password is BDIS#1$$. After logging in with the initial password, you will be prompted to change it
immediately, and every 90 days thereafter.

Open the Coherent Connection laser control software, wait for all lasers to populate.

If the Auto-on laser option is selected, wait for all lasers controlled by Coherent Connection to power on.
Otherwise, for each laser, select the Laser Start mode.

Note: The UV Laser does not turn on automatically, and will display in Coherent Connection in a “fault”
state with power set to “0.00 mW?”. If the laser is already in the Laser Start mode, select Laser Stop. Set the
desired laser power, and then select Laser Start.

Ensure all lasers controlled by Coherent Connection are powered up and the power levels are stable. The
laser power levels should automatically set to the previously used power levels. If not, adjust the power as
needed.

Once all the lasers are at optimal power, close the Coherent Connection software to avoid laser connection
issues with the BD FACSDiva™ software. Closing the Coherent Connection software will not affect the laser
power levels.

For lasers not controlled through coherent connections software:
a. Open the GUI-VFL Laser-control software.
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b. Click the image of the serial (COM) port to view or set the port number.

c. Enter the desired power level in the Power Set field, and select Activate.

d. Verify that the power level rises to the desired level.

e. Set the On/Off control to On.

Open BD FACSDiva™ software by double-clicking the application shortcut on the desktop.

Log in with your user name and password.
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If your login name is not displayed, contact your BD FACSDiva™ software administrator to create a login
name for you. For more information, see the BD FACSDiva™ Software Reference Manual.

Check the fluid levels in the Cytometer window. Replenish fluids or empty the waste, if needed.

To display the Cytometer window, click the Cytometer button on the Workspace toolbar. Check the fluid
levels at the bottom of the window. Roll the mouse pointer over fluid indicators to show the fluid type.

Sheath Was\te D‘I Bl/each Ethanol
Note: The ethanol level in the Cytometer window indicates the volume of fluid in the white auxiliary ethanol
tank. There is no sensor for the stainless steel ethanol shutdown tank.

iZytomeker Connected

To service the fluid containers, see Emptying the waste tank (page 97).

Performing fluidics startup

This section describes the fluidics startup procedure. The status of the fluidics system is displayed in the bottom
right corner of the main window.

1.

From the BD FACSDiva™ Cytometer menu, select Fluidics Startup. The following window opens.
N 5|
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2. Verify that the air and fluid lines are disconnected from the ethanol tank and connected to the sheath tank,

then click Done.
A Do not run fluidics startup with the air and fluid lines connected to the ethanol shutdown tank.

This can cause damage to the system. Always verify that the lines are connected to the sheath

tank.

Top view Side view

Sheath or ethanol
Fluid line filter

To filter

Air line

Fluid
connector

To instrument

Sheath tank
or ethanol shutdown tank
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Note: The flow rate is calibrated with the sheath tank. If the location or elevation of the sheath tank is
changed, it could affect the flow rate calibration.

. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

. Open the Flow Cell door and verify that a closed-loop nozzle is installed in the flow cell, then click Done.
The fluidics startup process starts and the progress is displayed at the bottom of the dialog.

Fraacn fovmup N pragren. Sens

. Turn the nozzle-locking lever counter-clockwise to the 9:00 position, pull the closed-loop nozzle out of the
cuvette flow cell, then click Done.

Insert the correct nozzle size in the flow cell.

a. Verify that the O-ring is present and that it is installed in the nozzle groove. For more information, see
Integrated nozzle (page 19).

b. Make sure the top side of the nozzle is facing up as you insert the nozzle.
c. Push the nozzle all the way back into the flow cell.

d. Turn the nozzle-locking lever clockwise to the 12:00 position.

. Click OK to complete the process.

8. Set the appropriate optical configuration. See Cytometer configuration (page 59).

. When fluidics startup is complete, select Sort > Sort Setup and verify that the setup mode matches the
nozzle size.

For information about Sort Setup modes, see Sort setup (page 70).

Starting the stream

. Confirm that the in-house air pressure, or the compressor, is on.

é When the stream is on, air pressure fluctuates between 80-100 PSI. A pressure reading of less
than 80 PSI or greater than 100 PSI indicates that the fluidics are not functioning properly. If this
occurs, contact your BD Biosciences service representative for assistance. Do not operate the

cytometer outside the normal air pressure range.

Start the stream.

. a. Click the Sorting button on the Workspace toolbar to display the Breakoff and Side Stream windows.
b. Click the Stream button in the Breakoff window to turn on the stream.

Ensure that the lasers are off or in standby and the laser control software is closed.

5. Open the sort block door and check the stream.

The stream should flow smoothly from the nozzle into the center of the waste aspirator. If the stream is

flowing but is unsteady, check for bubbles in the flow cell. If you see bubbles, turn off the stream, wait for 10

seconds, and turn on the stream again. If you see any dripping or spraying, or the stream image appears
abnormal, turn off the stream and see Troubleshooting the stream (page 170).
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6. Close the sort block door.

Note: If you encounter bubbles in the sheath fluid stream at the 130-micron sort setting, perform a sample
line backflush for approximately 1 minute. Select Cytometer > Cleaning Modes > Sample Line Backflush.
To prevent bubbles, the sheath tank should be depressurized while not in use to prevent air from dissolving
into the sheath solution.

7. Close the Flow Cell access door and use the Start button in the laser control software to return the lasers to
the Ready state.

Setting up the breakoff

Establishing a stable drop pattern in the breakoff window is an important step in getting optimal results from
the system. See Breakoff Window (page 45) for more information on the parameters and controls in the
breakoff window.

The following figure shows good versus poor breakoff patterns.
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1. Adjust the Ampl slider until the drop breakoff is approximately in the top third of the Breakoff window.
Do not exceed 70 volts. If you cannot achieve a drop breakoff at <70 volts, do the following:

* As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off
the laser diode, but will keep the diode temperature constant.

¢ Check the flow cell for air bubbles. If you see bubbles, turn the stream off and back on.
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¢ Make sure the sheath pressure and drop-drive frequency are appropriate.
¢ If the amplitude is <10 volts, turn on attenuation in the Side Stream window.
2. Verify that the small satellite droplets are merging with the large droplets.

If the satellites are not merging, you might need to clean the nozzle by sonicating. The satellite drops should
merge into the drops in 6 satellites or fewer.

3. Enter the actual Drop 1 value as the target in the Drop 1 field.
The actual value is displayed in the gray background next to the Drop 1 field. Once a valid target has been
established, you do not need to reset it unless you change the nozzle or your sort setup option.
Note: If the target value causes the amplitude to exceed 70 volts, perform the recommendations under
step 1 and re-enter the Drop 1 target value.

4. Turn on the Sweet Spot when the drop pattern is stable.

The Sweet Spot is designed to automatically adjust the drop-drive amplitude to maintain the stability of the
breakoff point. When the Sweet Spot is on, the Amplitude and Frequency fields are disabled. The values are
automatically adjusted by the software. For more information, see Breakoff Window (page 45).

The breakoff patterns shown in the following table are intended as examples. The patterns will not always look
exactly like these.

70 micron 85 micron 100 micron 130 micron
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Setting up the fluidics

Check the fluid levels in the sheath tank and waste containers every time you use the cytometer. This ensures
that you will not run out of sheath fluid during an experiment or have to service the containers during a sort.
Fluid level indicators are shown in the Cytometer window in BD FACSDiva™ software.

If a fluid container is running low, refill it with the fluid indicated on the container label. For best results, fill the
containers only with the fluids shown in the following table. For ordering information, see Reagents (page 189).

For instructions on emptying the waste, see Emptying the waste tank (page 97).

Container Compatible Fluids Capacity

Sheath@ e BD FACSFlow™ sheath fluid (non-sterile) One 10-L stainless steel

« 1X phosphate-buffered saline (PBS), with or without preservatives | container

Ethanol 70% solution diluted in deionized (DI) or laboratory-grade water One 5-L stainless steel
Shutdown container
Bleach » 10% household bleach (0.5% sodium hypochlorite) 5L

e BD FACSClean™ solution

DI Deionized water (Milli-Q or equivalent). Add 3 mL of bleach per literof [ 5L
DI water.
Ethanol 70% solution diluted in DI or laboratory-grade water 5L

Note: Make sure the blue sheath fluid line between the sheath tank and the cytometer does not come into
contact with anything that could introduce vibration that might affect the stability of the stream.

Refilling the sheath tank

The fluid level in the pressurized stainless steel sheath tank should be checked often and refilled when low. The
startup times for the breakoff stream will increase when the tank is low. If the cytometer is run until the sheath
supply is too low, the system will turn off the stream.

Top view Side view
Fluid li To flter Sheath
uid line filter

Containment
device

Pressure relief

Sheath valve

Sensor.

Fluid
connector

To instrument

AUsers should select solutions that are compatible with their specific samples and experiments.
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To refill the sheath tank:

1. Turn off the stream.

2. Disconnect the air line.

3. Pull up on the ring of the pressure relief valve to release pressure from the tank.
Make sure the tank is fully vented.

4, Unscrew the sheath tank cover knob and remove the cover.

Fill the tank with sheath fluid up to the upper weld line on the inside of the tank. See the following figure.

Note: Do not overfill the sheath tank because this can cause incorrect sample flow rates.

/—\ Upper weld line to

indicate fill level

6. Replace the cover and tighten the knob.

Make sure the large O-ring on the inside lip of the cover is seated correctly and has not slipped out of
position. The tank can leak if the cover is not secured properly.

7. If you removed the sheath tank to refill it, place the tank back in its original position.

The flow rate is calibrated with the sheath tank in the fluidics drawer. If the location or elevation of the
sheath tank is changed, it could affect the flow rate calibration.

8. Connect the air line.
9. Close the vent release valve and use the sheath tank gauge to ensure the tank is pressurizing properly.
The system is ready to run again.

Refilling the ethanol shutdown tank

The fluid level in the stainless steel ethanol shutdown tank should be checked before starting the fluidics
shutdown procedure and refilled when low. This tank does not have a sensor, so it must be checked manually.
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Top view Side view

To filter
Fluid line

Ethanol
filter

Pressure relief

Fluid )
connector Air

connector

Cover

knob To instrument

Ethanol shutdown tank

1. Turn off the stream.
If the air line on the ethanol shutdown tank is connected, disconnect it.
Pull up on the ring of the pressure relief valve to release pressure from the tank.
Make sure the tank is fully vented.
4. Unscrew the tank cover knob and remove the cover.
5. Fill the tank with ethanol to the level shown in the figure following this procedure.
6. Replace the cover and tighten the knob.

Make sure the large O-ring on the inside of the cover is seated correctly and has not slipped out of position.
The tank can leak if the cover is not secured properly.

7. If you are going to perform fluidics shutdown, connect the air line.

Fill level

Refilling the plastic containers

You can refill the plastic containers directly in the fluidics drawer without detaching any lines, or you can
remove the container for refilling.

Note: During operation, you can add fluid to a container through the large cap without any interruption to your
experiment, but if you detach any lines, you will need to prime the system.

1. (Optional) Disconnect the container’s sensor and quick-release connector from the connectors panel if you
need to move the container.

If you do not need to move the container, skip to step 2.
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Quick-release
connector

i~ Large-sized
cap

Remove the large-sized cap from the container.
Fill the container with the fluid indicated on the container label.
Replace the container cap and hand-tighten it until it is fully closed.

vos W

If you disconnected the sensor and quick-release connectors in step 1:
a. Reconnect the sensor and quick-release connectors to their respective ports.

Q To ensure that the appropriate solutions are dispensed, do not switch the tank positions. Make
sure the label on each container matches the labeled port on the fluidics drawer.

b. Prime the fluidics system.

From the BD FACSDiva™ menu bar, select Cytometer > Cleaning Modes > Prime after Tank Refill. In
the dialog that opens, select the fluid to prime, then click OK.

Emptying the waste tank

Empty the waste tank daily and when the fluid indicator shows the waste is getting full. To prolong the life of
the tank, we recommend that you switch to an alternate tank each time the waste is emptied.

‘@ All biological specimens and materials coming into contact with them can transmit potentially fatal
disease. To prevent exposure to biohazardous agents, expose waste tank contents to bleach (10% of

total volume) before disposal. Dispose of waste in accordance with local regulations. Use proper
precautions and wear suitable protective clothing, eyewear, and gloves.

A@ Change the waste tank cap and baffle every month, or when it has gotten wet, to prevent container
pressurization. To order new replacement caps and baffles, contact your local BD Biosciences
representative.
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Item Number | Component

1 Waste fluid line
2 Waste air line

3 Waste sensor

4 Waste tank

5 Waste cap and baffle
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1. Disconnect the waste tank’s sensor and fluid line connectors from the connector panel in the fluidics drawer.

W

j—
Waste fluid lines Waste sensor

A@ The waste tank can become pressurized when the cytometer is running. Always disconnect the
tank from the connector panel before you empty it. Wait at least 1 minute for pressure to

dissipate before you open the tank.
2. Remove the disposable waste cap (large-sized cap) and attached baffle from the container. Place the
assembly on the bench label-side up.

A@ Do not wet the cap on top of the baffle. If you see liquid inside the baffle, replace the cap an
baffle with new components.

3. Empty the waste tank according to your standard laboratory procedures for biochazardous waste.
4. Add approximately 1 L of bleach to the waste tank (10-L container).
Add a sufficient amount so that 10% of the total waste volume is bleach.

5. Replace the waste baffle and attached filter cap. Hand-tighten the trap and cap until they are fully closed.

>

@ To prevent over-pressurization during fluidics startup, do not overtighten the baffle or attached
filter cap. Tighten each component only until it is hand-tight. Do not use sealants such as Teflon®

tape or other adhesives.

6. If one month has passed since you last changed the cap, replace the filter cap and baffle with new ones.
Write the date on the new cap as a reminder.

7. Reconnect the sensor and fluid line connectors to their respective ports.

Checking cytometer performance

Before setting up an experiment, you should first run a performance check. A performance check ensures that
the cytometer is performing consistently over time. It also generates default cytometer settings that places
each PMT within an optimal range.

To run a performance check, start the BD® CS&T Research Beads application within BD FACSDiva™ software
and select the appropriate cytometer configuration. Each configuration must have a valid baseline. See the
BD® Cytometer Setup and Tracking Application Guide for more information on running a baseline.
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Preparing the BD® CS&T Research Beads workspace

To ensure that your cytometer is performing consistently over time, it's important to keep as many variables
constant as possible, such as bead type, sheath pressure, and cytometer settings. For this reason, you should
run the daily performance check using the same cytometer configuration each day.

1. Turn off the Sweet Spot (if it is on), then select Cytometer > CST.

The cytometer disconnects from the BD FACSDiva™ interface and connects to the BD® CS&T Research
Beads interface. A window similar to the following figure opens.

Note: Do not run the CST program in a maximized window.
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2. Verify that the bead lot information under Setup Beads matches the BD® CS&T Research Beads lot.

Sabup Basds

EmTE ~|
Product CST Setup Beads
Past 683391

Expuation Dabe:  10-10-2007

Select the correct lot ID from the menu. The bead lot ID number is located on the BD® CS&T Research
Beads vial.

3. Verify that the cytometer configuration is correct for your experiment.

Cytometer Configuration 3-laser, 9-color (5-2-2) Configuration 7 (BD def ault)
Lot ID 68341

If the cytometer is not set to the correct configuration:



Chapter 5 Startup and running samples | 101

a. Click Select Configuration in the Setup Control window.

Load & bube with beads and dick Run button bo start ssbup.

Chansctorizn: Chack Prarformans -
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Cytometer Corfipurstion: 4-Blus 2-Viokt 2-35500% 2-Red (

dh Select Configur ation

Sebup Beads
Lok ID; G bl
Produck 5T Setup Beads

Pt B I
Ewpraben Dale  10-10-2007

b. Select the correct configuration from the list.

Configurations |Parameters || Filkers and Mirrors|

== Base Configurations
@ 3-laser, 9-color {5-2-2) Configuration 5 (... 01/02/07 ...
[=HES?| Training class configurations

&) 70-70-High
70-35-Medium 04/04/07 ...
100-20-Law 40407 ..

c. Click Set Configuration. Click OK.

4. Verify that the current configuration has a valid baseline defined.
If not, see the BD® Cytometer Setup and Tracking Application Guide for more information on running a
baseline.

’ﬁ Cytometer Setup and Tracking
| Eile Cytometer Took
Saup 'll:ep-arls IPerfmmruTrmlq

System Summary: OK

Cylomatar Configuration Sys Val 100w I0psi 488, SE1, &80, 40%
Lot I e
Valid baseline B Cyiomeser Enseling June 21, 2013 12:51 PM
Performance check date ————— & Cytometer Perkemance Jung 25, 2013 §5:04 PM
LJ Cinereter Perlormares Flesuin  Passed

Preparing the BD FACSDiva™ BD® CS&T Research Beads

BD FACSDiva™ CS&T Research Beads consist of bright, mid, and dim beads dyed with a mixture of
fluorochromes. Use the beads to define a baseline and to check cytometer performance using the CS&T

application.
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See the BD FACSDiva™ BD® CS&T Research Beads technical data sheet for instructions about preparing the
bead suspension. Instructions vary based on the task you are performing.

Running a performance check
The performance check function of BD® CS&T Research Beads will check the cytometer’s daily performance.

1. Confirm the lasers are in the Ready state using the laser control software.

2. & Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do
not place objects underneath the loading port.

3. Inthe Setup Control window, select Check Performance from the Characterize menu.
4. Click Run.

Satup Conkral - RGO
Lo & bubse wakh beads and diick Fun buthon Bo stark setup,

haracterize: Check Performance w

|i3 Runi (W]

Plots are displayed under the Setup tab and the performance check is run. The performance check takes
approximately 5 minutes to complete.

Reviewing the results

1. Once the performance check is complete, click View Report.
2. Print the report.

3. Verify that the performance check passed.

In the Setup tab, the Cytometer Performance Results should have a green checkmark and the word Passed
next to it.

If any parameters did not pass, see the BD® Cytometer Setup and Tracking Application Guide for
troubleshooting information.
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4. Select File > Exit to close the BD® CS&T Research Beads window and connect back to the BD FACSDiva™
interface.
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5. Click Use CST Settings in the CST Mismatch dialog that opens.
See CST Mismatch dialog (page 103) for more information.

When CS&T settings are applied to new experiments, the settings applied include PMT voltages, threshold,
laser delays, and area scaling factors. (The window extension values are generated from the cytometer
configuration.)

When CS&T settings are applied to existing experiments, the settings applied include PMT voltages, laser
delays, area scaling factors, and window extensions. Threshold values remain the same.

There is a system preference to always use current BD® CS&T Research Beads settings that can be set by
the administrator. For BD FACSymphony™ S6 cell sorter users, we recommend that you do not enable this
preference.

At this point you can do one of the following:

¢ Create application settings for an experiment you will use frequently. See Application settings (page 103).

» Collect data using existing application settings. See Data collection (page 108).

CST Mismatch dialog

If there is a mismatch between the BD® CS&T Research Beads settings and those in BD FACSDiva™ software, a
dialog opens to indicate what the differences are, and gives you the following options:

e Use CST Settings. Select this option if you want to use the settings generated from the most recent
performance check.

e Keep BD FACSDiva Settings. Select this option if you want to keep the settings that are associated with
your cytometer.

¢ Details. Click this button to view the differences between the two settings to help with your selection.
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¢ See Data collection (page 108).

Application settings

Application settings are associated with a cytometer configuration and include the parameters needed for the
application, area scaling values, PMT voltages, and threshold values, but not compensation. Each time a
performance check is run for a configuration, the application settings associated with that configuration are
updated in the catalog. To update the application settings in an existing experiment, right-click the application
settings in the Browser and select Application Settings > Apply.

Using application settings provides an easy, consistent, and reproducible way to reuse cytometer settings for
your commonly used applications. See the BD® Cytometer Setup and Tracking Application Guide for
information on running a baseline and for other details on using the CS&T application.

Before creating application settings you must:
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¢ Perform the cytometer startup procedure described in Cytometer startup (page 88).

¢ Run a performance check for the cytometer configuration that will be used for the application.

Creating application settings

This section describes how to create and save application settings for a multi-color immunophenotyping
sample.

Setting up the workspace

1. Select Cytometer > View Configurations, and verify that the current configuration is appropriate for the
type of sample you are running.

Verify that there is a valid performance check for the configuration.

Create a new folder.

Create a new experiment.

Select the Cytometer Settings in the Browser.

In the Inspector window, click the Parameters tab and delete any unneeded parameters.
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Adjusting area scaling

The required area scaling factor changes based on sheath pressure and particle size. The area scaling factors
should be verified for each experiment performed on the cytometer.

Note: You will need to modify the template to support the lasers installed on your system. Don’t forget to save
the settings when you are done.

1. Inthe Browser, right-click Global Sheet1 and select Apply Analysis Template.

2. Inthe Template dialog, select the Area Scaling worksheet and click OK.

3. Create a new specimen by clicking the New Specimen button on the Browser toolbar.

4

Expand the new specimen, then click to set the current tube pointer to Tube_001.
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5. Install the FITC-positive control tube onto the loading port and click Load on the Acquisition Dashboard.

A

6. Adjust the FSC and SSC voltages to place the particles on scale.

Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.

Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do

not place objects underneath the loading port.
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7. Adjust the P1 gate around the population of interest in the FSC vs SSC plot.

Specimen_001-Tube_001
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8. Adjust the FSC area scaling.
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a. Click the Laser tab in the Cytometer window.
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b. Adjust the FSC area scaling factor until the FSC-A signal matches the FSC-H signal.
 Increase the area scaling factor if the FSC-A signal is lower than FSC-H.
* Decrease the area scaling factor if the FSC-A signal is higher than FSC-H.
¢. View the result of your change in the histograms and statistics views.
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9. Adjust the blue laser area scaling until the FITC-A signal matches the FITC-H signal, if needed.
10. Unload the FITC-positive control tube, then load the APC-positive control tube.
11. Adjust the red laser area scaling until the APC-A signal matches the APC-H signal, if needed.
12. Check and adjust, as necessary, the area scaling for the remaining lasers using a single color stained tube.
Only one parameter from each laser needs to be used for area scaling.

13. Inthe Inspector window, clear the checkboxes for height for all parameters.
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Optimizing PMT voltages

1. Right-click Cytometer Settings in the Browser, then select Application Settings > Create Worksheet.
A second global sheet is added with the plots created according to your selections in the Parameters tab.
Use the gray boxes and crosshairs to guide your optimization.

Note: The gray boxes and crosshairs are not displayed until acquisition starts.
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Load a multicolor sample tube onto the cytometer.

In the Cytometer window, optimize the settings for your application.

a. Optimize the FSC and SSC voltages to place the population of interest on scale.

b. Optimize the FSC threshold value to eliminate debris without interfering with the population of interest.
4. Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for that parameter until the positive population
can be seen entirely on scale.

5. Unload the multicolor sample from the cytometer.
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Saving application settings
1. Right-click Cytometer Settings in the Browser, then select Application Settings > Save, to save the values

for reuse.
Save Application Settings b4
Enter a name for the Application Settings
6-Color Application Settings|
a. Inthe Application Settings dialog, rename the application settings with a descriptive name.
b. Click OK.

The application settings are saved to the catalog.

Data collection

Before you record data for a sample, cytometer settings should be optimized to position the cells of interest on
scale for scatter and fluorescence parameters. In the previous section, application settings were created by
taking into consideration the following:

¢ FSC and fluorescence area scaling
e FSCand SSC voltages

* FSC threshold

¢ Fluorescence PMT voltages

In this section, the application settings will be applied and compensation will be calculated before collecting
test data.

The following sections describe how to use previously optimized application settings for a 4-color experiment.
See Application settings (page 103) for more information.

Compensation will be automatically calculated using the compensation setup feature. For more information
about this function, see the BD FACSDiva™ Software Reference Manual. If you are performing compensation
manually, not all steps will apply.

Setting up the workspace
Before you begin optimizing settings, it is important to verify the cytometer configuration and create an
experiment containing appropriate parameters for the assay.

1. Select Cytometer > View Configurations, and verify that the current configuration is appropriate for the
type of sample you are running.

2. Verify that there is a valid performance check for the configuration.
Make sure that the HPC(s) contain appropriate filters.
For assistance, see Cytometer configuration (page 59).

é For accurate data results, the cytometer optics must match the current cytometer configuration.

4. Click the corresponding buttons on the Workspace toolbar to display the Browser (“*'), Cytometer ( * )

Inspector ( o ), Worksheet ( = ), and Acquisition Dashboard (***) windows, as needed.

5. (Optional) Create a folder for your experiment.



10.

11.

12.

Chapter 5 Startup and running samples

Select the icon for your database and press Ctrl+N. Rename the folder appropriately. See the BD FACSDiva™

Software Reference Manual for ideas on how to organize experiments.

Note: To place an experiment inside a folder, select the folder before you create the experiment.
Create a new experiment.

Rename the experiment appropriately (for example, 4-Color experiment).

Create the following plots for doublet discrimination in the global worksheet:

a. FSC-Avs SSC-A, containing a scatter gate

b. FSC-A vs FSC-H, displaying events from the scatter gate, with an FSC gate drawn on the plot
c. SSC-A vs SSC-H, displaying events from the FSC gate, with an SSC gate drawn on the plot

We recommend that you perform doublet discrimination in order to analyze and sort only singlet events. A
procedure is given in Recording data (page 113).

Right-click the experiment level Cytometer Settings in the Browser and select Apply Application Settings.
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See Application settings (page 103) for instructions on creating application settings.
Select the application setting for your sample and click Apply.

The following figure shows a typical error message if there are any mismatches between the application and

cytometer settings.

¥l Cytometer Settings Mismatch

The application settings to be applied do not match the selected cytometer settings.

The Following parameters are not in the cytometer settings to be applied: Cascade Blue-A.
The Following parameters are not in the selected application settings: FSC-H, S9C-H, PE-Texas Red-4,
PE-Cy7-A, APC-Cy7-A, Alexa Fluor 405-4, Alexa Fluar 430-4,

Click Apply to apply PMT Yoltage and Threshold values only For matching parameters.,

Click Cwverwrite bo replace all parameters and values with those from the selected application settings.

[ Apply ” Cwerwrite H Cancel ]

Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog opens, listing only those parameters associated with the
application settings.

Click OK to add the specified controls.

Alternatively, add and define label-specific controls, then click OK.
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Add label-specific controls when your experiment contains samples stained with the same fluorophore
conjugated to different antibodies (labels) that require different compensation values. This is especially
useful with tandem conjugates due to lot-to-lot variation. See the BD FACSDiva™ Software Reference
Manual for more information about this function.

A compensation specimen is added to the experiment, along with a stained control tube for each
compensation control. (Expand the specimen to view all tubes.) Worksheets containing appropriate plots are
added for each compensation tube.
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Calculating compensation

The unstained control will be used to verify the settings for FSC, SSC, and FSC threshold, and to gate the
population of interest.

1.

2.
3.
4

6.

Confirm the lasers are in the Ready state using the laser control software.
Install the unstained control tube onto the cytometer.
Expand the compensation specimen in the Browser.

Set the current tube pointer to the unstained control tube and click Load.

& Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do

not place objects underneath the loading port.

Verify that the population of interest is displayed appropriately on the FSC vs SSC plot. Adjust if needed.

Since the application settings have already been optimized for your sample, the cytometer settings should
require little or no adjustment (unless you are using BD® CompBead particles).

Unstained Control

S3C-A (1,000
§0 190 150 2p0 240

|||”|||||||||||||||||||||||
&0 100 150 200 250
FSi-A e 1,000)

Click the Threshold tab and adjust the FSC threshold, if needed.

Set the threshold to remove most of the debris without cutting off the singlet population.



7. Adjust the P1 gate to surround only the singlets.

8. Right-click the P1 gate and select Apply to All Compensation Controls.

Chapter 5 Startup and running samples

The P1 gate on each stained control worksheet is updated with your changes.

9. Click Record Data.

10. When recording is finished, click Unload and remove the unstained control tube from the cytometer.

é Do not change the PMT voltages after the first compensation control has been recorded. In order

to calculate compensation, all controls must be recorded with the same PMT voltage settings. If

you need to adjust the PMT voltage for a subsequent compensation control, you will need to

record all compensation controls again.

11. Install the next tube onto the cytometer and repeat steps 9 and 10 until data for all stained control tubes

has been recorded.

12. Double-click the first stained control tube to display the corresponding worksheet.

13. Verify that the snap-to interval gate encompasses the positive population. Adjust the gate, if needed.

FITC Stained Control

S3C-A (¢ 1,000)
51190 150 2p0 240

FITC Stained Control

Count
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14. Repeat steps 12 and 13 for the remaining compensation tubes.

15. Select Experiment > Compensation Setup > Calculate Compensation.

16. Enter the name of your experiment as the setup name, then click Link & Save.
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To keep track of compensation setups, include the experiment name, date, or both in the setup name.

Note: We recommend that you always visually and statistically inspect automatically calculated overlap values.

The means of the positive controls should be aligned with the means of the negative.

Data recording and analysis

Once you have optimized the cytometer electronics for your sample type, you are ready to record and analyze

data.

Before you record data, we recommend that you gate out doublets in order to record only singlet events.

During analysis, recorded data is displayed in plots, and gates are used to define populations of interest.

BD FACSDiva™ software analyzes the gated data and calculates statistics that you can print or export. With
global worksheets, data can be shown for a series of tubes on the same worksheet, manually or in an
automated batch analysis.
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The following sections describe how to use BD FACSDiva™ software features to record and analyze sample
data.

Setting up the experiment

Before you record data, set up an experiment with appropriate tubes, plots, and labels for your assay. This
section describes how to add Browser and worksheet elements to the experiment that was started in the
previous section, Data collection (page 108).

1. Rename Specimen_001 to a descriptive name.

2. Rename Tube_001 to 4-color_001.

3. Set the current tube pointer to the 4-color_001 tube.

4. Click Next Tube in the Acquisition Dashboard to duplicate the first tube with the name 4-color_002.
5. Use the experiment layout to specify the number of events to record for each tube.

The experiment layout can be used to define the events to record as well as parameter labels for all tubes in
an experiment. Labels are displayed on the plot axes and in all statistics views.

a. Select Experiment > Experiment Layout.

b. Inthe Acquisition tab, select the events to record field for all specimen tubes, and select or enter 5,000
events.

c. Click OK.

——

Setting up the global worksheet

A global worksheet is used to perform doublet discrimination and to set up plots to preview and record data.
1. Click the Worksheets View button on the Worksheet toolbar.
The global worksheet is shown.

The second and third plots are set up to display gated data from the first and second plots, respectively, as
shown in the population hierarchy.

2. Create two dot plots for previewing and recording data.
For this example, create a FITC vs PE plot and an APC vs PerCP-Cy5.5 plot.
Note: Double-click the Plot button to keep it selected until you create all plots. Click any other button to
undo the selection.
3. Turn on biexponential display.
a. Select the two plots.
b. Inthe Inspector, select the checkbox for X Axis and Y Axis under Biexponential Display.
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Set up the fluorescence plots to display data from the SSC gate.

The SSC gate defines singlet events. By gating the fluorescence plots through this population, only singlet
events will be used for analysis and sorting.

a. Select the two plots.
b. Inthe Inspector, select the SSC Gate checkbox.

Arrange the fluorescence plots so they fill the page vertically.

Recording data

This section describes how to adjust the gates to eliminate doublets and record singlet events.

1.
2.
3.

11.

© v ® N O U &

Confirm the lasers are in the Ready state using the laser control software.
Move the current tube pointer to the 4-color_001 tube.

Install the first mixed sample tube onto the loading port and click Load.

& Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do

not place objects underneath the loading port.

Change the Events to Display to 5,000 events.

Adjust the scatter gate to encompass the events of interest.

Adjust the FSC gate to encompass the low FSC-H population.

Adjust the SSC gate to encompass the low SSC-H population.

Click Record in the Acquisition Dashboard to record data.

When all events have been recorded, click Unload and remove the tube from the cytometer.

Install the next tube, then click Next Tube in the Acquisition Dashboard to move the current tube pointer
to the next tube.

Repeat steps 7 through 9 for the remaining tubes.
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Analyzing data

This section describes how to set up plots, gates, and a statistics view to analyze the recorded data.

1. Select Edit > User Preferences.

2. Inthe Gates tab, set the preferences as follows.
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3. Create the following gates:
¢ Quadrant gate on the FITC vs PE plot.
¢ Interval gate on the APC vs PerCP-Cy5.5 plot to capture the APC beads.
¢ Rectangle gate on the APC vs PerCP-Cy5.5 plot to capture the PerCP-Cy5.5 beads.

4. Rename each population in the population hierarchy.

Note: Press the Enter key twice to move to the next population without using the mouse.
5. Right-click either fluorescence plot and select Create Statistics View.
A statistics view is added to the worksheet.
6. Right-click the statistics view and select Edit Statistics View.
7. Edit the statistics view as follows:
¢ Inthe Header tab, select the Use 2 columns for display checkbox.
¢ Inthe Populations tab, clear the checkboxes for all populations except FITC, PE, PerCP-Cy5.5, and APC.
¢ In the Statistics tab, select the Mean checkboxes for the fluorescence-A parameters.
8. Resize the statistics view so it fits on the page.

9. (Optional) Print the analysis.
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Performing a batch analysis

Batch analysis allows you to automatically advance through a selected set of tube data when using a global
worksheet.

To perform a batch analysis:
1. Verify that the global worksheet you will be using for analysis is displayed in the worksheet window.
2. Right-click the specimen to analyze in the Browser and select Batch Analysis.

The Batch Analysis dialog opens.

Only tubes under the selected specimen will be processed. Tubes without data are skipped during a batch
analysis.

3. Do the following in the Batch Analysis dialog.
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¢ Select Auto to analyze all the files without user intervention.
¢ Select 5 from the View Time menu to pause the analysis for 5 seconds after each tube is loaded.

¢ Select the Output to Printer checkbox to print a copy of the analysis after the data for each tube is
loaded.

¢ Select the Statistics checkbox to export the statistics to a separate file, then enter a name for the
statistics file. By default, the file is saved at D:\BDExport\Statistics.

¢ Select the Freeze Biexponential Scales checkbox to process all files with the same biexponential scales.

¢ Clear the Use Preferred Global Worksheet checkbox to display analyses of tubes within the same global
worksheets. This option is useful for analyzing panels that require a separate global worksheet for each
tube.

See the BD FACSDiva™ Software Reference Manual for more information on batch analysis.
4. Click Start to begin the analysis.

When the analysis is finished, a completion dialog opens.
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Manual adjustment of laser delay

Laser delay is automatically adjusted during performance checks. However, you may want to adjust laser delay
manually, for example, when changing sheath pressure.

The laser-delay factor in BD FACSDiva™ software is used to realign the signals so they can be measured and
displayed on the same time scale. Signals are aligned with respect to the blue laser, so the blue laser will have a
0 delay value. The delay values for other lasers will be negative or positive depending on their order in relation
to the blue laser.
To manually adjust the delay:

Select your experiment folder in the Browser and create a new experiment.

Rename the experiment Laser Delay.

. Create a specimen and a tube in the experiment and set the current tube pointer next to the tube.

1
2
3
4. On the global worksheet, create a plot for FSC vs SSC and then histograms for each laser.
5. Create a P1 gate on the FSC vs SSC plot and change the histograms to view P1.

6

Prepare a tube of Spherotech™ Rainbow beads.

BD FACSFlow™ Solution Spherotech Rainbow Particles (3.0-3.4 pm) Ordering Info

1mL 2 to 3 drops Cat. No. 556291

7. Load the tube of Spherotech Rainbow beads and click Load.

& Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do

not place objects underneath the loading port.

8. Place the population on scale in the FSC vs SSC plot.
9. Adjust P1 to encompass the singlet population, if needed.

Rainbow Beads-050106
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a. Optimize the delay setting for the red laser.
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b. Click the Laser tab in the Cytometer window.
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¢. While watching the peak in the APC-A histogram, change the window extension to O.
« If the APC-A signal stayed the same or had little change, then go to step d.
 If the APC-A signal decreased, then follow steps c through d.

d. Adjust the laser-delay value until the maximum APC-A signal is achieved.
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e. Reset the window extension to the appropriate setting (typically 2).
10. Repeat step 9 for each laser, using the appropriate fluorochrome for each laser.

11. (Optional) To return to the laser delay values determined by CS&T, right-click the cytometer settings in the
Browser and select Apply CST Settings.

12. (Optional) To save this worksheet for future use, export it as an analysis template.
a. Right-click the global worksheet in the Browser.
b. Select Export > Analysis Template.
¢. Name the template Laser Delay Plots and click Save.
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Sorting

You can program BD FACSDiva™ software to sort a specified number of particles from multiple populations into
a variety of sorting devices including tubes, plates, and slides. Up to four defined populations can be sorted into
each tube, allowing up to 24 populations to be sorted at one time.

The following topics are covered in this chapter:

¢ Setting up for sorting (page 120)

¢ Determining the drop delay — manual method (page 123)

e Determining the drop delay — automatic method (page 126)

¢ Sorting (page 127)

 Setting up for sorting onto a plate or slide (page 132)

¢ Index sorting (page 136)

e Terasaki plate adapter (page 138)
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Setting up for sorting

In general, do the following to set up for a sorting experiment. Each step is explained in more detail in previous
or subsequent sections.

1. Start up the cytometer and the computer.
See Cytometer startup (page 88).

2. Install the appropriate size nozzle.

3. Select a new sort setup mode, if needed, and select an appropriate cytometer configuration.
To change your current sort setup mode, select a nozzle size from the Sort > Sort Setup menu.
For more information, see Sort setup (page 70).

4. Install a sample line filter, if needed.

See Installing or removing a sample line filter (page 159).
5. Check the laser delay for your sheath pressure and particle size.

¢ To set the laser delay automatically using the CS&T module, see Checking cytometer performance (page
99).

¢ Toset the laser delay manually, see Manual adjustment of laser delay (page 116).
6. If you have the AMO, turn it on at 20%.
See Operating the BD® Aerosol Management Option (page 193).
7. Optimize cytometer settings for the sample to be sorted.
See Data collection (page 108).
8. Install the required collection device and set up the side streams.
See Setting up for bulk sorting (page 120) or Setting up for sorting onto a plate or slide (page 132).
9. Calculate the drop delay.
See Determining the drop delay — automatic method (page 126).
10. Use gating tools and subsetting methods to define the population(s) of interest.
Examples of gating analyses can be found in Analyzing data (page 114).
11. Define a sort layout for the tube containing the defined sort populations and proceed with sorting.
See Sorting (page 127).

Setting up for bulk sorting

This section describes how to set up the streams for two-, four-, or six-way sorting. For sorting using the ACDU
option, see Setting up for sorting onto a plate or slide (page 132).

A@ Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal
disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing

and gloves.

To set up for bulk sorting:
1. Install collection tubes in the appropriate collection device.

Collection tube holders are available for 1-mL microtubes, 1.5-mL Eppendorf® tubes, 12 x 75-mm tubes, and
15-mL centrifuge tubes. For compatible tubes, see Labware (page 190).
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Install the collection tube holder onto the cytometer.

a. Close the sort block door and open the sort collection chamber door, if needed. The sort block door must
be closed to install the tube holder.

b. Slide the holder into the slotted fittings below the sort aspirator drawer, then close the sort collection
chamber door.

A@ Before installing the collection tube holder, ensure that an O-ring is installed in the groove
between the two sections of the tube holder. The O-ring minimizes the chance of aerosols
escaping. It can be found in the accessory kit (Catalog No. 337897).

. Turn on the deflection plates.

Click the Voltage button in the Side Stream window. The voltage warning light illuminates, indicating that
the plates are charged.

A A 12,000-volt potential exists between the deflection plates when they are on. Contact with the
charged plates results in serious electrical shock. Do not touch the deflection plates when the
plate voltage is on. The plates remain energized even when the sort block door is open. Do not set
the plate voltage over 6,000V.

Make sure the center stream image does not move after the plates are turned on. Major movement of the
center stream could indicate that the plates or the area around the plates needs cleaning.

Click the Test Sort button and optimize the side streams.

Adjust the voltage sliders to view the required number of streams. If necessary, adjust the plate voltage to
achieve deflection in the outermost tubes. Do not exceed a plate voltage of 6000V.

If you cannot see a stream image or the image is dim, adjust the micrometer dial on the diode laser to
better view the streams.

. Adjust the 2nd, 3rd, and 4th Drop settings to tighten the center stream and fine-tune the side streams, if
needed.

Generally, the sort setup mode provides good starting values for these settings. Adjust the values only if
needed to optimize the streams.

. Open the aspirator drawer and aim the side stream(s) into each collection tube.
a. Inthe Side Stream window, click the Waste Drawer button to open the drawer.

b. Open the sort block door and aim each side stream along the horizontal axis into the tube as you adjust
the corresponding slider in the Side Stream window.

c. The 6-way sort collection device also includes set screws on either side of the device to center the
streams along the front-to-back axis. Adjust the set screws using a 1/16 hex key from the accessory kit.
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7.
8.

A seal must be formed between the top of the device and the bottom of the sort block. If there is a gap,
the front-to-back adjustment is incorrect.

d. When you are satisfied with the side stream deflection, close the sort block door.
Click the Voltage button to turn off the deflection plates.

Attempt to optimize drop delay using the automatic method first, then if necessary use the manual method.
For details, see the following procedures:

¢ Determining the drop delay — automatic method (page 126)
¢ Determining the drop delay — manual method (page 123)

Using the 1.5-mL side stream alignment tool

If you are using 1.5-mL Eppendorf tubes, use six tubes of ethanol to align the side streams and verify drop

placement.

1. Set the optimal breakoff.

2. Ensure that the center stream is aligned with the center of the aspirator drawer.

3. With the aspirator drawer closed (retracted), position the alignment tool in the sort block.

4. Turn on the deflection plates.

5. Click Test Sort, then adjust sliders to align each side stream to the corresponding notch on the alignment
tool.
Note: To prevent the stream fluid from pooling or splashing, place a wipe or paper towel inside the sample
collection chamber.

6. Turn off the deflection plates.

7. Carefully remove the alignment tool.

8. To verify stream alignment, place four capped Eppendorf tubes inside the Eppendorf collection tube holder
and insert the tube holder into the sort collection chamber.

9. Turn on the deflection plates.

10. Quickly click Test Sort twice to deposit a drop on the Eppendorf tube lids.
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11. Verify that the drops are deposited on the center of each Eppendorf tube lid.

Drop on Eppendorf tube lid

Note: For future reference, record the slider values or take a screen shot of the stream setup window.

Determining the drop delay - manual method

BD FACS™ Accudrop technology is used to determine the optimal drop-delay setting for your sorting

application. For more information, see Drop-Delay Overview (page 49).

There are two methods for determining the drop delay.

¢ Manual drop delay. Using the standard method as described in the following sections.

e Auto drop delay. Using an automated algorithm method. See Determining the drop delay — automatic
method (page 126).

Note: Before beginning these procedures, make sure the stream is stable and the Sweet Spot is on.

Setting up the experiment
This section describes how to set the drop delay using the Accudrop experiment template. Because no data is
recorded, the experiment can be reused as often as you like.
1. Create an experiment from the Accudrop Drop Delay template.
Select Experiment > New Experiment. Select the Accudrop Drop Delay experiment and click OK.
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2. Expand Specimen_001 and Tube_001.
3. Set the current tube pointer to Tube_001.
4. Open the sort layout by double-clicking it.
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Using manual drop delay

This section describes the manual method of optimizing the drop delay.

1.

Load a tube filled with a suspension of Accudrop Beads (approximately one to two drops of beads in 0.5 mL
of PBS).

& Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do
not place objects underneath the loading port.

Open the Parameters tab of the Cytometer window and adjust the FSC and SSC values until events are on-
scale. A typical value of FSC is ~500V and of SSC is ~250V.
In the Laser tab of the Cytometer window, set the window extension to zero.
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Adjust the flow rate to achieve an event rate of 1,000-3,000 events per second.

. Turn on the voltage in the Side Stream window. Click Sort in the Sort Layout window.
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Click Cancel at the Confirm dialog.
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There is no need to collect the beads. When the drawer is closed, the beads are sorted to waste.

Adjust the micrometer dial to obtain the brightest bead spot on the center stream.

8. Click the Optical Filter button in the Side Stream window.

10.

11.
12.

This control moves the emission filter that allows you to view the Accudrop Beads in front of the lower
camera. When the control is clicked, the image switches from a raw image to a processed (digitized) image.
The two boxes indicate the region of the image where the left and center stream intensities are calculated
during image processing. The numbers shown are percentages of the total intensity.

If the left side stream is not completely contained in the left region, adjust the voltage slider to place the
stream in the center of the region.

Verify that the sort precision mode is set to Initial.
See Sort Precision Modes (page 52) for more information.
Optimize the drop delay.

Adjust the drop-delay value in 1-drop increments (Ctrl+click arrow control) to achieve close to 100%
intensity in the left side stream. Wait a few seconds after each click for a complete response to the delay
change.
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In the Sort Layout window, change the precision mode to Fine Tune.
Optimize the drop delay.

Adjust the drop-delay value in 0.03-drop increments (click the arrow control) until the left side stream
intensity is greater than or equal to 90%. Wait a few seconds after each click for a complete response to the
delay change.
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13. Click the Optical Filter button to move the emission filter away from the camera.
14. Reset the window extension to its original setting (typically 2).
15. Turn off the deflection plates.

Determining the drop delay — automatic method

The auto drop delay feature automates setting the drop delay to get optimized results from sorting. You should
use this method after you have a good understanding of how drop delay works in general. See Using manual
drop delay (page 124) for more information.

Overview of auto drop delay

Auto drop delay works best when the sort system is stable, and assumes that Accudrop Beads are used. When
the process is started, the auto drop algorithm uses several passes to find best drop delay possible under the
current conditions of the system. Coarse passes are used to find the initial drop delay within 2 drops of the
ideal. The coarse passes are faster than the fine-tune passes. Fine-tune passes are used to locate the ideal drop
delay value considering the current conditions.

Using auto drop delay
1. Set up an experiment for drop delay as described in Setting up the experiment (page 123).
2. Load a tube filled with a suspension of Accudrop Beads (approximately 2 drops of beads in 0.5 mL of PBS).

ﬁ Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do

not place objects underneath the loading port.

3. Adjust the flow rate to achieve these values of events per second:
70 micron = 1,000 to 3,000
85 micron = 800 to 2,000
100 micron = 600 to 1,500
130 micron = 400 to 1,200
Note: If this cannot be achieved using a flow rate setting between 1 and 5, adjust the bead concentration.
4. Turn on the voltage in the Side Stream window. Click Sort in the Sort Layout window.
5. Click Cancel in the Confirm dialog.
There is no need to collect the beads. When the drawer is closed, the beads are sorted to waste.
6. Adjust the micrometer dial to obtain the brightest bead spot on the center stream.

7. Click the Auto Delay button in the Side Stream window.



A dialog opens, similar to that shown in the figure that following this procedure. The graph in the left pane
of the dialog represents brightness of the stream (Y axis) versus drop delay (X axis). Typically the graph
should have a flat portion, with several small peaks in either direction (up or down) or one prominent peak.

Note: If the original drop delay value was close to the appropriate value prior to starting auto delay, then
you may not get a graph displayed because few data points were required to determine the optimal drop

8. Select Start Run in the Auto Drop Delay dialog.

Sorting

Monitor the Auto Drop Delay dialog for progress.
A message is displayed when the process is completed.
Note: If the sort is stopped during algorithm execution (either by user action or because the system

detected a failure), the run will be stopped with an appropriate message. Start the sort again, verify that the
stream is stable and the sort is not pausing, and re-run the auto drop delay.
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Chapter 6 Sorting

Before beginning the sort, do the following:

1.
2.

Setting up the experiment

Note: When more than one drop is deflected in the same direction, residual charge from the first drop degrades
the quality of the side streams. Thus, when sorting more than one stream to a side or sorting into small wells
where precise deflection is required, use the 4-Way Purity mode or select a mode with a yield mask of zero. For

Perform the steps outlined in Setting up for sorting (page 120).
Use gating tools and subsetting methods to define the population(s) of interest.
Examples of gating analysis can be found in Analyzing data (page 114).
Note: Gates drawn on a biexponential scale can be used for sorting. However, the cytometer will sort on a
log scale. Therefore, a gate that crosses the zero boundaries will sort all events below zero into that gated

population. This can cause a variance between the sort results and the statistical results in the software. If
the gate is completely below zero on a biexponential plot, no events will be sorted.

Snap-to gates cannot be used for sort gates.

more information, see Yield Mask (page 50).
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1. Create a new sort layout by clicking the New Sort Layout button on the Browser toolbar.
By default, the 2-Tube Sort Layout is displayed.
2. Make appropriate entries in the Sort Layout window.
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¢ Select the collection device from the Device menu.

¢ Change the sort precision mode to Purity (two tubes), 4-Way Purity (four tubes), or Single Cell (plate or
slide).

¢ Enter the number of target events by selecting a value from the menu or entering a number in the field.

¢ Select a Save Sort Reports option: Save None, Save All, or Ask User. See Setting up a sort layout (page
73).

¢ Select the Save Conflicts checkbox if you are using a 2- or 4-tube sort layout and want to save conflicts.
¢ Select the Index Sorting checkbox if you are doing an index sort. See Index sorting (page 136).

¢ Select the sort location field(s) to be sorted into. Select multiple fields by dragging the mouse. Select a
row or column by clicking the row or column header.

¢ Add the required population(s) to each sort location field.
¢ To display fewer counters in the Sort Layout window, click the View Counters button and clear a menu

option. The corresponding counter is hidden. (Only counters with a checkmark next to the name are
displayed.)
Starting and monitoring the sort

To start the sort:
1. Open the sort collection chamber door and install the collection tubes, plate, or slide.

ﬁ The flow cell access door is equipped with a shutter mechanism that shuts off the laser light when
the door is opened. To ensure there is no interruption to data acquisition, do not open the door

while sorting or recording.
2. Close the sort collection chamber door.

é Failure to close the sort collection chamber door prevents the evacuator from generating negative
pressure in the chamber and could affect drop placement while sorting.

3. Install the sample tube onto the loading port and click Load.

& Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do

not place objects underneath the loading port.

4. Adjust the flow rate.
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Sorting results are typically optimized at lower flow rates.
5. (Optional) Turn on the deflection plates and open the aspirator drawer.

The deflection plates turn off automatically each time a tube is unloaded. If you do not turn them back on
before beginning a sort, a dialog is displayed in which you can turn on the plates and open the aspirator
drawer by clicking OK.

6. Verify that the current tube pointer is indicating the appropriate tube in the Browser, then click Sort.

7. Click OK if you are prompted to open the aspirator drawer or turn on the deflection plates.
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Q If you click Cancel, sorting will begin with the deflection plates off and the drawer closed. As a
result, sort populations will be identified and counted, but no deflection (or sorting) will occur. If

you sort with the drawer closed, events will be sorted to waste.

Note: Click Record Data to save data for the tube. Acquisition and sorting continue after the required
number of events has been recorded.

Sorting continues until the required number of cells has been sorted. Acquisition stops and the drawer closes
when sorting is complete. If the number of Target Events is set to Continuous, sorting continues until you
manually stop sorting by clicking the Stop Acquiring button in the Dashboard, or the Sort button in the Sort
Layout window.

Monitor the sort progress in the Sort Layout window. The number of events sorted into each sort location is
displayed in the corresponding field. The sort rate and sort conflict rate are displayed in the corresponding
counter fields.
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Note: When the Sweet Spot is on, sorting pauses automatically if the Drop 1 or Gap values are out of range.
This ensures that sorting occurs only under the proper breakoff conditions. If a more severe problem such as
a clog is detected, the stream shuts off and sorting stops. The deflection plates shut off, the aspirator
drawer closes, and the sample tube is unloaded.

8. (Optional) You can print the sort report at this time, or open the report later and print it then. You can also
export the report.

Stopping and Resuming a Sort

The Stop/Resume function allows you to temporarily stop the sort and still retain the counter values. This is
particularly useful when the sample volume is low and you need to refill the tube, or to replace collection tubes.
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Replacing a sample tube
1. To stop a sort while it is running, click the Sort button in the Sort Layout window.
2. If prompted, click OK to save the sort report.
You can set the sort report to save automatically after each sort. See Setting up a sort layout (page 73).
3. Unload the sample tube by clicking Unload on the Acquisition Dashboard.
Refill the sample tube, then click Load in the Acquisition Dashboard.

& Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do

not place objects underneath the loading port.

5. Click the Resume button in the Sort Layout window to continue sorting.
6. Click OK when you are prompted to open the aspirator drawer or turn on the deflection plates.

The sort counters resume from the value where they stopped. The threshold counter restarts. However, the
value is accumulated and the total count is saved in the final sort report.

Replacing the collection tubes
1. To stop a sort while it is running, click the Sort button in the Sort Layout window.
2. If prompted, click OK to save the sort report.
You can set the sort report to save automatically after each sort. See Setting up a sort layout (page 73).
3. Click Stop Acquiring in the Acquisition Dashboard to stop the sample flow.
4. Turn off the deflection plates by clicking the Voltage button in the Side Stream window.

Remove the lower section of collection tube holder by lifting up on the handle and pulling the lower section
of the holder down and forward.

Replace the collection tubes as needed.
Reinstall the tube holder and pull down on the handle to secure it in place.
Click Acquire Data in the Acquisition Dashboard to restart the sample flow.

Click the Resume button in the Sort Layout window to continue sorting.

© v ® N O

Click OK when you are prompted to open the aspirator drawer or turn on the deflection plates.

The sort counters resume from the value where they stopped. The threshold counter restarts. However, the
value is accumulated and the total count is saved in the final sort report.

Pausing and resuming a sort

The Pause/Resume function allows you to temporarily pause the sort, and still retain the sort counter values.
This is useful when you need to make adjustments to an experiment during a sort. Be aware that the sample
continues to flow during a pause.

Note: If you need to replace the sample tube to refill it, or to replace collection tubes, you should stop the sort.
See Stopping and Resuming a Sort (page 129).

1. To pause a sort while it is running, click the Pause button in the Sort Layout window.

2. Make adjustments to the experiment as needed.

3. Click the Resume button in the Sort Layout window to continue sorting.

Responding to a nozzle clog during a sort

Follow this procedure if your system does not have a BSC or the Aerosol Management Option (AMO).
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If your system:

¢ Does not have a BSC, but does have the AMO, see Responding to a nozzle clog during a sort with the AMO
(page 195).

e Does have a BSC and the Aerosol Management System (AMS), see Responding to a nozzle clog during a sort
(page 211).

If the stream is disturbed during the sort (due in part to a clogged nozzle), the sort is designed to stop
automatically and block the sort tubes (if Sweet Spot is on). If the system detects a clog, it displays the
following warning:

Warning

System Clog is Detected!!!

l y  Actions taken:
Moved drawer IN - for sample protection.
Turned voltage OFF at deflecton plates.
Sample flow is stopped and tube is unloaded.
“Sweet Spot” monitoring is turned OFF,
Stream is stopped.

oK

The sort will not restart until the operator has cleared the clog. In the event of a nozzle clog, do not open the
sort collection chamber door or access the sort tubes before following this procedure.

Cell sorters that use droplet generation methods, such as the BD FACSymphony™ S6 cell sorter, can
produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal
precautions at all times. Keep the sort block door and the sort collection chamber door closed during
sorting. Follow these steps to stop sample flow and evacuate potential aerosols before opening the
sort collection chamber door.

To clear a clogged nozzle:

1. If the stream has not already shut down automatically, turn off the stream by clicking the Stream button
(with a checkmark) at the top of the Breakoff window.

This will shut off the stream, unload the sample, and close the aspirator drawer.
2. Turn on the stream and view the breakoff.
If the clog is removed, the breakoff will be similar to the breakoff before the clog.
3. If the clog is not cleared, turn the stream on and off several times to see if the clog will clear itself.

4. If the clog is not removed, turn the stream off and perform the Clean Flow Cell procedure with DI water (see
Cleaning the flow cell (daily) (page 140)), followed by turning the stream on to see if the clog will be cleared.

5. With the aspirator drawer closed, wait for at least 3 minutes to clear aerosols before opening the sort
collection chamber and the sort block door.

6. Ifitis necessary to change nozzles or remove a clog from a nozzle, see Cleaning the integrated nozzle (page
156).

7. With the stream turned off, open the sort block door and dry the plates and surfaces as needed.
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@ When removing collection tubes, be aware that the outside of the tube is potentially
contaminated. Use alcohol swabs or bleach to wipe the outsides of tubes.

8. Make sure that all chamber doors are closed and restart the stream.
9. Perform these tasks if needed:

¢ Turn on the Sweet Spot

¢ Check the drop delay

¢ Check the side stream deflection

Setting up for sorting onto a plate or slide

The following sections describe how to set up for sorting onto a plate or slide. For general guidelines, see Setting
up for sorting (page 120).

Installing the sorting hardware

A@ Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal
disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing
and gloves.

1. Install the splash shield below the aspirator drawer.
a. Close the sort block door and open the sort collection chamber door, if needed.
The sort block door must be closed in order to open the collection chamber door.
b. Remove the tube holder, if one is installed.

c. Slide the splash shield into the slotted fittings below the sort aspirator drawer and push it all the way in.

Splash shield

2. Click the Access Stage button to bring the ACDU stage to the front.
a. Open an experiment, if one is not already open, and create a sort layout for any of the tubes.

b. Inthe Sort Layout window, click the Access Stage button to move the stage to the front of the sort
collection chamber.

3. Install the appropriate collection device on the stage.
¢ If you are sorting into a plate, install the plate with well A1 toward the front of the stage.

¢ If you are sorting onto a slide, install the slide-adapter tray with the printed side up. If your slide has a
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frosted end, place the frosted end to the right.

Sorting starts on the front left corner of the device (A1 location), and proceeds from front to back, and then
from left to right, sorting in a serpentine motion. Thus, for a plate, sorting proceeds from well A1-A12, B12-
B1, C1-C12, and so on.

When sorting onto a slide, sorting proceeds in rows across the short end of the slide, and in columns along
the long end of the slide. Make sure that you set up your sort layout accordingly.
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Setting up the stream
This section describes how to optimize side stream deflection and how to adjust the home location.

When sorting onto a plate or slide, the stage is pre-programmed to move a set distance between wells on a
plate or spots on a slide. The home location is used as the starting point. The far left stream should hit the
center of the well in the top left corner of a plate or the top left corner of a slide at the home location.

Default home location coordinates exist for each standard sort collection device: Falcon® multiwell plates with
6, 24, 48, 96, and 384 wells, and standard or frosted-end slides. For other plate types, you will need to create a
custom device. See Creating a custom device (page 135).

Use the following procedure to verify the home location and adjust it.

1. Turn on the deflection plates.

Click the Voltage button in the Side Stream window. The voltage warning light illuminates, indicating that
the plates are charged.
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Note: Make sure the center stream image does not move after the plates are turned on. Major movement of
the center stream could indicate that the plates or the area around the plates needs cleaning. See External
cleaning (page 144).

2. Select Sort > Home Device.

10.
11.
12.

13.

In the Device Setup dialog, select the collection device you are using and click Go to Home.
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The stage moves to the pre-programmed home position.

Click the Test Sort button and optimize the far left side stream, then click the Test Sort button again to turn
it off.

Ensure that the aspirator drawer is open. Adjust the far left slider for minimal deflection of the stream. The
stream should be deflected just enough to clear the hole in the splash shield. Do not adjust the other sliders.

If you cannot see a stream image or the image is dim, adjust the micrometer dial on the diode laser to
better view the streams.

Double-click the Test Sort button to deposit a drop at the home location.

Note: To ensure consistent drop placement, keep the sort collection door closed when depositing drops on
the vessel.

Inspect the collection device to see where the drop was deposited.

If you need to move the stage to the front, close the Device Setup dialog and click the Access Stage button
in the Sort Layout window.

Wipe the collection device dry and place it back on the tray support.

If needed, click the Access Stage button to send the stage back and select Sort > Home Position to access
the Device Setup dialog again.

Adjust the home location, if necessary.

Click the appropriate arrow buttons to move the tray support as needed. Large arrows move the tray by five
steps. Small arrows move the tray by one step.

Repeat steps 5 through 8 until the drop is centered appropriately.
Click Set Home, then Close.

Click the Voltage button to turn off the deflection plates.
Optimize the drop delay.

See one of the following procedures:

¢ Determining the drop delay — manual method (page 123)

¢ Determining the drop delay — automatic method (page 126)
Proceed with Sorting (page 127).
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Creating a custom device

You can program the ACDU stage to sort into any grid configuration. Create a custom device by entering the
number of rows and columns and setting the home and farthest locations. BD FACSDiva™ software calculates
the increment between rows and columns to determine the sort locations. The home and farthest locations for
a 96-well plate are AT and H12, respectively.

Farthest
¥
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1. Select Sort > Custom Devices.
2. Click the Add button in the Custom Devices dialog.
A new device is added to the list of custom devices. By default, devices are named Custom Device_00x,

where x is the next consecutively numbered device.
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3. Select the text in the Name field and enter a new name.

Enter the number of sort location rows and columns.
A device can have up to 60 rows and 25 columns.
5. Use the arrow buttons and the Test Sort button to set the home location, then click Set Home.

See Setting up the stream (page 133) for details. There are no default values for custom devices, so greater
initial adjustment with the arrow buttons is required.

6. Use the same procedure to set the farthest location, then click Set Farthest.
The farthest sort location is the well or spot on the lower-right corner of the collection device.
7. Click Close.
After you set the home and farthest locations, custom devices are listed in the Device menu in the Sort
Layout window.
Note: Once custom devices are defined, you cannot change the number of rows and columns.
8. Click the Voltage button to turn off the deflection plates.
9. Proceed with Determining the drop delay — manual method (page 123) and Sorting (page 127).
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Deleting a custom device

1. Select Sort > Custom Devices.

2. Select the name of the custom device to be deleted in the Custom Devices dialog.
3. Click Delete.

The device is deleted from the Custom Device list, but is retained within any sort layouts where it was used.

Index sorting

Index sorting allows you to sort single cells onto a plate or slide and indexes the well or slide location to the
collected parameters for that cell. You can use this function to ensure that a sorted cell with a specific
phenotype has been sorted. Index sorting is useful in characterizing subpopulations of phenotypically similar
events using post-sort genetic, chemical, and/or metabolic applications.

Setting up for index sorting

Index sorting uses the same steps as required in setting up for a plate or slide sort. Review the instructions in
these sections:

¢ Setting up for sorting (page 120)

¢ Setting up for sorting onto a plate or slide (page 132)

To perform an index sort:

1. Create a new experiment, using a global worksheet, for the index sort.

Note: If you want to export data from each well into one CSV file, you must use a global worksheet.
Create a new global worksheet.
Create the plots and gates needed to define the populations of interest.

Create a new sort layout or select an existing sort layout defined for index sorting.

v bW N

Make the following selections in the Sort Layout window.

¢ Precision = Single cell (recommended setting)

e Target events =1

¢ Index sorting checkbox = Selected

Make the other selections in the Sort Layout window according to your experiment requirements.
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6. Click the Sort button in the Sort Layout window to start the sort.
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10.
11.

12.
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You must be acquiring sample to start a sort. A new tube is automatically added to the experiment. Upon
completion, the new tube will contain the index sort data.

When the sort is finished, right-click the new tube in the experiment and select Index Sorting Analysis.
The Index Sorting Analysis displays.
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The color legend for the wells is shown in the following table.

Color Indication

Black Sorted well data is showing in the plots

Gray Sorted well data is available, but not showing in the plots
White No sorted events

Red More than one event sorted into a well

Select a well in the Index Sort Analysis to see the event sorted into that well displayed in a plot.
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After selecting an individual well, the other wells in the Index Sort Analysis turn to gray, indicating that they
contain data, but are not being displayed.

You can select multiple wells by Shift+clicking or Ctrl+clicking. You can also drag over multiple wells in the
Index Sort Analysis to display multiple wells.

To increase the size of a dot on a plot for better visibility, open the population hierarchy, select a population,
navigate to the Population Inspector, and select a larger size.

To see the statistics for an index sort, right-click a plot and select Create Statistics View.

To export the statistics for an index sort as a CSV file, right-click in the statistics view and select Export
Index Sort Statistics.

In the dialog that opens, navigate to the location where you want to save the CSV file and click Save.
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Terasaki plate adapter

A Terasaki plate adapter is available as an option to enable the use of 60-well and 72-well Terasaki plates with
the ACDU. A Terasaki plate is installed into the adapter, and then the plate/adapter assembly is loaded onto

the ACDU.
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Terasaki plate adapter showing Terasaki plate in adapter installed
location of set sorews on ACDU

Using the adapter
The adapter has three set screws that enable the fit to be adjusted for the plates.
1. Install a Terasaki plate into the adapter with the A10 or A12 well at the bottom left corner of the adapter.

2. Tighten the set screws so the plate is held firmly and does not move within the adapter, but do not over-
tighten because you need to be able to remove plates easily.

The set screws should not have to be adjusted after the initial fitting process.

Using the correct device in the sort layout

During the sort layout setup process, you have to select the correct device in the Sort Layout window so the
ACDU knows the layout and location of the wells on the Terasaki plate.

1. Inthe Sort Layout window, select the Device menu.

2. Navigate to the bottom of the list, then select the plate you are using (60-well or 72-well).

Device:

3584 Well - Falcon v

296 well - Falcon ~
354 Well - Falcon

Slide - Frosted End
Slide - Standard

Il - Terasaki

|l - Terasaki

The sort layout displays with the correct number of rows and columns.



Shutdown and maintenance

This chapter explains the routine maintenance procedures you should follow to keep your
BD FACSymphony™ S6 cell sorter in good condition.

Shutdown and maintenance procedures are presented as follows:

¢ Daily shutdown (page 140)

¢ Scheduled maintenance (page 144)

¢ Unscheduled maintenance (page 155)
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Daily shutdown

In the BD FACSymphony™ S6 cell sorter system, the recommended daily shutdown procedure is to run the
Clean Flow Cell command with the closed-loop nozzle installed (see the next section). This procedure fills the
flow cell with cleaning solution. This is normally sufficient to keep the flow cell clean and operating properly.

If the system is used to process many different sample types, or the system has problems with contamination,
you can perform a more extensive cleaning by running the Fluidics Shutdown command. See Fluidics Shutdown
(Weekly or As Needed) (page 142).

In addition to one of these procedures, you should also perform an external cleaning. See External cleaning
(page 144).

Cleaning the flow cell (daily)

Use the Clean Flow Cell command to run a tube of 1.5% solution of BD® Detergent Solution Concentrate
through the sample line and flow cell.

Note: After the procedure is complete, the detergent solution remains in the flow cell until the stream is
restarted. The solution should not be left in the flow cell for long periods. For shutdowns that will last more than
a day, perform Fluidics Shutdown as described in Fluidics Shutdown (Weekly or As Needed) (page 142).

To clean the flow cell:

1. Turn off the stream.

2. Mix a 1.5% dilution of BD® Detergent Solution Concentrate (catalog number 660585) as described in the
instructions provided with the detergent.

ﬁ Do not mix BD® Detergent Solution Concentrate with bleach because they produce chlorine gas.

3. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

4. Remove the nozzle and install the integrated closed-loop nozzle.

If you are using a standard closed-loop nozzle, verify that there is an O-ring in the nozzle before installing it.
5. Select Cytometer > Cleaning Modes > Clean Flow Cell.
6. When prompted, install a tube containing the 1.5% BD® Detergent Solution Concentrate, then click OK.

The cytometer loads the tube and fills the flow cell with the detergent solution.
7. Click OK when the completion dialog opens.
8. Turn off the lasers using the laser buttons on the Laser Power Panel.
9. Turn off the cytometer main power.
10. Turn off the Temperature Control Option if it was used.
11. Exit BD FACSDiva™ software and shut down the computer.
12. Turn off the in-house air or the compressor.
13. Vent the air pressure from the sheath tank by pulling up on the vent ring.

14. If the cell sorter is installed in a BSC, leave the BSC blower on and close the view screen by lowering the sash
to the lowest (ready safe mode) position.
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Deep cleaning the flow cell (weekly or as needed)

1.
2.
3. Carefully pull the tubing out of the bubble detector, taking care not to pull it out of the sample pinch valve.

Stop the stream.

Install the integrated closed loop nozzle.

Pinch valve

Bubble detector

-
.-'ﬂ o

4. Select Cytometer > Cleaning Modes > Clean Flow Cell.
5. Mix a 1.5% dilution of BD® Detergent Solution Concentrate (catalog number 660585) as described in the

instructions provided with the detergent.

A Do not mix BD® Detergent Solution Concentrate with bleach because they produce chlorine gas.

When prompted, install a tube with at least 4ml of 1.5% solution of BD® Detergent Solution Concentrate
then click OK.

A Do not mix BD® Detergent Solution Concentrate with bleach because they produce chlorine gas.

The cytometer loads the tube and fills the flow cell with the detergent solution.
When the completion dialog displays, click OK.

. Select Cytometer > Cleaning Modes > Clean Flow Cell.

9. When prompted, install an empty tube, then click OK.

10.

The cytometer loads the tube, which will create bubbles that scrub the inside of the sample path and flow
cell.

Repeat steps 4 to 9 two more times.
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11.

12.
13.

14.

Carefully push the tubing back into the bubble detector. Make sure that the tubing is fully inserted. A cotton
swab may be used to push it in.

Select Cytometer > Cleaning Modes > Clean Flow Cell.

When prompted, install an empty tube, then click OK.

When the tube loads, the bubble detector should trip and LED should flash. If it does not, check tubing to be
sure it is fully inserted and then repeat this procedure from step 12.

If the system will be shut down for more than 1 day, perform Fluidics Shutdown as described in Fluidics
Shutdown (Weekly or As Needed) (page 142).

Fluidics Shutdown (Weekly or As Needed)

The Fluidics Shutdown command can be used to perform an extensive cleaning if the system is used to process
many different sample types, or the system has problems with contamination. This procedure removes sheath
fluid from the lines and fills them with 70% ethanol, and cleans the flow cell.

Preparing for shutdown

1.
2.
3.

Unload the sample tube, if one is loaded.

Turn off the stream.

Check the waste container and empty it if needed.

See Emptying the waste tank (page 97).

Check the ethanol shutdown tank and refill it if needed.
See Refilling the ethanol shutdown tank (page 95).

Running fluidics shutdown

1.

Select Cytometer > Fluidics Shutdown.
The Fluidics Shutdown dialog opens.

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

Remove the nozzle from the flow cell assembly and click Done.
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5.

10.
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Insert the integrated closed-loop nozzle into the flow cell assembly and click Done.

If you are using a standard closed-loop nozzle, verify that there is an O-ring in the nozzle before installing it.

Connect the air and fluid lines to the stainless steel ethanol shutdown tank.
a. Disconnect the air line from the sheath tank and connect it to the air port on the ethanol shutdown tank.

b. Disconnect the fluid line from the bottom side of the sheath filter and connect it to the ethanol filter on
the ethanol shutdown tank.

Remove the sheath filter and replace with the ethanol filter. Do not run ethanol through the sheath filter.
c. Click Done.

The system starts the cleaning process, and then displays a message at the bottom of the dialog.

Top view Side view
To filter
Fluid I Ethanol
uid line ﬁlter

Fluid
connector

Disconnect
here

Ethanol shutdown tank

When prompted, install a tube containing 3 mL of sterile, filtered DI water on the loading port, then click
Done.

| [ N VSIS & Bulri O LR GTeTe] ArChabid Pk P E e il | Dena

The cytometer loads the tube and continues the cleaning process. A progress message is displayed, and then
Done is displayed when the process is complete.

Click OK when you see a message informing you that the system can be turned off.

Turn off the in-house air or the compressor.

Vent the air pressure from the sheath tank by pulling up on the ring on the pressure relief valve.
Turn off the lasers by pressing the lighted buttons on the Laser Power Panel.

Turn off the cytometer main power.

Turn off the Temperature Control Option if it was used.

Exit BD FACSDiva™ software and shut down the computer.
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14. If the cell sorter is installed in a BSC, leave the BSC blower on and close the view screen by lowering the sash
to the lowest (ready safe mode) position.

External cleaning

To keep the system free from salt buildup, wipe down all cytometer surfaces that have been exposed to sheath
fluid. Clean surfaces with a cloth dampened with a 10% bleach solution, followed by DI water.

A@ All cytometer surfaces that come in contact with biological specimens can transmit potentially fatal
disease. Use universal precautions when cleaning cytometer surfaces. Wear suitable protective
clothing, eyewear, and gloves.

A To prevent shock, turn off the plate voltage before cleaning on or around the deflection plates. To
prevent arcing (sparking), make sure the plates are completely dry before you turn the plate voltage
back on.

The following surfaces should be inspected and cleaned when necessary:
* Inside the sort chamber

¢ Deflection plates

¢ Sample loading port

e (Collection devices

Scheduled maintenance

For optimal cytometer functioning, perform the following procedures according to the recommended
maintenance schedule.

Procedure Recommended Frequency

Internal cleaning (page 144) See the table in the following section.

Purging the fluid filters (page 148) Weekly

Purging the sheath filter (page 148) Weekly

Changing the disposable waste cap (see Emptying the waste | Monthly

tank (page 97))

Changing the fluid filters (page 148) Every 6 months

Changing the sheath/ethanol filter (page 149) Every 6 months

Changing the sample lines (page 150) Every 4—-6 months, or as needed

Changing the air filter (page 154) Every 6-12 months, depending on cytometer use and the
quality of the air

Changing the Sheath Tank Air Filter (page 154) Every 6 months

Internal cleaning

BD FACSDiva™ software includes four pre-programmed cleaning modes that can be used alone or in
combination to provide the required level of cleaning. The following sections describe the different cleaning
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modes.
Cleaning Mode Summary Frequency
Sample line Flushes the sample line with sheath fluid. After running samples with adherent cells or
backflush (page dye.
145)
Cleaning the flow Cleans the sample path and the flow cell with DI When indicated by distorted scatter or high
cell (daily) (page water. CVs, or as a daily shutdown procedure.
140)
Prime after tank Primes the fluid lines for the designated fluid(s). When a fluidics line is unplugged to refill a
refill (page 145) tank.
Prepare for aseptic Decontaminates the complete sheath path and When needed before aseptic sorting.
sort (page 146) sample path with bleach, DI water, and ethanol.

Sample line backflush

After a sample tube is unloaded, the sample line tubing within the sample injection chamber is automatically
flushed inside and out with sheath fluid to eliminate potential sample carryover. Use the Sample Line Backflush
command to perform additional backflushing of the inside of the sample line after a tube is unloaded. Perform
the sample line backflush when you observe sample carryover or after running samples with adherent cells or
dye.

Note: Keep the stream running while performing the backflush.

1. Select Cytometer > Cleaning Modes > Sample Line Backflush.

2. Click Start to start the backflush.

3. Click Stop to stop the backflush, or click Cancel to stop the backflush and close the dialog.

The backflush does not stop automatically.

Prime after tank refill

Use the Prime After Tank Refill command to prime the fluid lines if a 5-L plastic fluidics container was
disconnected for refilling.

1. Turn off the stream.

2. Select Cytometer > Cleaning Modes > Prime After Tank Refill.

3. Select the checkboxes for the tanks that were refilled, then click OK.

The cytometer proceeds with priming the specified tanks. A progress dialog opens while the tanks are being
primed.

4. Click OK when the tank prime is complete.

Removing the sheath probe

The sheath probe must be removed from the sheath tank before autoclaving the tank in preparation for
performing the aseptic sort procedure.

Note: Do not autoclave the sheath probe. It is not designed to withstand the conditions of autoclaving.

Make sure to perform the following steps in sequence, so the containment device works properly.
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1. Disconnect the air line from the sheath tank.

2. Vent the air pressure from the sheath tank by pulling up on the pressure relief valve. Verify that all of the
pressure is released by pulling up a second time.

3. Loosen the nut at the top of the probe with a wrench.

Thumbscrew

Containment
device

4. Loosen the thumbscrew on the containment device.
5. Pull the top section of the containment device straight up and out of the bottom section.
Top section of

containment
device

6. Finish loosening the 11/16-inch nut at the top of the probe and pull the probe straight up and out of the
sheath tank.

7. Decontaminate the sheath probe using 70% ethanol.

Prepare for aseptic sort

Use the Prepare for Aseptic Sort command when you want to decontaminate the entire sheath path. This
procedure cleans the system with bleach, DI water, and ethanol.
Perform the following steps before starting the Prepare for Aseptic Sort command:

1. Verify that the pressure has been vented from the sheath tank and the sheath probe has been removed. See
the preceding section.

2. Disconnect the fluid and air lines from the sheath tank.
3. Empty the sheath tank and rinse it with DI water.

4. Autoclave the sheath tank at 125 °C and 15 psig for 30 minutes with a 7.5-minute warmup and shutdown
cycle.

5. Fill the sterilized sheath tank with sterile sheath fluid.

6. Obtain a new sheath filter to replace the old filter when instructed to do so in the wizard. See Changing the
sheath/ethanol filter (page 149).

7. Install the decontaminated sheath probe into the sheath tank and tighten the nut securely with a wrench.
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Install the top section of the containment device into the bottom section, and then tighten the thumbscrew.
Sterilize the DI water sensor by soaking in a 10% bleach solution for 10 minutes.

Fill the DI water container with sterile DI water and 3 mL of bleach per liter of DI water, and then reinstall
the sterilized DI water sensor.

To run the Prepare for Aseptic Sort command:

1.

Select Cytometer > Cleaning Modes > Prepare for Aseptic Sort.
Follow the instructions on screen as you perform the procedure.

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

Install the integrated closed-loop nozzle in the flow cell and click Done.
If you are using a standard closed-loop nozzle, verify that there is an O-ring in the nozzle before installing it.

Remove the fluid line from the DI water port, connect the fluid line from the bleach/BD FACSClean™
container to the DI water port, then click Done.

Do not disconnect the sensors from either container.
Bleach/BD FACSClean™ tank DI water tank

—=——— Fluid line from DI water port

Fluid line from bleach/
BB BD FACSClean™ tank

Disconnect the bleach/BD FACSClean™ fluid line from the DI water port, and connect it back to the bleach

container port, then reconnect the DI fluid line to the DI water port, and click Done.

Disconnect the sheath fluid line from the sheath filter (at the output side) and connect it to the fluid out
port on the connectors panel on the side of the fluidics drawer. Click Done.

The system cleaning takes approximately 20 minutes.

Fluld (B)  Srearmn
O-06
|

Disconnect the fluid line from the fluid out port on the side of the fluidics drawer and connect it to a new
0.2-um sheath filter. See Changing the sheath/ethanol filter (page 149).

Fluid out port

Remove the old sheath filter and connect the new 0.2-um sheath filter to the liquid port of the sterilized
sheath tank.

Reconnect the fluid and air lines to the sheath tank.

To complete the process, select one of the two options.
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¢ To continue running samples, perform fluidics startup.

¢ To turn off the system, perform the flow cell cleaning procedure.

Purging the fluid filters

Once a week, purge air from the fluid filters for the 5-L plastic containers by opening the bleeder valve on the

top of each filter. This ensures that the filters will not dry out.

1. Open the bleeder valve a small amount and leave it open until fluid seeps out through the valve.
Note: If the fluid does not seep, close the valve, prime the fluid lines, and try again. It might take a few
minutes for the air to purge.

2. Close the valve.

3. Wipe up any excess fluid that might have dripped into the fluidics drawer.

Purging the sheath filter

Once a week, purge air from the sheath filter by opening the bleeder valve on the top of the filter. The sheath
tank is pressurized, so do this task carefully to avoid spraying sheath fluid on any equipment.

1. Place a small container under the bleeder valve to catch any fluid.

2. Slowly open the bleeder valve a small amount and leave it open until fluid seeps out through the valve.

3. Close the valve.

4. Wipe up any excess fluid that might have dripped into the fluidics drawer.

Changing the fluid filters

We recommend changing the fluid filters every six months. Spare filters are included with the accessory kit.

Remove the filter by pressing the tabs on each quick-disconnect coupling.

Install the new filter with the flow arrow point down and connect the quick-disconnect couplings.

Write the current date on the new filter so you will know when to replace it.

S wN =

Open the bleeder valve on top of the filter a small amount and leave it open until fluid seeps out through
the valve.

5. Close the valve.
6. Wipe up any excess fluid that might have dripped into the fluidics drawer.
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Changing the sheath/ethanol filter

Introduction

The sheath/ethanol filter can be used to filter either sheath fluid or ethanol fluid. You need to change the filter
depending on the procedure you are doing and the indications in the software.

About this task

Note: Before it is installed, a fluid filter can be used as a sheath filter, or an ethanol filter. After the filter is
installed for one of these purposes, however, you cannot use it for a different purpose. Because of this, you
should label each filter so that you know which one to use for each purpose.

When you use the filter as a sheath filter, you should change it every six months, or when increased debris in an
FSC vs SSC plot indicates that the sheath filter needs to be replaced.

Spare filters are included with the accessory kit.

Procedure

To change the sheath/ethanol filter:
1. Turn off the stream.
2. Disconnect the air line from the sheath tank.

3. Pull up on the ring of the pressure relief valve to release the pressure from the tank. Verify that all of the
pressure is released by pulling up a second time.

4. Disconnect the filter by the pressing the metal tabs on each end.

MOJ4 JO UOI3IIQ

To instrument }7 @

Item Description

1 Tabs

5. Write the current date on the filter so that you will know when to replace it.

6. Use the arrows on the filters that indicate the direction of the flow through the filter; replace the filter with a
new one in the same orientation.

7. Reconnect the air line and check for leaks when the pressure is turned on.
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Changing the sample lines

The primary sample line between the sample injection chamber and the pinch valve should be changed every
4-6 months or when decreased event rates indicate that the sample line might be clogged. The secondary
sample line between the pinch valve and the cuvette flow cell needs changing only when it is kinked or clogged.

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser control
software to put the lasers in standby and then close the laser control software. This will turn off the laser diode,
but will keep the diode temperature constant.

Secondary
sample line

Primary
sample line

Connecting nut

Flow cell

assembly o
Sample injection
chamber

To withstand the high pressures generated by the BD FACSymphony™ S6 cell sorter flow cytometer, the sample
lines are attached using a two-piece compression fitting, in which a cone-shaped ferrule is compressed onto the
tubing as the connecting nut is tightened.

To replace the tubing, you will need a 12-inch length of replacement tubing for the primary sample line, or a 7-
inch length for the secondary line. Replacement tubing is supplied in the accessory kit. The ferrules and
connecting nuts can be reused when the tubing is replaced.

‘@ All biological specimens and materials coming into contact with them can transmit potentially fatal
disease. Handle used tubing and fittings as if capable of transmitting infection. Wear suitable

protective clothing, eyewear, and gloves.

Changing the primary sample line

To replace the primary sample line, you will need a 12-inch length of replacement tubing from the accessory kit.
There is a different fitting at each end of the tubing, so the procedure is divided into two sections.

Assembling the collet fitting at the pinch valve
At the pinch valve end of the primary sample line, a collet fitting joins the sample line to the pinch valve tubing.

To replace the tubing:

1. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

Turn the stream off (if needed). Make sure the loading port is in the unload position.
Unscrew the nut from the collet fitting and pull the nut and collet apart.

Pull the pinch valve tubing out of the nut, and then pull the sample line out of the pinch valve tubing.

LA N

Locate a new 12-inch piece of sample line tubing.
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a. Slide the collet over the pinch valve tubing, then slide the nut over the new sample line tubing.
Collet Nut

Pinch valve
tubing Sample line

tubing

2 o | Y

b. Slide the pinch valve tubing over one end of the sample line tubing until approximately 6 mm of the
sample line is inside the pinch valve tubing.

c. Slide the pinch valve tubing on the inside of the teeth of the nut until it stops.

é Ensure that the pinch valve tubing is inserted inside the teeth of the nut. Failure to do so can
cause the bubble detector to malfunction.

d. Couple both pieces of the fitting together and then tighten until finger-tight.

Primary sample line - sample injection end

At the sample injection end of the primary sample line, a compression fitting secures the sample line at the top
of the sample injection chamber.

/ Primary sample

line

- Nut

___— Ferrule

Sample injection
chamber

1. Turn the stream off (if needed). Make sure the loading port is in the unload position.

2. If there is a sample line filter installed, remove it by pulling it off the sample line.
To gain access to the filter, see Installing or removing a sample line filter (page 159).
Unscrew the connecting nut at the top of the sample injection chamber and slowly pull out the sample line.
Ensure that a cone-shaped ferrule is attached to the sample line.

If the ferrule was left behind in the injection chamber fitting, gently push the tip of the ferrule-removal tool
(included in a small vial inside the accessory kit) into the top of the ferrule and pull the ferrule straight out.

After using the tool, you might need to replace the ferrule. If the ferrule is damaged, replace it with a spare
(included in the accessory kit).
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. Slide the ferrule and nut off the end of the sample line.
6. Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 5 inches (12.7 cm) of tubing extending out of the sample injection chamber end. (This
length can be adjusted depending on the depth of your sample tube.) This length is referred to as the pilot.

External view Internal view

Ferrule Ferrule

E_l--_...,q

I_._,J S
Tubing Pilot Iength Tubing Pilot length Pilot depth
Insert the pilot tubing into its fitting, ensuring that the tubing reaches the intended pilot depth.
é Do not to bend the primary sample line during insertion.

Insert the sample line into the sample injection chamber fitting. Push the tubing from the top until it is
slightly above the bottom of the chamber viewing window. Finger-tighten the nut on top of the chamber so
the sample line is secure.

é Do not overtighten the nut and do not use tools. Over-tightening the nut can kink or damage the
tubing.

. Check the fitting connections at both ends to make sure they are not leaking.

Turn on the stream, load a tube of DI water, and make sure none of the fittings are leaking. If needed,
unload the tube, turn off the stream, and tighten the fittings. After tightening, if leaking still occurs, replace
the ferrule.

2 Make sure all fittings are securely tightened. If any fitting is loose, the tubing could detach during high-
pressure operation, exposing the operator to potentially biohazardous sample spray.

. Verify the length of the sample line.

The sample line should not bow or bend when a tube is loaded. If you need to adjust the length, unscrew the
nut on top of the sample injection chamber, adjust the length, and tighten the nut again.

See Installing or removing a sample line filter (page 159) for detailed instructions on verifying sample line
length. Disregard any steps that do not apply.

Changing the secondary sample line

This section describes changing the secondary sample line. There is a different fitting at each end of the tubing,
so the procedure is divided into two sections.

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser control
software to put the lasers in standby and then close the laser control software. This will turn off the laser diode,
but will keep the diode temperature constant.
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Pinch valve end

The procedure to replace the secondary sample line at the pinch valve end is the same as for the primary
sample line, except the replacement line is a 7-inch length. See Assembling the collet fitting at the pinch valve
(page 150).

Flow cell end
1. Turn the stream off.
2. Unscrew the connecting nut at the top of the flow cell and slowly pull out the sample line.

~_—Secondary sample line

_—— Nut

~—— Ferrule

Flow cell

!

3. Ensure that a cone-shaped ferrule is attached to the sample line.

If the ferrule was left behind in the flow cell fitting, gently push the tip of the ferrule-removal tool (included
in the accessory kit) into the top of the ferrule and pull the ferrule straight out.

After using the tool, you might need to replace the ferrule. If the ferrule is damaged, replace it with a spare
(included in the accessory kit).

4. Slide the ferrule and nut off the end of the sample line.
5. Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 0.1 inch (0.25 cm) of tubing extending out of the ferrule. This length is referred to as
the pilot.

6. Insert the pilot tubing into its fitting at the top of the flow cell, ensuring that the tubing reaches the
intended pilot depth.
Within the cuvette flow cell fitting, make sure the pilot is seated flush against the pilot depth.

Dead volume between the pilot and the pilot depth can lead to sample carryover or leaking.
7. Finger-tighten the nut at the top of the flow cell to secure the sample line.
é Do not overtighten the nut and do not use tools. Over-tightening the nut can kink or damage the
tubing.

8. Check the fitting connections at both ends to make sure they are not leaking.
Turn on the stream, load a tube of DI water, and make sure none of the fittings are leaking. If needed,
unload the tube, turn off the stream, and tighten the fittings. After tightening, if leaking still occurs, replace
the ferrule.
A@ Make sure all fittings are securely tightened. If any fitting is loose, the tubing could detach during
high-pressure operation, exposing the operator to potentially biohazardous sample spray.
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Changing the air filter

The BD FACSymphony™ S6 cell sorter has an air filter in the sort collection chamber door.

wwwwmn Sort collection chamber door

Air filter

To change the filter in the sort collection chamber door, slide out the old filter and slide in the new one. To slide
out the old filter, release the locking screw behind the door. See Replacing the air filter (page 199) for more
information.

Changing the Sheath Tank Air Filter

Check the inline air filter on the sheath tank air line periodically for any signs of debris or discoloration. Replace
with a new air filter from the accessory kit every six months, or sooner if needed.

Sheath tank inline air filter

1. Turn off the cytometer.
2. Pull the tubing off each end of the air filter.

3. Install a new filter with the directional arrow pointing toward the sheath tank.
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There are several cytometer components that should be cleaned periodically or checked for wear and replaced
if necessary. See the indicated sections for the following maintenance procedures.

Procedure

Recommended Frequency

Changing the integrated nozzle (page 155)

As needed for different sized particles

Cleaning the integrated nozzle (page 156)

When stream irregularities indicate that the nozzle is clogged

Temporary replacement of a seal (page 158)

As needed when seal is lost or damaged in an integrated
nozzle

Closed-Loop Nozzle Maintenance (page 158)

As needed

Installing or removing a sample line filter (page 159)

When the sample line filter needs to be installed or changed

Changing the pinch valve tubing (page 161)

As needed

Cleaning the camera windows (page 163)

When smudges appear in the Breakoff or Side Stream
windows

Removing the deflection plates (page 165)

As needed to clean the deflection plates

Lubricating the sample injection chamber O-ring (page
166)

As needed when the O-ring is dry

Using custom optical filters (page 167)

As needed

Cleaning the optical filters (page 168)

As needed when changing a filter

Removing or installing the FSC ND filter (page 168)

As needed

Changing the integrated nozzle

Three sizes of nozzles are provided with your cytometer: 70, 85, and 100 pm. A 130-pum nozzle can be ordered
as an option. The size is marked on the nozzle. The closed-loop nozzle used for cleaning and shutdown

procedures is also changed with this procedure.

eyewear, and gloves.

Any cytometer surface that comes in contact with biological specimens can transmit potentially fatal
disease. Use universal precautions when handling sorting hardware. Wear suitable protective clothing,

1. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

2. Turn off the stream and open the flow cell access door.
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3. Turn the nozzle-locking lever counterclockwise to the 9:00 position, and pull the nozzle out of the cuvette
flow cell.

Nozzle-locking
lever in 12:00 position

4. Insert the new nozzle into the flow cell (with the top side facing up) and push it gently all the way forward
until it stops.

5. Turn the nozzle-locking lever clockwise to the 12:00 position.

6. Turn on the stream and make sure it flows smoothly from the nozzle into the center of the waste aspirator.

If the stream is flowing but the breakoff is too long or the gap is unsteady, this could indicate that there are
bubbles in the flow cell. If these conditions occur, turn off the stream, wait for 10 seconds, and turn on the
stream again.

If you see any dripping or spraying, or the stream image appears abnormal, turn off the stream and see
Troubleshooting the stream (page 170).

Note: After changing the nozzle, you might need to adjust the angle of the sort block to re-center the stream in
the aspirator. To do so, loosen the adjustment screws on both sides of the deflection plates and rotate the sort
block. Tighten the screws when the stream is centered in the aspirator. For further assistance, see
Troubleshooting the stream (page 170).

Cleaning the integrated nozzle

Use the following procedure to clean the nozzle when the stream appears blocked or distorted. To verify that
the nozzle is clogged, examine the opening at the center of the seal area under a microscope.

Seal in
integrated nozzle

A@ All biological specimens and materials coming into contact with them can transmit potentially fatal
disease. Handle nozzles as if capable of transmitting infection. Wear suitable protective clothing,
eyewear, and gloves.
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To clean the integrated nozzle:

1. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

2. Remove the nozzle from the flow cell by turning the nozzle-locking lever counterclockwise to the 6:00
position, then pull the nozzle straight out.

3. Sonicate the nozzle for approximately 1 minute in a test tube containing DI water. Repeat the sonication
until the nozzle is clean.

A Do not use bleach, Contrad®, or any strong detergents to clean the nozzle.

4, Allow the nozzle to air dry for a few minutes. Do not wipe the nozzle with anything, because it could leave
fibers or other contamination.

5. Insert the nozzle into the flow cell with top side facing up and push it gently forward until it stops.
6. Turn the nozzle-locking lever clockwise to the 12:00 position.
7. Turn on the stream and make sure it flows through the nozzle properly.

Flow cell

Nozzle

Nozzle-locking
lever

Note: After re-installing the nozzle, you might need to change the angle of the sort block to re-center the
stream in the aspirator. To do so, loosen the adjustment screws on both sides of the deflection plates and
rotate the sort block. Tighten the screws when the stream is centered in the aspirator. For further assistance, see
Troubleshooting the stream (page 170).
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Handling the integrated nozzle

In addition to following proper cleaning instructions, follow these precautions when handling the integrated
nozzles.

Precaution Result

Always use the integrated closed-loop nozzle for cleaning and shutdown | Keeps the flow cell clean and reduces the
procedures. chances for clogs. A clean flow cell provides

improved sensitivity and higher performance.

Do not expose integrated nozzles for long periods of time to bleach or Prevents the seal from coming loose and
detergents. However, you can prepare for the aseptic sort procedure falling out.
without causing any problems to the O-ring in the integrated nozzle.

Do not expose integrated nozzles to strong base solutions such as Prevents the seal from coming loose and
Contrad 70. falling out. Any contact with such solutions

might damage the seal.

Do not wipe the surface of the seal with anything. Prevents damage to the seal that could result

in leaking.

Temporary replacement of a seal

The standard O-ring can be used as a short-term replacement in the integrated nozzle, if the original seal has
been lost or damaged, but a new integrated nozzle will provide better long-term usability. See Accessory kit
(page 184) for part numbers for ordering integrated nozzles.

Standard O-rings (part number 333084) are supplied in the accessory kit. The following procedure describes
how to install a standard O-ring in an integrated nozzle.

1.

Make sure the groove in the nozzle is clean.

If the any part of the seal is still in the nozzle groove, sonicate the nozzle in a bleach solution until the seal
comes out. Rinse the nozzle in DI water after sonicating.

Use the wooden end of a cotton swab, or similar tool, to install the O-ring in the nozzle groove, then allow
the nozzle to air dry for a few minutes.

Do not wipe the nozzle with anything, because it could leave fibers or other contamination, or dislodge the
O-ring.

Use the magnifier in the accessory kit, or a microscope, to inspect the nozzle to verify that the O-ring is
installed all the way into in the groove.

Closed-Loop Nozzle Maintenance

The closed-loop nozzle and related tubing should be cleaned if there are any indications of clogging or kinked
tubing.

Cleaning the integrated closed-loop nozzle

1.

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

Turn off the stream and open the flow cell access door.
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3. Remove the closed-loop nozzle from the cuvette flow cell.

Turn the nozzle-locking lever counterclockwise to the 6:00 position. Remove the nozzle by pulling it straight
out.

4. Unscrew the nut on the side of the nozzle to remove the tubing.
Make sure that the ferrule stays on the tubing as you remove it.
5. Sonicate the nozzle for approximately 1 minute.

Sonicate the nozzle in a test tube containing DI water or a mild detergent. Repeat the sonication as needed
until the nozzle is clean.

6. Make sure that the ferrule is on the tubing, then screw the nut back into the hole in the side of the closed-
loop nozzle.

Replacing the tubing on the closed-loop nozzle

To replace the tubing on the closed-loop nozzle, use this procedure. Use a 7-inch length of sample tubing from
the accessory kit as the replacement.

Ferrule Nut Tubing (7-inch length)

/

m;@

Closed-loop
nozzle

Union fitting

To replace the tubing:

1. Unscrew the nut from the closed-loop nozzle and from the union fitting and pull out the tubing from both
places.

Make sure that the ferrule comes out on the tubing on both ends. If not, use the ferrule tool to remove it.
2. Slide the nut and ferrule off each end of the tubing.
3. Slide the nut and ferrule onto the new tubing.

Insert the tubing into the closed-loop nozzle and slowly tighten the nut until secure. Do not over-tighten.
Make sure that the tubing is pushed all the way in while tightening the nut.

4, Insert the tubing into the union fitting and slowly tighten the nut until secure. Do not over-tighten. Pull
gently on the tubing to ensure that it is secure.
Installing or removing a sample line filter

Sample filters can be installed on the end of the sample line to filter out large particles from a sample. Pre-
filtering the sample before beginning any sorting is recommended.
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Two sizes of sample line filters are included in the accessories kit: 35 micron (green) and 50 micron (blue). The
filters can be changed as often as required. The sample filters are not intended for use with the 1-mL
microtubes.

Note: When a sample filter is installed, the sample flow rate can be slowed down due to the effect of particles
in the sample fluid clogging the filter.

1. With the stream turned on, select Change Sample Filter from the Cytometer menu.

2. A wizard opens with the instructions.

Logsen T sample na filing on j2p of T bulk injecSon chamber
i Y Lower e sampbs fine.

<% MEtalamove T Sumphe Thar
False I sampln lina

dsr 2 Place a ube ondo o losding por
; Caurtan: Bulk injecion chamber will dlasn

@
@

L

3. Loosen the sample line fitting nut at the top of the injection chamber to allow the sample line to slide freely
through the fitting.

Sample line
/

Nut

Sample injection

n chamber

4. Push the sample line down so the end is below the bottom of the sample injection chamber.
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Sample line
filter

Install the sample line filter by sliding it onto the end of the line, then click Done.
Do not bend the sample line while installing the filter.

Pull the sample line up to operation height, slightly above the chamber viewing window.

7. Place a tube onto the loading port.

11.

& Movement of mechanical parts within the instrument can pinch or injure your hands or fingers.
Keep your hands and clothing away from the loading port when a tube is loading or unloading. Do
not place objects underneath the loading port.

Click Done to raise the sample injection chamber.

ﬁ% Be careful of a pinching hazard as the sample injection chamber is raised.

The sample line should not bow or bend when a tube is loaded.
Adjust the sample line height if needed.
Tighten the sample line fitting and click Done.

The bulk injection chamber is lowered and the sample purge mode is turned on for about 5 seconds until
several drips exit the filter. A message is displayed at the bottom of the wizard.

Click Done to complete the process.

Changing the pinch valve tubing

The tubing that runs through the bubble detector and the pinch valve should be changed as needed. The
system ships with replacement tubing cut into 3-inch lengths, found in the accessory kit.
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Bubble detector

To replace the tubing:
1.

As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

2. Turn off the stream. Make sure the loading port is in the unload position.

Pull the existing pinch valve tubing out of the slot in the pinch valve and the bubble detector.

Grasp the tubing with two fingers next to the pinch valve and two fingers next to the bubble detector. Pull
the tubing straight out from the slots. The tubing pops out with a small amount of pulling action.

Pinch valve collet fittings

Sample line tubing

Pinch valve tubing

Unscrew the nut on the black collet fitting at each end of the tubing, and pull the pinch valve tubing out of
both fittings.

Leave both pieces of the fitting on the sample line tubing.
Install a new 3-inch piece of pinch valve tubing.
a. Slip the collet over one end of the new pinch valve tubing.

b. Slide the pinch valve tubing over the sample line tubing until approximately 6 mm of the sample line is
inside the pinch valve tubing.

Slide the pinch valve tubing on the inside of the teeth of the nut until it stops.
d. Couple both pieces of the fitting together and then tighten until finger-tight.
e. Repeat steps a through d at the other end of the tubing.
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f. Check to see that both ends of the new pinch valve tubing are held securely in the compression fittings.
Collet Nut

Pinch valve )
tubing Sample line

tubing

00 o | )

6. Install the new pinch valve tubing into the slots in the pinch valve and bubble detector.

Make sure that the tubing goes all the way into the back of each slot. The sample line can drip if the pinch
valve tubing is not all the way into the slot in the pinch valve and the bubble detector.

Cleaning the camera windows

Lower camera window

Clean the lower camera window and the diode laser window when you have trouble viewing the side streams or
you cannot set the drop delay using Accudrop.

A A 12,000-volt potential exists between the deflection plates when they are on. Contact with the
charged plates results in serious electrical shock. Do not touch the deflection plates when the plate
voltage is on. The plates remain energized even when the sort block door is open.
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To clean the lower camera window and the diode laser window:

1. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

Ensure that the deflection plates are turned off (warning light is not illuminated).
Turn off the stream.

Open the sort block door.

v W

Wipe the windows with a soft, lint-free cloth soaked with DI water, and then dry the windows.

Lower camera window

Upper camera window

Clean the strobe lens and upper camera window when smudges appear in the processed (digitized) image in
the Breakoff window, or when dark spots appear to interfere with Sweet Spot monitoring. You might need to
clean these components after a clog, or after sheath fluid has leaked or sprayed. Follow the steps in this section
to clean the strobe lens and upper camera window.

A A 12,000-volt potential exists between the deflection plates when they are on. Contact with the
charged plates results in serious electrical shock. Do not touch the deflection plates when the plate

voltage is on. The plates remain energized even when the sort block door is open.
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To clean the strobe lens and upper camera window:

1. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

Ensure that the deflection plates are turned off (warning light is not illuminated).
Turn off the stream.

Open the sort block door.

Place 1-2 drops of DI water or ethanol on a cotton swab.

o v bk WwN

Click the Breakoff window and select Raw Image.
Visible smudges are more apparent in the raw image view.
7. While viewing the image in the Breakoff window, insert the swab just below the bottom of the flow cell.

The strobe lens and upper camera windows are located behind two circular openings on either side of the
top of the sort chamber. You will see the end of the swab in the Breakoff window when you intercept either
opening.

Strobe lens
window

Upper
camera
window

8. Gently wipe the upper camera window, and then the strobe lens (opposite the window) to remove any
saline.

9. Repeat with isopropyl alcohol or 70% ethanol until clean.

Removing the deflection plates

You can remove the deflection plates for cleaning by pulling the plates out using the deflection plate removal
tool, supplied in the accessory kit.
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1. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

2. Make sure that the deflection plates are turned off.

3. Open the sort block door.

4. Slide the deflection plate removal tool behind one of the plates and pull straight out from the sort block.
Hold your thumb on the plate (or use your other hand) as you pull it out so it does not fall as you remove it.

2.5-inch deflection plates 3.5-inch deflection plates

Lubricating the sample injection chamber O-ring

The O-ring at the bottom of the sample injection chamber should be lubricated as needed to maintain proper
operation.
1. Verify that the loading port is in the down position, and open the hinged cover.
2. Check the O-ring (located at the opening in the bottom of the chamber) to see if it is dry.
3. If the O-ring is dry, it must be lubricated with O-ring lubricant from the accessory kit.
a. Remove the clear plastic tube holder from the tube holder base.

b. Apply a small amount of O-ring lubricant to the outside beveled edge of the tube holder base. This is
where the base contacts the O-ring inside the sample injection chamber.

¢. Wipe off any excess lubricant.
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d. Replace the tube holder on the base.

Outside beveled edge
of tube holder base

Using custom optical filters

If you want to install a custom filter or dichroic, the filter should comply with the following specifications.

Filter Characteristic Dichroic LP Filters BP Filters Glass Filters
Diameter 0.492 in. 0.492 in. 0.492 in.
(12.5 mm) (12.5 mm) (12.5 mm)
Thickness 0.16 +0.005 in. 0.079 in. 0.098 in.
(0.408 + 0.127 mm) (2.00 mm) (2.5 mm)
Minimum clear aperture 0.562 in. 0.85in. (21.6 mm)
(14.3 mm)
Incident angle 11 £71° 0°

For the longpass filters, the surface that faces the center of the HPC should be coated directly on its surface, not
between two or more pieces of glass. The coating should transmit >70% of the wavelength range you want the
filter to transmit, with a minimum transmission of >50%, and it should reflect >90% of the wavelength range
you want the filter to reflect.

The opposite surface (facing away from the center) should be coated with an anti-reflective coating with a
minimum reflection of £1% of the wavelength range you want the filter to reflect.

Note: Filters must be installed in front of each PMT to block unwanted laser light. For the dichroic, carefully
assemble the glass filter in the holder using the retaining spring. Assemble the filter as per the supplier’s
specification. The angle of the dichroic is critical to achieving optimal results.

Note: Whenever you modify the filter set on your cytometer, you will need to create a new cytometer
configuration to identify which PMT (identified by laser color and letter) will detect the emitted light. See
Custom configurations (page 61) for instructions.
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Cleaning the optical filters

Optical filters should be inspected occasionally and cleaned as necessary. The frequency will depend on how
often the filters are handled.

When cleaning or replacing a filter, handle with care to avoid scratching the surface and to prevent
the filter from falling out of the holder. Use cotton swabs, optical lens paper, and spectral-grade

methanol or absolute ethanol in a dropper bottle (do not use acetone) to clean the optical filters.

1. Wrap a triangular section of the lens paper around the cotton end of a cotton swab. Moisten and seal the
end with a few drops of alcohol.

Holding the cotton swab in a horizontal position, gently rub any spots on the filter surface and wipe clean.
3. Allow the solvent to evaporate and check the filter surface for streaks.

Inspect a Y-inch—diameter section in the center of the filter for scratches.

Filters are coated with different dielectrics that can get scratched. If you see scratches, replace the filter.
5. Insert the cleaned filter into the HPC array.

Make sure the filters are pushed all the way in.

Removing or installing the FSC ND filter

For applications involving large particles in which events appear off scale on the FSC axis with a voltage of zero,

keep the FSC ND filter in place to decrease the FSC signal and keep the events on scale. For applications

involving small particles (for example, bacteria or platelets), you might need to remove the FSC ND filter as

follows.

1. As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the
laser diode, but will keep the diode temperature constant.

2. Open the flow cell access door.
Locate and pull out the FSC ND filter.

The filter is installed at the left end of the FSC detector block, just to the right of the flow cell. To remove the
filter, loosen the set screw and pull the filter out of the slot.

Nozzle holder

FSC ND filter

Set screw

4. Toreinstall the filter, slide it into the slot with the filter side down and the label facing the flow cell.

Note: You can remove the nozzle holder to get better access to the ND filter slot.



Troubleshooting

The tips in this chapter are designed to help you troubleshoot your experiments. Additional troubleshooting
information can be found in the BD FACSDiva™ Software Reference Manual.

Note: As a precautionary measure, prior to opening the Flow Cell access door, use the Stop button in the laser
control software to put the lasers in standby and then close the laser control software. This will turn off the laser
diode, but will keep the diode temperature constant.

If additional assistance is required, contact your local BD Biosciences technical support representative. See
Technical assistance (page 9).

Troubleshooting suggestions in this chapter are grouped under the following headings:

e Troubleshooting the stream (page 170)

e Troubleshooting the breakoff (page 173)

 Sorting troubleshooting (page 174)

¢ Acquisition troubleshooting (page 177)

* Fluidics troubleshooting (page 181)

¢ Electronics troubleshooting (page 182)
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Troubleshooting the stream

Observation

Possible Causes

Recommended Solutions

Stream not in
center
of aspirator

Difference in keyed stream position between
nozzles

If you have just changed the nozzle, use an Allen
wrench to loosen the screws on either side of the
sort block. Adjust the angle of the sort block until
the stream flows into the center of the waste
aspirator, and then tighten the screws.

Nozzle inserted improperly

Turn off the stream. Remove the nozzle and ensure
that the seal or O-ring is in place. Re-insert the
nozzle and slide the nozzle in until it stops, then
close the locking lever.

Clogged or damaged nozzle

Turn off the stream, remove the nozzle, and
examine the nozzle tip under a microscope.

 If debris is visible, clean the nozzle. See Cleaning
the integrated nozzle (page 156).

o If the nozzle appears damaged, replace it. See
Changing the integrated nozzle (page 155).

Plate arcing Arcing error comes from the droplet board (not Dry the plates and sort block. Reset the instrument
with no events | from the fluidics board). Board will turn everything | and software.
thereafter off to prevent destroying plates and for circuit
protection. If no notification is sent to the board,
the software will not reset the board.
Performance Incorrect filters Confirm that the filters used during the
check failed performance check match the filters used to define

the baseline.

No stream or

dripping
stream

Nozzle inserted improperly

Turn off the stream. Remove the nozzle. See
Changing the integrated nozzle (page 155) for
instructions.

Clogged or damaged nozzle

Turn off the stream, remove the nozzle, and
examine the nozzle tip under a microscope.

o If debris is visible, clean the nozzle. See Cleaning
the integrated nozzle (page 156).

« If the nozzle appears damaged, replace it. See
Changing the integrated nozzle (page 155).

Stream control
disabled or no
stream when
stream control
clicked

Air lock in fluidics filter

Prime the system with the corresponding fluid.

If the control is still disabled, remove the filter,
install the bypass tubing, and repeat the priming
procedure until you see fluid in the line.

When fluid is running through the line, remove the
bypass tubing, install the filter, and repeat the
priming procedure one last time.

Communication failure between workstation and
cytometer

Exit the software and restart it.
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Observation

Possible Causes

Recommended Solutions

No stream when
Stream control
clicked

Sheath tank low or
empty

Refill the sheath tank. See Refilling the sheath tank (page 94).

NOTE When the empty tank warning message is not closed after
15 minutes, the stream shuts off automatically.

Air in sheath line

Prime the sheath tank. See Prime after tank refill (page 145).

Air in sheath filter

Purge the sheath filter. See Purging the sheath filter (page 148).

Dry filter

Open the bleeder valve to purge the filter. See Purging the fluid filters
(page 148).

Fanning around
center stream

Nozzle inserted
improperly

Re-insert the nozzle. Push it gently all the way forward without rocking it
from side to side.

House air or compressor
is off (gauge reads zero)

Turn on house air or compressor.

Sheath tank lid not
properly seated (gauge
reads <80 psi)

Remove sheath tank lid, reseal properly.

Unstable stream

Debris in flow cell or
nozzle

Remove the nozzle and run the stream with no nozzle in place for
approximately 10 seconds. (Click the Stream control on, then off.) Sonicate
the nozzle and re-install it.

Fluid line connected to
ethanol shutdown tank

Move fluid and air lines to the sheath tank, then perform a fluidics startup.
See Performing fluidics startup (page 90).

Stream stops
shortly after
starting stream

Interlock cable is
disconnected

Check cable.

Call BD Service.

Stream stops
when loading
tube

Sample Injection
Chamber obstructed

Sample Injection
Chamber misaligned

Check tube loading area is clear.
Check chamber base O-ring is properly seated.

Call BD Service.

Stream stops
after tube
unloads

Sample Injection
Chamber obstructed

Sample Injection
Chamber misaligned

Check that nothing is below the Sample Injection Chamber base.
Ensure Sample Injection Chamber skin is positioned all the way back.

Call BD Service.

Stream stops Emergency Off switch Reset switch.
randomly pressed .
Call BD Service.
Leaking or Defective or damaged Replace the defective seal with a standard O-ring. See Temporary

spraying around
nozzle

integrated nozzle seal

replacement of a seal (page 158).

Nozzle inserted
improperly

Turn off the stream. Remove the nozzle. See Changing the integrated
nozzle (page 155) for instructions.

Extra O-ring is blocking
the nozzle

Remove the nozzle and use a cotton swab to clear out the cuvette.

Drop breakoff is
too long

Bubbles in flow cell

Open the flow cell access door and check for bubbles in the flow cell. If
they are visible, turn off the stream, wait a few seconds, and turn on the
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Observation

Possible Causes

Recommended Solutions

stream again.

Attenuation is on

Turn off attenuation.

Amplitude is too low

Increase the amplitude until you can see drops. If you need a very high
amplitude (>70 volts) to see drops, there might be air bubbles in the flow
cell.

Nozzle inserted
improperly

Turn off the stream. Remove the nozzle and ensure that the seal or O-ring
is in place. Re-insert the nozzle and slide the nozzle in until it stops, then
close the locking lever.

Problems using
Auto Delay
feature

Stream is not stable

Make sure that the stream is stable before starting to run auto delay.

Diode laser does not
fully intercept the
sorting streams

Adjust the diode laser to intercept streams in the middle, producing the
biggest and brightest spots in the left and center images.

Event rate is too low or
too high

Adjust the flow rate to increase or decrease the event rate.




Troubleshooting the breakoff

Chapter 8 Troubleshooting

Use the following examples to help troubleshoot problems with the breakoff image.

Normal stream image

Abnormal Stream Images
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Possible Nozzle Nozzle Partial clog Wet or dirty strobe | Attenuation is
Causes inserted inserted lens on at wrong
improperly improperly or pressure
orifice is off
center
Recommended Remove the Remove the Remove the Clean the lens as Turn off
Solutions nozzle and nozzle and nozzle, clean described in attenuation in
re-insert it. re-insert it. it, and then Cleaning the the Side
re-insert it. camera windows Stream
(page 163). window.
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Sorting troubleshooting

Observation

Possible Causes

Recommended Solutions

Unstable breakoff while
Sweet Spot is engaged

Residual ethanol in
system

Allow the system to run until the breakoff stabilizes.

Target Drop 1 value
is out of range for
drop spacing

Use an actual Drop 1 value for the target. Remember to repeat the
drop delay setup each time the target value is changed.

Nozzle is clogged or
inserted improperly

See Responding to a nozzle clog during a sort with the AMO (page
195).

Dirty strobe lens or
upper camera
window

Clean the lens and the window as described in Cleaning the camera
windows (page 163).

Air in sheath filter

Purge the sheath filter. See Purging the sheath filter (page 148).

Debris in flow cell or
nozzle

Remove the nozzle and run the stream with no nozzle in place for
approximately 10 seconds. (Click the Stream control on, and then off.)
Sonicate the nozzle and re-install it.

Center stream image is
dim or not visible in the
Side Stream window

Camera window is
dirty

Clean the lower camera window. See Cleaning the camera windows
(page 163).

Stream is not
intercepting the
diode laser

Adjust the micrometer dial on the laser to make the stream intercept
as bright as possible.

Center stream is off center
when the plate voltage is
turned on

Voltage center too
low or too high

Adjust the Voltage Center slider to put the center stream back to
center.

Saline spray on
deflection plates or
in sort block

Clean the deflection plates and the area around them.

Arcing between deflection
plates

Salt bridge

Clean and dry the deflection plates and the area around and behind
the plates.
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Observation

Possible Causes

Recommended Solutions

ACDU sorting failure

Insufficient stream
voltage

Increase the voltage for the far left stream.

Splash shield not
installed

Install the splash shield. See Installing the sorting hardware
(page 132).

Side stream position reversal, where
the streams appear to be
associated with the wrong voltage
slider.

Voltage sliders are
set too far in or too
far out.

Move sliders in or out so they control the correct side
streams.

No deflection or insufficient
deflection

Insufficient voltage

» Increase the side-stream voltages using the slider
controls.

o Increase the plate voltage.

Stream-charging
wire is loose or
missing

Verify that the stream-charging wire is inserted all the way
into the barb.

Salt bridge

Turn off the stream. Remove the nozzle. See Changing the
integrated nozzle (page 155) for instructions.

Sorting paused
because actual Drop
1 value is out of
range

Wait until the Sweet Spot adjusts the amplitude to achieve
the Drop 1 target.

If this happens repeatedly during sorting, there might be
debris in the nozzle or flow cell. See Troubleshooting the
stream (page 170) for suggestions.

Fanning around center or side
streams

Nozzle inserted
improperly

Turn off the stream. Remove the nozzle and ensure that the
seal or O-ring is in place. Re-insert the nozzle and slide the
nozzle in until it stops, then close the locking lever.

Incorrect Gap

Turn off the Sweet Spot and adjust the Gap amplitude to a
value that is midway between the outer limit tolerances.
Turn on the Sweet Spot after the adjustment.

Sweet Spot is off

Turn on the Sweet Spot.

Incorrect sort
precision mode

Verify that the sort precision mode is appropriate for your
sorting requirements. See Sort Precision Modes (page 52).

2nd, 3rd, or 4th Drop
values not optimized

Adjust the 2nd, 3rd, and 4th Drop settings to tighten the
center stream and fine-tune the side streams.

Particles too big for
nozzle

Change the nozzle. See Changing the integrated nozzle
(page 155).

Sort button disabled

Current tube pointer
not set to current
tube

Click to move the current tube pointer to the appropriate
tube.

Population not listed in Add menu
on sort layout

Population defined
using snap-to gate

Redefine the population using another gate type.

Viewing sort layout
for another tube

Open or create a sort layout for the current acquisition tube.
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Observation

Possible Causes

Recommended Solutions

Sort layout counters not updating

Viewing sort layout
for another tube

Open or create a sort layout for the current acquisition tube.

High sort conflict rate

Event rate is too
high for drop drive
frequency

Decrease the event rate.

Gating conflict

Verify the gating hierarchy.

Purity mask is too
high

Decrease the purity mask.

Erratic sort rate

Flow rate is too high

Decrease the flow rate.

Unexpected sort results

Incorrect drop delay

Reset the drop delay. See Determining the drop delay —
automatic method (page 126).

Incorrect sort
precision mode

Verify that the sort precision mode is appropriate for your
sorting requirements. See Sort Precision Modes (page 52).

Sweet Spot is off

Keep the Sweet Spot on during sorting.

Drop 1 changed
after setting drop
delay

Reset the drop delay each time you change the Drop 1
value. See Determining the drop delay — automatic method
(page 126).

Laser delay changed
after setting drop
delay

Reset the drop delay each time you change the laser delay.
See Determining the drop delay — automatic method (page
126).

Incorrect logic in
population hierarchy

Verify the gating strategy.

Sorting parent and
child populations
into two different
tubes

If you try to sort a parent and its child population into two
tubes, BD FACSDiva™ software ignores the child events in
both tubes.

Create a new subset under the parent population consisting
of NOT (child). Sort the child population into one tube and
the NOT (child) population into another tube.
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Observation

Possible Causes

Recommended Solutions

No events in plots after
clicking Load or Acquire
Data

Current tube pointer is not set
to current tube

Click to move the current tube pointer to the appropriate
tube.

Laser shutter is engaged

Make sure the flow cell access door is completely closed.

Laser power is off

Turn on the laser power.

Laser delay set incorrectly

Adjust the laser-delay settings. See Manual adjustment
of laser delay (page 116).

Viewing plots for a different
tube

Double-click the current tube in the Browser to display the
plots for that tube.

Incorrect population(s) in plot

Right-click the plot and select Show Populations. Verify
that the appropriate populations are displayed.

Uncolored events in plot

o Format the plot to display all events.
« Assign a color to the population displayed in the plot.

o Verify the population drawing order.

Current cytometer
configuration different from
optical setup

Verify that the cytometer optics match the current
cytometer configuration.

No sample in the tube

Add sample to the tube or install a new sample tube.

Sample is not mixed properly

Increase the sample agitation rate. See Sample agitation
(page 57).

Sample line is clogged

Perform a sample line backflush. See Sample line
backflush (page 145). If necessary, change the sample
line.
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Observation

Possible Causes

Recommended Solutions

No events in plots after
clicking Acquire Data
(continued)

Sample filter is
clogged

Replace the sample filter.

Threshold not set to
the correct parameter
(usually FSC)

Set the threshold to the correct parameter for your application.

Multiple threshold
parameters not set
correctly

Verify that the correct Boolean logic (And/Or) was used for the
threshold parameters.

Threshold channel too
low or too high

Adjust the threshold channel. See Calculating compensation
(page 110).

Optical filter(s) not
completely seated

Make sure that the filters are pushed all the way in.

FSC area scaling is
incorrect

Ensure that the FSC-A matches the FSC-H value.

No fluorescence signal

Current cytometer
configuration different
from optical setup

Verify that the cytometer optics match the current cytometer
configuration.

Wrong filter installed
or filter not completely
seated

Make sure that the appropriate filter is installed for each
fluorochrome. Make sure that the filters are pushed all the way
in.

Laser delay is set
incorrectly

Adjust the laser-delay settings. See Manual adjustment of laser
delay (page 116).

Low area signal

Area scaling is too low

Adjust area scaling for the corresponding laser. See Adjusting
area scaling (page 104).

Unexpected events in plot

Incorrect logic in
population hierarchy

Verify the gating strategy.

Incorrect population
(s) in plot

Right-click the plot and select Show Populations. Verify that the
appropriate populations are displayed.

Incorrect drawing
order

Verify that the required population is not hidden by another
population. Right-click the plot and select Order Populations by
Count.

Erratic event rate

Sample aggregates

Filter the sample.

Bulk injection O-ring is
worn

Contact your BD Biosciences service engineer.

Sample is
contaminated

Re-stain the sample, making sure the tube is clean.

Sheath tank low

Fill the sheath container.

Unexpectedly high event rate

Threshold channel is
too low

Adjust the threshold channel. See Calculating compensation
(page 110).

Sample is too

Dilute the sample.
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Observation

Possible Causes

Recommended Solutions

concentrated

Flow rate is too high

Decrease the flow rate in the Acquisition Dashboard.

Bubbles in flow cell

Turn off the stream, wait a few seconds, and turn on the stream
again.

Unexpectedly low event rate

Sample not
adequately mixed

Increase the sample agitation rate. See Sample agitation (page
57).

Threshold channel is
too high

Adjust the threshold channel. See Calculating compensation
(page 110).

Sample is too dilute

Concentrate the sample.

Unexpectedly low event rate
(continued)

Sample line is clogged
or kinked

Backflush the sample line. See Sample line backflush (page 145).
If necessary, change the sample line.

Look for visible kinks in the line. If kinks are found, change the
sample line. See Changing the sample lines (page 150).

Sample line installed
incorrectly

Verify the sample line installation. See Changing the sample
lines (page 150).

Sample aggregates

Filter the sample.

Memory is full

Compare the processed event rate in BD FACSDiva™ software
with the threshold counter. If the event rate is much lower, exit
and then restart the application.

Distorted populations or high
CVs

Cytometer settings
adjusted incorrectly

Optimize the scatter parameters. See Calculating compensation
(page 110).

Flow rate is too high

Decrease the flow rate in the Acquisition Dashboard.

Window extension is
too low

Increase the window extension.

Bubbles in flow cell

Turn off the stream, wait a few seconds, and turn on the stream
again.

Nozzle is clogged or
dirty

Clean the nozzle as described in Changing the integrated nozzle
(page 155).

Flow cell is dirty

Clean the flow cell. See Cleaning the flow cell (daily) (page 140).
Let DI water sit for 15 minutes before turning on the stream.
Repeat as needed.

Poor sample
preparation

Repeat sample preparation.

Area scaling is too low

Verify area scaling. See Adjusting area scaling (page 104).

Excessive amount of debris in
plots

Threshold channel is
too low

Increase the threshold channel. See Calculating compensation
(page 110).

Dead cells or debris in
sample

Examine the sample under a microscope.
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Observation

Possible Causes

Recommended Solutions

Sample is
contaminated

Re-stain the sample, making sure the tube is clean.

High electronic abort rate
(>10% of system event rate)

Window extension is
too high

Decrease the window extension.

Threshold channel is
too low

Increase the threshold channel.

Event rate is too high

Decrease the flow rate in the Acquisition Dashboard.

Sample is aggregated

Filter the sample.

Sample is too
concentrated

Dilute the sample.

Fewer events than expected
in gated population

Window extension set
incorrectly

Adjust the window extension, if needed. See the BD FACSDiva™
Software Reference Manual for information.

Laser delay set
incorrectly

Adjust the laser-delay settings. See Manual adjustment of laser
delay (page 116).

Plot is zoomed

Unzoom the plot or make the gate bigger.

Events left out of the
gate

When drawing a gate, make sure that events on the axis are
included.

Increasing threshold results
in decreased area signal

Window extension is
too low

Slightly increase the window extension to maximize the area
signal.

Increasing the window extension too much results in more
electronic aborts or high CVs.

Area measurement off scale
while the height
measurement is on scale

Area scaling is too
high

Decrease area scaling to move the area measurement back on
scale. If necessary, adjust area scaling to make the area
measurement match the height measurement.

Cannot delete from
Parameters, Threshold,
Compensation, or Ratio tab
views

Row not selected

Select the row using the selection button.

Data already recorded

Create a new tube.

Cannot connect to CS&T

External air supply is
<80 PSI

Check the air pressure gauge on the air supply panel or sheath
tank. The air pressure should be 80-100 PSI.

 If the air pressure is within range, contact your
BD Biosciences service engineer.

o If the air pressure is <80 PSI, close the release valve and
reseal the lid.

Negative Q values

Higher power lasers
than in previous cell
sorters

1. Rerun the CST baseline.

2. When the software pauses at the Optimized PMT Results
window, set median channel values that are <200 to 200.

3. Click OK to finish the run.
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Observation

Possible Causes

Recommended Solutions

No fluid in line during
system prime

Air lock in sheath or fluidics
filter

Remove the filter for the corresponding fluid, install the
bypass tubing, and run Prime After Tank Refill. Repeat the
priming procedure until you see fluid in the line.

When fluid is running through the line, remove the bypass
tubing, install the filter, and repeat the priming procedure
one last time.

Prepare for aseptic sort fails

Air lock in filter

Remove the filter for the corresponding fluid, install the
bypass tubing, and run Prime After Tank Refill. Repeat the
priming procedure until you see fluid in the line.

When fluid is running through the line, remove the bypass
tubing, install the filter, and repeat the priming procedure
one last time.

Fluid line is detached

Verify the fluid line connections on the fluidics drawer and
on the cytometer. Push firmly on each line to ensure that it is
connected.

Fluidics air flow <80 PSI

Air leak

Contact your BD Biosciences service engineer.

Fluidics air flow >100 PSI

Regulator not adjusted
properly

Contact your BD Biosciences service engineer.

Fluid leak under fluidics
drawer or below side door

Condensation from
pressure relief valve

This is a normal phenomenon that occurs when water is
condensed from room air. Condensation is greater in humid
environments. To avoid slipping, wipe up any water daily.

Bleeder valve is open

Check and close all bleeder valves for fluid and sheath filters.

Broken fluid line

Contact BD Biosciences.

Sample injection chamber
does not close and causes a
BISH or BISO error message

O-ring at bottom of sample
injection chamber is dry
and causing chamber to
stick

Lubricate the O-ring and tube holder. See Lubricating the
sample injection chamber O-ring (page 166).
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Electronics troubleshooting

Observation

Possible Causes

Recommended Solutions

“Cytometer
Disconnected” in
Cytometer window

Cytometer power is off

Turn on the cytometer main power.

Communication failure
between workstation and
cytometer

o Exit the software and then restart it.

» If restarting does not work, reset the cytometer electronics: switch
off the main power, wait 10 seconds until the system is fully
depressurized, and then switch the power back on.

o Restart the computer and the cytometer.

Ethernet cable between
workstation and
cytometer is
disconnected

Unplug and then plug in the cable connectors and make sure they are
secure.

IP address changed

Enter the correct IP address. Call BD Biosciences for assistance.

Lasers are not

Main laser power button

Switch the main laser power button on.

responding” in
Status tab

powered on is not switched on.

USB data loss. Unplug and replug the USB cable at the side of the sorter.
“Master DAQ Event rate is too high Decrease the event rate or verify the threshold.
Overflow” in
Cytometer window | Dirty flow cell Clean the flow cell. See Cleaning the flow cell (daily) (page 140).
“Cytometer not Unknown Perform the suggestions for a communication failure, above.




Supplies and consumables

This chapter provides a list of supplies and options that are available for the BD FACSymphony™ S6 cell sorter.

e To order spare parts and consumables from BD Biosciences from within the US, call 877.232.8995 or go to
bdbiosciences.com.

Outside the US, contact your local BD Biosciences representative.
» To order cytometer options, contact your sales representative.
This information is correct at the time of publication. For up-to-date information, see our website
(bdbiosciences.com).
e Cytometer supplies (page 184)
¢ Consumables (page 188)


http://www.bdbiosciences.com/
http://www.bdbiosciences.com/home/
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Cytometer supplies

Accessory kit

The cytometer is shipped with an accessory kit containing the following items. Use these part numbers if you

need to order any replacements.

Tank-related parts

Item Part Number
Waste sensor probe (6-level) 334915
Auxiliary 5-L container 333504
Baffle for 10-L waste tank (2 pack) 338505
Cap for 5-L container (3) 335916
Sheath tank assembly 641915
Ethanol tank assembly 641916
Auxiliary sensor probe (ethanol) 642874
O-ring, tank, ethyl and sheath 642877
Wet cart liquid filter 644320
Disposable waste tank caps (pack of 12) 338854
Waste tank with label 643909
Ethanol tank with label 643910
DI water tank with label 643911
BD FACSClean™ tank with label 643912
Sheath sensor probe 644109
Pressure gauge, 0-100 PSI 646024
Pipe fitting, 0.25 in. 645400
Vacuum lid utility knob 648233
Ball knob, 1 in. diameter 642833
Aucxiliary sensor probe (non-ethanol) 343835




Optical Filters

Chapter 9 Supplies and consumables

Item Part Number
FSC 0.5 neutral density filter assembly 337104
FSC 1.0 neutral density filter assembly 337108
FSC 1.5 neutral density filter assembly 338651
FSC 2.0 neutral density filter assembly 338652
Filter (Chroma) HQ710/50 640471
Mirror (Omega) 675/20 19-62774-15
Filter holders (3) 336102
Filter clip (5) 640563

Sort collection devices

Item Part Number
15-mL centrifuge tube holder 333430

12 x 75-mm test tube holder 333456
Six-way 5-mL amber tube holder 500050957
Six-way 5-mL tube holder top 500050958
Six-way 1.5-mL tube holder 665647
1-mL microtube holder 333457
Four-way 12 x 75-mm collection tube holder 641454
Two-way 12 x 75-mm collection tube holder 500032421
Two-way 15-mL collection tube holder 641612
Four-way 1-mL collection tube holder 641614
Splash guard 641615
Temp control 15-mL tube holder 647168
Temp control 12 x 75-mm tube holder 647206
Temp control Eppendorf tube holder 647207
Four-way 1.5-mL Eppendorf collection tube holder 644349
Terasaki plate adaptor 652905
Adapter tray for microscope slides 335630
Six-way 5-mL temp control tube holder 665346
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Maintenance-replacable items

Item Part Number
Sample injection tubing (12-in. lengths) 641059
Sample injection tubing (7-in. lengths) 641475
Standard nozzle O-rings 333084
Ferrule 335108
Capsule filter 0.2 micron 336945
O-ring for collection-tube holder, 1.75 in. internal diameter, 1.87 in. external diameter (9) 337897
0-rings 0.176 in. internal diameter, 0.318 in. external diameter (10) 340086
Drop charge cable assembly 343358
Barbed Fitting, 1/4-28 in. x 1/16 in. internal diameter tubing (3) 343508
Lubricant for O-rings 347306
Peek nut fitting 348578
0-rings 0.859 in. internal diameter (3) 641860
Pinch valve tubing 641900
Reducing union fitting 1/16 in. — 1/32 in. 643571
Rotary shaft seal 644054
Universal top section for collection tube holders (2) 651439
Coupling insert valved 1/4 in. 641543
Tube compression fitting 3/8 in. through 641920
Coupling body valved 1/4 in. 641542
Window BI sort head 657582
Fitting street tee 1/4M x 1/4F x 1/4hex 657798
Collet 19-66455-00
Collet nut large diameter 663282
Connector female luer to 10/32 in. 59-10102-00
Collet nut 19-66456-00
Sort block deflection plate, left 2.5 in. 642579
Sort block plate deflection plate, right 2.5 in. 640042
Sort block deflection plate, left 3.5 in. 5000061176
Sort block deflection plate, right 3.5 in. 5000061177




Cables
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Item

Part Number

Power cords:

e Main power cord e 333694
o Cordset for continental Europe e 334140
e Cordset for UK e 334141
o Cordset for Australia/Asia e 334175
R1 CAT-5 cable 334965
Coaxial cable BNC-M to BNC-F 2 ft. 342824
Cable, extension, DBOFEM-DB 8 ft. 332907
Nozzles
Item Part Number
Closed loop nozzle assembly 644395
Integrated nozzles:
e 70 micron (2) e 647339
e 85 micron (2) e 647340
e 100 micron o 647341
Nozzle holster 642884
Nozzle locking lever (spring and plunger included) 7001349

Tools
Item Part Number
Plastic O-ring pick tool 331430
Ferrule-removal tool 335690
Magnifying glass 337599
Tool alignment 1.5-mL side stream 658214
Deflection plate removal tool 643197
Hex wrench set 98-10004-00

Other replacement parts

The following items may not be included in the accessory kit, but you can use the indicated part numbers to

order spare or replacement parts.
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Item Part No.
Autoclavable 10-L container 340261
Warning labels 335600
Consumables
Cytometer setup particles
Particle Supplier Catalog No.
BD Calibrite™ Beads BD Biosciences
o Two-color kit e 349502
(unlabeled, FITC, PE)
e Three-color kit o 340486
(unlabeled, FITC, PE, PerCP)
e PerCP beads e 340497
e PerCP-Cy5.5 beads e 345036
¢ APC beads o 340487
Fluoresbrite® Yellow-Green 2-pm beads (for the 405-nm laser) Polysciences Inc. 18604
(800) 523-2575
Spherotech Rainbow Calibration Particles, 3.0-3.4 pm BD Biosciences e 559123
(8 peaks)
e« 556286
e 556291
(brightest peak in
556286)
BD FACS™ Accudrop Beads BD Biosciences 345249
BD FACSDiva™ CS&T Research Beads BD Biosciences 641319
(1 vial)
642412
(3 vials)
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Reagents
Reagent Supplier Catalog
No.
BD FACSFlow™ sheath BD Biosciences 342003
fluid
BD® Detergent Solution BD Biosciences 660585
Concentrate
Detergent liquid cond BD Biosciences 99-
30109-00
BD FACSClean™ solution BD Biosciences 340345
Ethanol Various -
Chlorine bleach (5% Clorox® or other major supplier (to ensure that the bleach is at the correct -
sodium hypochlorite) concentration and free of particulate matter)
Monoclonal antibodies BD Biosciences® -
Dyes and fluorochromes Life Technologies -
(800) 438-2209
Sigma
(800) 325-3010
BD FACS™ Lysing Solution | BD Biosciences 349202

9See the BD Biosciences Immunocytometry Products Catalog or the BD Biosciences website, bdbiosciences.com.
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Labware

Item Supplier Catalog No.

1-mL microtubes Bio-Rad Laboratories 223-9391 (1,000 per box)
(800) 424-6723

1.5-mL Eppendorf tubes Various -

5-mL polystyrene test tubes, 12 x 75-mm BD Biosciences

e Uncapped, 125 per bag e 343675

o Capped, 125 per bag o 352054

o Capped, 25 per bag * 352058

o With cell-strainer cap, e 352235

25 per bag

15-mL conical centrifuge tubes BD Biosciences

» Polypropylene, 50/bag e 352196

» Polypropylene, 125/bag e 352096

« Polypropylene, 50/rack e 352097

o Polystyrene, 125/bag * 352095

» Polystyrene, 50/rack e 352099

AMS/AMO consumables

Item Part Number
Air filter for ACDU cabinet (set of 3) 334821
ULPA filter and tubing replacement kit (set of 3) 334822
Pre-filter 333595
Hydrophobic filter for sort block door, 0.2 micron, 25 mm 651177

BD FACSymphony™ S6 Cell Sorter consumables

Item Part Number
Swab, micro head 3.2 x 1.5 x 10, 70-mm LG (100/pkg) 643290
Cotton-tipped applicators (100/pkg) 99-30122-00
Air filter, inline, 0.3 micron (2) 641913
Sample inline filters (35 micron) Qty 50 649048
Sample inline filters (50 micron) Qty 50 649049
Hydrophobic filter for sort block door, 0.2 micron, 25 mm 651177
Sheath fluid filter (also used for ethanol shutdown tank filter) 661744
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BD® Aerosol Management Option

The BD® Aerosol Management Option (AMO) is a device that uses an attached vacuum source to rapidly
evacuate aerosolized particles through an ultra-low penetrating air (ULPA) filter during routine sorting or
analysis.

The following topics are described in this chapter:

Option components (page 192)

Operating the BD® Aerosol Management Option (page 193)
Maintenance (page 196)

Upgrades for the AMO (page 200)

Troubleshooting the AMO (page 201)

Specifications (page 203)
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Option components

The BD® Aerosol Management Option (AMO) includes the following:

An evacuator to generate negative pressure

An ULPA filter to trap particles, with attached tubing that connects the evacuator to the instrument
An air filter for the sort collection chamber door

A hydrophobic filter on the sort block door

A hinged cover on the sample injection chamber

A@ The BD® Aerosol Management Option does not eliminate the health risks of working with
biohazardous material and must be used in conjunction with good laboratory practice.

The BD® Aerosol Management Option is for research use only. It is not for use in diagnostic or therapeutic
procedures.

Evacuator

The evacuator holds the ULPA filter and attached tubing. Air flow is controlled using pushbuttons within a
membrane panel on the front of the unit. The evacuator sits on caster wheels for easy maneuverability. It can
be moved using the handle attached to the unit.

Handle

Filter hold-down

ULPA filter

Flow gauge

Membrane panel

Tubing

ULPA filter

The ULPA filter used in the BD AMO captures and retains 99.9995% of all particles down to and including
particles 0.12 microns in size, according to the manufacturer’s specifications.
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Operating the BD® Aerosol Management Option

Starting up the evacuator

Before starting up the evacuator, make sure that:
¢ The ULPA filter is completely seated against the bottom of the evacuator filter well
¢ One end of the tubing is securely attached to the 1 1/4-inch (left) port on the ULPA filter

Note: Ensure that the 7/8-inch (right) port is closed.

¢ The other end of the tubing is attached to the manifold located in the connection panel on the back of the
cytometer

A@ Any instrument surface that comes in contact with biological specimens can transmit potentially
fatal disease. Use universal precautions when handling instrument hardware. Wear suitable

protective clothing, eyewear, and gloves.

To start up the evacuator:

1. Install the splash shield or the tube holder below the aspirator drawer.
The splash shield is required for sorting into a multiwell plate or onto a slide.
To install the splash shield:
a. Remove the tube holder, if one is installed.

b. Insert the splash shield into the slotted fittings below the sort aspirator drawer. Push the splash shield all
the way in.

Splash shield

2. Ensure that an air filter is installed in the sort collection chamber door.

The filter traps airborne dust that could clog the ULPA filter. The filter should be changed on a monthly
basis. See Replacing the air filter (page 199).
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wwwwwmn Sort collection chamber door

Air filter

3. Close the sort collection chamber door.

Note: The sort collection chamber door must be closed for the evacuator to generate negative pressure in
the chamber.

4, Switch on the main power on the back of the evacuator.

Main power

5. Press the power button on the membrane panel of the evacuator.
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6. Press the up or down arrow button to set the suction control rate to 20%.

Each time either arrow button is pressed, the suction will increase or decrease by 10%. When two lights are
lit on the suction control indicator, the actual air flow is the value between the two illuminated percentages.

A Do not set the suction control rate above 20%. Higher rates could affect the stability of the side
streams.

7. Verify that the filter flow gauge reads less than 2.4 inches of H20.

For a new filter, the gauge should read 1.1-1.4 inches of H20. As the filter is used, the reading will increase.
If the gauge reads 2.4 inches of H20 or greater, replace the filter. See Replacing the ULPA filter (page 197).
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Setting up for sorting

To set up for sorting:

1. Start up the flow cytometer system. See Cytometer startup (page 88).

2. Start up the evacuator as described in Starting up the evacuator (page 193).

3. Follow the standard sort setup procedure. See Setting up for sorting (page 120).

Always start up the evacuator before setting up for sorting. If you start up the evacuator after sort setup is
complete, you will need to repeat the setup procedure.

Responding to a nozzle clog during a sort with the AMO

If the stream is disturbed during the sort (due in part to a clogged nozzle), the sort is designed to stop
automatically and block the sort tubes (if Sweet Spot is on). The sort will not restart until the operator has
cleared the clog. In the event of a nozzle clog, do not open the sort collection chamber door or access the sort
tubes before following this procedure.

Cell sorters that use droplet generation methods, such as the BD FACSymphony™ S6 cell sorter, can
produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal
precautions at all times. Keep the sort block door and the sort collection chamber door closed during
sorting. Follow these steps to stop sample flow and evacuate potential aerosols before opening the

sort collection chamber door.

To clear a clogged nozzle on a system with the AMO:

1. If the stream has not already shut down automatically, turn off the stream by clicking the Stream button
(with a checkmark) at the top of the Breakoff window.

This will shut off the stream, unload the sample, and close the aspirator drawer.
Increase the air evacuation rate on the AMO unit to 100%.
Open the aspirator drawer using software controls.
4. Wait at least 60 seconds.
This procedure will clear aerosols from the sort chamber.
5. Close the aspirator drawer.
6. Turn on the stream and view the breakoff.
If the clog is removed, the breakoff will be similar to the breakoff before the clog.

7. If the clog is not cleared, turn the stream on and off several times to see if the clog will clear itself.
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If the clog is not removed, turn the stream off and perform the Clean Flow Cell procedure with DI water (see
Cleaning the flow cell (daily) (page 140)), followed by turning the stream on to see if the clog has cleared.

Open the aspirator drawer and evacuate for at least 60 seconds before closing the aspirator drawer again.
You can now open the sort collection chamber and remove the sort collection device.

If it is necessary to change nozzles or remove a clog from a nozzle, see Cleaning the integrated nozzle (page
156).

With stream turned off, open the sort block door and dry the plates and surfaces as needed.

When removing collection tubes, be aware that the outside of the tube is potentially contaminated. Use
alcohol swabs or bleach to wipe the outsides of tubes.

Set the AMO unit back to 20% vacuum.

Make sure that all chamber doors are closed and restart the stream.
Perform these tasks if needed:

¢ Turn on the Sweet Spot

¢ Check the drop delay

¢ Check the side stream deflection

Turning off the evacuator

Turn off the evacuator after you have finished running biohazardous samples.

1. Place the system in standby by pressing the power button on the membrane panel of the evacuator.
2. Switch off the main power on the back of the evacuator.
Maintenance

Use the following guidelines to ensure optimal performance of the BD® Aerosol Management Option.

Change the ULPA filter and attached tubing when the flow gauge indicator is >2.4 at a 20% flow setting or
when the red filter-life indicator LED is blinking. See Replacing the ULPA filter (page 197).

Two spare filters and replacement tubing are included with the AMO. To order additional replacement kits,
contact your local BD Biosciences representative.

All biological specimens and materials coming into contact with them can transmit potentially
fatal disease. Handle the ULPA filter and attached tubing as if capable of transmitting infection.
Dispose of waste using proper precautions and in accordance with local regulations. Wear suitable
protective clothing, eyewear, and gloves.

Change the air filter in the sort collection chamber door on a monthly basis. The filter traps airborne dust
that could clog the ULPA filter. Regular replacement of the air filter will extend the life of your ULPA filter.
See Replacing the air filter (page 199).

Do not touch the Filter Life Reset button during normal operation. Doing so could shut down the evacuator
and prevent the collection of aerosols.

Do not disconnect the tubing from the instrument manifold outlet or the ULPA filter unless you are changing
the filter. Repeated removal and reattachment of the tubing could loosen the connection and disrupt airflow.

To ensure optimal airflow, keep the tubing free of kinks and away from sharp or heavy objects. Do not crush
or puncture the tubing. Ensure that the tubing is securely attached at both ends before turning on the
evacuator power.
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¢ Keep the sort collection chamber free of potentially obstructive debris, such as Kimwipes® or disposable
pipets.
¢ Replace the hydrophobic filter on the sort block door every six months.

Replacing the ULPA filter

Replace the filter when either of the following conditions occur:

¢ The filter-flow gauge reads 2.4 inches of H20 or greater at 20% suction.

¢ The red filter-life indicator LED is blinking.

Note: When only the red LED light is illuminated (but is not blinking), you have approximately 1 hour of filter
life remaining. If the red light comes on during sorting, the filter will not stop working. Replace the filter as soon
as possible when the red light starts blinking.

To replace the ULPA filter:

1. Turn off the evacuator main power and disconnect the electrical plug.

A To prevent potential shock, always turn off the evacuator main power and disconnect the

electrical plug from the power source before installing or removing any filter.

2. Disconnect the tubing from the manifold.
The manifold is located in the connection panel on the back of the cytometer.
3. Remove the spring-loaded filter hold-down.

While pushing down on the filter, pull up on the spring-loaded handle, and guide the handle over the top of
the filter and behind the metal plate in the back of the evacuator.

Note: The photos in this section show the discontinued ULPA filter. The new ULPA filter has two ports (1 1/4-
inch and 7/8-inch).

4, Lift off the ULPA filter and attached tubing from the evacuator and dispose of both the filter and the tubing.

A@ All biological specimens and materials coming into contact with them can transmit potentially
fatal disease. Handle the ULPA filter, attached tubing, and all instrument hardware as if capable
of transmitting infection. Dispose of waste using proper precautions and in accordance with local

regulations. Wear suitable protective clothing, eyewear, and gloves.

5. Insert the new ULPA filter into the evacuator filter well.
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6. Push down on the filter to ensure that it is seated against the bottom of the filter chamber.

|

Note: For optimal evacuation of aerosols, the filter must be completely seated in the evacuator filter well.
7. Lift the spring-loaded filter hold-down and place it on top of the filter.

8. Press and hold the Filter Life Reset button on the membrane panel for 5-10 seconds.

Reset button

All of the green, amber, and red LED lights will turn off, and then on. Hold down the button until the 100%
indicator light is lit. This resets the 180-hour filter-life clock.

Note: As the life of the filter is exhausted, the indicator lights will go out, starting from 100%. When only the
red LED light is illuminated (but is not blinking), you have approximately 1 hour of filter life remaining.

9. Connect one end of the replacement tubing to the 1 1/4-inch (left) port on the ULPA filter, and the other
end to the tubing manifold on the back of the cytometer.

Ensure that the cover on the 7/8-inch (right) port is closed.



Chapter 10 BD® Aerosol Management Option | 199

-

Note: For optimal evacuation of aerosols, ensure that the tubing is securely connected at both ends.

10. Connect the evacuator power plug to the power source.

Replacing the air filter

To extend the life of your ULPA filter, we recommend that you replace the air filter on a monthly basis. The filter
traps airborne dust that could clog the ULPA filter. Regular replacement of the air filter will extend the life of
your ULPA filter.

The air filter is located inside the sort collection chamber door.

wwwmmn Sort collection chamber door

Air filter

To replace the air filter:
1. Slide open the sort collection chamber door.

The air filter is held in place by a cover.
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Opened sort collection chamber door

Screw

Cover

Sort collection chamber

i

2. Unscrew the screw at the top of the cover.
3. Pull off the cover and slide out the air filter.

Grasp the filter and then carefully slide it out of the door. While it is still inside the BSC, bag the air filter to
avoid exposure to biohazardous agents.

A@ All biological specimens and materials coming into contact with them can transmit potentially
fatal disease. Handle the air filter and all instrument hardware as if capable of transmitting
infection. Dispose of waste using proper precautions and in accordance with local regulations.

Wear suitable protective clothing, eyewear, and gloves.

4, Install a new air filter in the door.
Slide the new filter in from the right.
Note: Make sure to install the filter with the grid side facing out so that it is visible through the closed door.

[ T—

T
[

Grid side faces out Non-grid side faces in

5. Reinstall the cover and tighten the screw.

Upgrades for the AMO

Upgrade kits are available for the AMO to improve the efficiency of the system to clear aerosols that can be
produced during the sorting process. The components include a new tube holder top section with three holes
and a hydrophobic filter for the sort block door.

Contact BD Customer Support for information on the upgrade kits.
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Hydrophobic filter,
included with AMO

Sort block door

Troubleshooting the AMO

The tips in this section are provided to help you troubleshoot issues that arise when using the BD® Aerosol
Management Option. For cytometer-specific troubleshooting, see Troubleshooting (page 169).

If additional assistance is required, contact your local BD Biosciences technical support representative or
supplier.

A If any of the following are observed, assume that the AMO is not evacuating properly, and do not
open the doors to the sort chamber.
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Control Panel Troubleshooting

Observation

Possible Cause

Recommended Solution

Evacuator indicator
lights off

Evacuator power cord
unplugged

Connect the evacuator power cord to the power source.

Evacuator power
switched off

Switch on the evacuator main power.

Evacuator motor failure

Contact your local BD technical support representative.

Circuit breaker tripped

Depress the circuit breaker on the rear of the evacuator into its
original position.

Site power failure

Turn off the evacuator power switch and wait for site power to be
restored.

Evacuator indicator
lights pulsing

Erratic power source

Plug the power cord into a different outlet.

Arrow keys not
responding

Improper operation

Push each button firmly before removing your finger from the control.

Defective membrane
panel

Contact your local BD technical support representative.

Red filter-life indicator
light on

Approaching 180 hours
of filter use

Monitor the light. When it blinks, change the filter.

Filter life not reset after
filter change

After changing the filter, press and hold the Filter Life Reset button
until the 100% indicator light is lit.

Red filter-life indicator
blinking

Filter used over 180
hours

Replace the filter.
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Observation

Possible Cause

Recommended Solution

Zero reading on filter
flow gauge

Power off

Press the power button on the membrane panel of the
evacuator.

Filter defective

Replace the filter.

Filter improperly seated in
evacuator

Re-seat the filter with the evacuator power off.

Tubing loose or
not connected

Ensure that the tubing is securely connected below the sort
chamber and to the filter module.

Tubing kinked or damaged

Inspect the tubing for kinks or punctures. Replace the tubing, if
needed.

Wrong tubing type or part

Ensure that the correct type of tubing is in use.

Erratic reading on filter
flow gauge

Defective filter

Replace the filter.

Filter improperly seated in
evacuator

Re-seat the filter with the evacuator power off.

Off-scale reading on
filter flow gauge

Tubing or sort collection
chamber obstructed

« Inspect the tubing for kinks or punctures. Replace the
tubing, if needed.

o Check for obstructions in the sort collection chamber.
Remove any obstruction.

Filter clogged or saturated

Replace the filter as described in Replacing the ULPA filter
(page 197).

Specifications

Specifications for the BD® Aerosol Management Option are as follows.

Evacuator

e Greater than or equal to 7 CFM (ft3/min) normal operation rate (20% suction control)

e Greater than or equal to 30 CFM boost evacuation (100% suction control)

¢ <35 Ib unpacked weight

ULPA filter module
* VLSI grade

e Traps particles greater than or equal to 0.12 pm

e Three-stage filtration (pre-filter, ULPA, post-filter)

 Particulate removal efficiency >99.9995%

Air filter

* Filter medium is an open-cell polyurethane foam

¢ Medium specially coated for improved fire retardation and fungi resistance

¢ High dust-trapping capacity, low air resistance

203
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¢ Can be used in a wide variety of climatic conditions
* Rated UL 94 HF-1
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Biosafety Cabinet Option

The following topics are covered in this chapter:
» Biosafety cabinet overview (page 206)

e Aerosol Management System (page 210)

¢ Operating the AMS (page 211)

e Working in the BSC (page 213)

¢ Cleaning the base pan (page 214)

¢ Replacing the electronics cable plastic sleeve (page 216)
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Biosafety cabinet overview

The optional biosafety cabinet (BSC) is designed to be used with the BD FACSymphony™ S6 cell sorter, with the
sorting hardware located inside the BSC. Biosafety protection is provided by negative pressure and controlled
air flow within the cabinet. Before entering the work area or leaving the top of the cabinet, air passes through
high-efficiency particulate air (HEPA) filters. An integrated Aerosol Management System (AMS) operates
independently from the BSC blower and provides additional biosafety protection. The AMS evacuates the sort
chamber during sorting and exhausts that air through a separate HEPA filter. Air flow probes in the BSC and
AMS monitor exhaust air flow. An audible alarm is triggered if the air pressure differential (BSC) or air flow
(AMS) drops to and unsafe level.

17— AMS gauge and control panel

_-_._.=
- . [ BSC gauge and control panel

View screen

Sash

Armrest/bypass

ﬁ Operating the BD FACSymphony™ S6 cell sorter inside the BSC can generate temperatures above the
acceptable range of 17.5-22.5 °C (63.5-72.5 °F). Monitor the temperature inside the BSC to ensure

that it does not exceed this range.
An optional FlexAIR® canopy can be purchased to connect the BSC to an in-house exhaust system. The FlexAIR

canopy can help alleviate excess heat inside the BSC. Lowering the temperature inside the lab will also help
keep the temperature down.

FlexAIR canopy
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For safety information about the BSC, see the BD FACSymphony™ S6 cell sorter Safety and Limitations Guide.
Additional BSC information not contained in this guide can be found in The Baker Company Biosafety Cabinet
for BD FACSymphony™ S6 cell sorter Operator’'s Manual.

View screen

The view screen is made from safety plate glass and is the barrier between the BSC work area and the user.

¢ Maximum opening: The view screen can be opened to a maximum of 18 inches to allow temporary full
access to the work area.

e Minimum opening: The view screen can be fully closed.

Sash

The sash is the bottom edge of the view screen. Grip the sash and slowly:
* Pull down to close the view screen

¢ Push up to open the view screen

Safe Work access opening

ﬁ The safe work access opening is 8 inches, which provides biosafety protection. If the sash is raised
above 8 inches for more than 3 seconds, an alarm sounds.

The safe work access opening is marked by a red arrow located on both sides of the BSC frame. Ensure that the

sash is at this level each time you work in the BSC.
|| I |
I

View screen

Safe work access marker

H.

Sash
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Ready safe mode

The ready safe mode is an energy saving mode for when the BSC is not in use. To put the BSC in ready safe

mode:

» Keep the blower on.

¢ Lower the sash to fully close the view screen.

¢ Check the differential pressure gauge to verify that the pressure decreases. (See View screen (page 207) for
more information.)

We recommend that you leave the BSC in ready safe mode when it is not being used.

Cabinet gauge and controls

The BSC differential pressure gauge and cabinet controls are located on the front of the BSC in the lower right
corner. (The BSC and AMS controls are located on the same panel.) The BSC controls are on the right side of the
panel.

Differential pressure guage

Light

Blower

Alarm reset/mute

Cabinet controls panel

Alarm indicator LEDs

Differential pressure gauge

The differential pressure gauge displays the difference in air pressure inside the BSC vs outside the BSC,
measured in inch water column (inch WC). The reading should be the value obtained during certification +20%.
(See your BSC certification paperwork.) If the value drops below this level, the pressure alarm will sound and an
orange indicator LED will flash. See Buttons and LED indicators (page 208).

Buttons and LED indicators

The following table describes the function of the BSC control buttons and the meaning of the LED indicators
located above each button.
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Button | Function LED LED color | Comments
indicates
Light Turns the light on and off Power is on | Blue Two fluorescent lamps light the work area.
Blower Turns the blower on and off Power is on | Green The blower creates the air flow patterns
inside the BSC.
Power Flashing -
is off green
Alarm Mutes the alarm for 5 minutes or | See LED alarm indicators (page 209).
resets it

LED alarm indicators

LED indicators to the right of the Alarm button are illuminated when there is an alarm condition.The following
table describes the LEDs and conditions that trigger them.

Alarm LED Color Condition
Sash Flashingred | ¢ The sash is raised above the 8-inch safe opening height.
e The sash is lowered to fully close the view screen (until pressure decreases).

Pressure Flashing e The air pressure differential drops to an unsafe exhaust airflow level.

orange « The air pressure differential has not reached the proper level. (This occurs when the

blower is first turned on.)

Solid orange | The air pressure problem was corrected. Press the alarm button to reset the alarm.
FlexAIRC (if Flashing The air flow through the canopy drops to an unsafe level.
installed) yellow

Audible alarms

An LED indicator to the right of the alarm button is illuminated when there is an alarm condition. Audible
alarms differ for each alarm type. The following table describes the alarms and conditions that trigger them.

LED Audible Alarm Condition
Indicator
Sash Sounds once per second. The sash is positioned at an unsafe level for more than 3 seconds.
Pressure Sounds four times per second o The air pressure differential drops to an unsafe exhaust air
followed by a two-second delay. flow level.
o The air pressure differential has not reached the proper level.
(This occurs when the blower is first turned on.)
FlexAIRP Sounds two times per second. The air flow through the canopy drops to an unsafe level.
(if installed)

%The optional FlexAIR canopy can be purchased to connect the BSC to an in-house exhaust system.

bThe optional FlexAIR canopy can be purchased to connect the BSC to an in-house exhaust system.
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For detailed instructions on how to use the BSC, what the alarm conditions indicate, and how to reset them, see
The Baker Company Biosafety Cabinet for BD FACSymphony™ S6 cell sorter Operator’s Manual.

Aerosol Management System

An AMS is incorporated into the BSC to rapidly evacuate aerosolized particles from the sort collection chamber
during sorting or analysis. Equipped with a separate HEPA filter, the AMS operates independently of the BSC.
The AMS will continue to operate if the BSC blower fails, providing an additional level of biosafety protection.

AMS gauge and controls

The AMS air flow gauge and controls are located on the front of the BSC in the lower right corner, to the left of
the BSC controls.

Air flow gauge

AMS on/High

AMS on/Low

AMS off

Air flow gauge

The air flow gauge indicates the amount of suction being applied to evacuate the sort collection chamber and
the aspirator drawer. The air flow is measured in CFM.

The air flow value should be:
e Low: 14 CFM 1 CFM
¢ High: >26 CFM

See Buttons and LED indicators (page 210) and Audible alarms (page 211).

Buttons and LED indicators

The following table describes the functions of the AMS control buttons and the meaning of the LED indicators
located above each button.
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Button Function LED Comments
Color
AMS off Turns the AMS off Blue Turn the AMS off when it is not in
use.
AMS on/Low | Turns the AMS and low suction on. Turns low suction Blue Use low suction during normal
off. sorting.
AMS Turns the AMS and high suction on. Turns high suction | Blue Use high suction while removing a
on/High off. clog.

Audible alarms

An LED indicator will flash above the corresponding button when there is an alarm condition. The following
table describes the meaning of the LED indicators and the alarms and conditions that trigger them.

LED LED Color | Audible Condition

Indicator Alarm?

AMS Flashing Yes The air flow is outside the range of 14 +1 CFM. (This also occurs when the
on/Low orange AMS is first turned on.)

AMS Flashing Yes The air flow is <26 CFM. (This also occurs when the AMS is first turned on.)
on/High orange

Operating the AMS

A@ The AMS does not eliminate the health risks of working with biohazardous material and must be used

in conjunction with good laboratory practice.

1. To turn on the AMS, press either the Low or the High button.

¢ A blue indicator LED is illuminated over the button.

¢ The air flow gauge goes through a startup sequence and then equilibrates.
2. Operate the AMS in:

¢ Low during normal sorting.

¢ High while removing a clog. See Responding to a nozzle clog during a sort (page 211) to troubleshoot a
nozzle clog.

3. Press the AMS Off button to turn off the AMS.
¢ A blue indicator LED is illuminated over the AMS off button.

¢ The flow air gauge shuts off.

Responding to a nozzle clog during a sort

If the stream is disturbed during the sort (due in part to a clogged nozzle), the sort is designed to stop
automatically and block the sort tubes (if the Sweet Spot is on). The sort will not restart until the operator has
cleared the clog. In the event of a nozzle clog, do not open the sort collection chamber door or access the sort
tubes before following this procedure.

211
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A@ Cell sorters that use droplet generation methods, such as the BD FACSymphony™ S6 cell sorter, can

produce aerosols around the sample stream. When acquiring biohazardous samples, follow universal
precautions at all times. Keep the sort block door and the sort collection chamber door closed during
sorting. Follow these steps to stop sample flow and evacuate potential aerosols before opening the

sort collection chamber door.

To clear a clogged nozzle on a system with the AMS:

1.
2.

Keep the sort chamber door closed.

If the stream has not already shut down automatically, turn off the stream by clicking the Stream button
(with a checkmark) at the top of the Breakoff window.

This will shut off the stream, unload the sample, and close the aspirator drawer.

Increase the air evacuation rate to high.

4. Open the aspirator drawer using the software controls.

10.
11.

12.

13.
14.

15.
16.
17.

Wait at least 60 seconds.

This procedure will clear aerosols from the sort chamber.

Close the aspirator drawer.

Turn on the stream and view the breakoff.

If the clog is removed, the breakoff will be similar to the breakoff before the clog.

If the clog is not cleared, turn the stream on and off several times to see if the clog has cleared.

If the clog is not removed, turn the stream off and perform the Clean Flow Cell procedure with DI water (see
Cleaning the flow cell (daily) (page 140)), followed by turning the stream on to see if the clog has cleared.

Open the aspirator drawer and evacuate for at least 60 seconds before closing the aspirator drawer again.

You can now open the sort collection chamber and remove the sort collection device. Be aware that the
surfaces of the device are potentially contaminated.

‘@ All cytometer surfaces that come in contact with biological specimens can transmit potentially
fatal disease. Use universal precautions when cleaning cytometer surfaces. Wear suitable

protective clothing, eyewear, and gloves.

If it is necessary to change nozzles or remove a clog from a nozzle, see Cleaning the integrated nozzle (page
156).

With stream turned off, open the sort block door and dry the plates and surfaces as needed.

When removing collection tubes, be aware that the outside of the tube is potentially contaminated. Use
alcohol swabs or bleach to wipe the outsides of tubes.

Press the AMS Low button.

Make sure that all chamber doors are closed and restart the stream.
Perform these tasks if needed:

e Turn on the Sweet Spot

¢ Check the drop delay

¢ Check the side stream deflection
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Working in the BSC

When working inside the BSC, we recommend that you:

¢ Keep the blower on at all times.

¢ Keep the AMS on while sorting.

« Keep the view screen closed to the safe-access opening of 8 inches each time you work in the BSC.

¢ Do not work in the BSC if an alarm sounds and the corresponding indicator is illuminated. See the The Baker
Company Biosafety Cabinet for BD FACSymphony™ S6 cell sorter Operator’s Manual for troubleshooting
information. If additional assistance is required, contact your local BD Biosciences technical support
representative or supplier.

¢ Do not block the intake grilles or the diffusers because it obstructs air flow.
Note: Consult a qualified safety professional for decontamination procedures appropriate for you
laboratory.
¢ Decontaminate the BSC and cytometer before:
© Turning off the blower.
° Having maintenance or service performed.

¢ Keep the blower on at all times and keep the view screen closed when the BSC is not being used, especially if
you want the inside of the BSC to remain contamination-free.

¢ Use an adjustable chair for comfort.

Cleaning the BSC

Use this procedure to clean the BSC after sorting potentially infectious agents.

Materials

¢ 10% chlorine bleach (0.5% sodium hypochlorite) solution

Q Bleach can cause stainless steel to pit and crack. Ensure that you wipe down the BSC with 70%
isopropyl alcohol to remove the bleach solution.

e 70% isopropyl alcohol
e Paper towels

Procedure

A@ Any surface that comes in contact with biological specimens can transmit potentially fatal disease.
Use universal precautions when cleaning the BSC. Wear suitable protective clothing, eyewear, and
gloves.
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To clean the BSC:
1. Wipe down the following areas using paper towels and 10% bleach (0.5% sodium hypochlorite) solution:
¢ Floor of the BSC in front of the cytometer, and on each side
¢ Inside and outside surfaces of the view screen
e Armrest/bypass
¢ Cabinet Controls panel
¢ Any other areas that might be contaminated

2. Repeat step 1 using 70% isopropyl alcohol.

Cleaning the base pan

Note: Before cleaning the base pan, clean the inside of the BSC. See Cleaning the BSC (page 213).

Use the following procedure to clean the base pan.

Materials
¢ 10% chlorine bleach (0.5% sodium hypochlorite)

Q Bleach can cause stainless steel to pit and crack. Ensure that you wipe down the BSC with 70%
isopropyl alcohol to remove the bleach solution.

e 70% isopropyl alcohol
e Paper towels

¢ A cleaning tool to reach into the base pan

Procedure

‘@ Any surface that comes in contact with biological specimens can transmit potentially fatal disease.
Use universal precautions when cleaning the base pan. Wear suitable protective clothing, eyewear,
and gloves.
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To clean the BSC:

1. Press in on the armrest/bypass and lift it up.

} Armrest/bypass

Remove the armrest/bypass.
Wipe down the armrest/bypass using paper towels and 10% bleach (0.5% sodium hypochlorite) solution.
Wipe down the armrest/bypass using paper towels and 70% isopropy! alcohol.

Set the armrest/bypass aside.

o v &~ W N

Wipe down the base pan using a cleaning tool and a 10% bleach (0.5% sodium hypochlorite) solution.
Ensure that you also wipe down the areas underneath the electronic cables.

7. Wipe down the base pan using a cleaning tool and 70% isopropyl alcohol.
8. Check the position of the tabs above the base pan on either side of the BSC.

Tab on left side of BSC
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9. Reinstall the armrest/bypass by sliding it into position over the tabs.

A
10. Lock the armrest/bypass into place by pushing it down and back so that the bottom snaps into place behind
the lip of the base pan.

Replacing the electronics cable plastic sleeve

Some of the electronics cables for the BD FACSymphony™ S6 cell sorter are located under the cytometer in the
base pan. The cables are wrapped in plastic sleeves to protect the cables from exposure to liquids. When
cleaning the base pan, check the plastic sleeves and replace them as necessary. Replacements are located in

the spares kit.

To replace the plastic sleeves:
1. Remove the armrest/bypass by following step 1 through step 5 in Cleaning the base pan (page 214).
2. Check the plastic sleeves covering the electronic cables in the left and right sides of the base pan.

3. If necessary, remove the plastic sleeves by carefully removing the ties at each end of the sleeve and peeling
off the plastic sleeve.
4. Wrap the cable bundles with new plastic sleeves and secure with ties at each end.
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BD FACSymphony™ S6 Temperature Control
Option

The BD FACSymphony™ S6 Temperature Control Option can be used to control the temperature of sorted
samples in the BD FACSymphony™ S6 cell sorter flow cytometer.

The following topics are described:

¢ Option components (page 218)

¢ Using the BD FACSymphony™ S6 Temperature Control Option (page 219)
¢ Maintenance (page 222)

* Specifications (page 223)
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Option components

The BD FACSymphony™ S6 Temperature Control Option includes the following:

¢ Arecirculating water bath

 Specially designed collection tube holders with ports for recirculating water

Tube holders are available in these styles: two-way 15-mL, four-way 12 x 75-mm, four-way 1.5-mL Eppendorf,
and six-way 12 x 75-mm tubes.

—— T
— -t II
s 1

: Two-way 15 mL

: Four-way 12 x 75 mm

: Four-way 1.5 mL Eppendorf

Water bath

Six-way 12 x 75 mm

& When acquiring biohazardous samples, follow universal precautions at all times. Keep the sort block
door and the sort collection chamber door closed during sorting. When sorting biohazardous samples
into the temperature control tube holders, we recommend that you use the BD® Aerosol
Management Option (for systems without a BSC) or the BD® Aerosol Management System (for
systems with a BSC). If the nozzle develops a clog, see Responding to a nozzle clog during a sort with
the AMO (page 195) or Responding to a nozzle clog during a sort (page 211) (for systems with the
AMS).

The BD FACSymphony™ S6 Temperature Control Option is for research use only. It is not for use in diagnostic or
therapeutic procedures.
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Using the BD FACSymphony™ S6 Temperature Control
Option

Note: Before you start the recirculating water bath, you must attach the tubing to the appropriate collection
device.

Setting up the water bath

1. Remove the threaded plug from the output port on the water bath.

2. Ensure that the drain cock on the back of the water bath is closed by turning it fully clockwise.
3. Set the pump outflow to maximum by turning the knob fully counter-clockwise.

Remove the top cover to access the knob, which is located inside the water bath toward the back. See the
operating instructions supplied with the water bath for additional details on this process. This is referred to
as position 1.

4. Connect the clear tubing end of the insulated hoses to the input and output ports on the water bath.

Slide the tubing over the hose barbs and twist gently while installing to get the tubing completely over the
barbs.

5. Connect the insulated hoses from the recirculating water bath to the ports on the right side of the
cytometer base.

Note: Because the water flow direction is controlled by the water bath pump, the ports on the cytometer
base are multi-directional. The input and output hoses from the water bath can be connected to either port
on the cytometer base.

6. Fill the water bath with distilled water containing 0.1 g/L of sodium carbonate.
Sodium carbonate helps reduce corrosion. See the water bath manufacturer's documentation for fill levels
and other setup information.
Note: We do not recommend using ethylene glycol (antifreeze) in the water bath.

7. Plug in the water bath power cord.
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Do not start up the water bath until after you have connected the recirculating water tubing, as described in
the following sections.

Setting up the tube holder

This section describes how to install the temperature control tube holder on the instrument and how to attach
the recirculating water tubing to the tube holder.

A@ Any instrument surface that comes in contact with biological specimens can transmit potentially
fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective

clothing and gloves.

Place collection tubes in the temperature control tube holder.
2. Attach the recirculating water tubing to the tube holder.
a. Open the sort collection chamber door.

NOTE The tubing ports are labeled In and Out. Attach the input tubing to the port on the left side of
the collection tube holder, and the output tubing to the port on the right side.

b. To attach the tubing, push it into the port until the tubing snaps into place.
Input tubing Output tubing

k |
\ { — T

Tubing ports inside collection chamber

If you need to remove the tubing, push in the orange collar as you pull the tubing out of the port.
Install the tube holder on the instrument.
Install the temperature control tube holder.

5. Close the sort collection chamber door and start up the water bath.

Setting up the ACDU stage

This section describes how to attach the recirculating water tubing to the stage used with the automated cell
deposition unit (ACDU).

A@ Any instrument surface that comes in contact with biological specimens can transmit potentially

fatal disease. Use universal precautions when handling sorting hardware. Wear suitable protective

clothing, eyewear, and gloves.

1. Install the splash shield below the aspirator drawer.

a. Close the sort block door and open the sort collection chamber door, if needed. (The sort block door must
be closed to open the collection chamber door.)

b. Remove the tube holder, if one is installed.
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c. Insert the splash shield into the slotted fittings below the sort aspirator drawer. Push the splash shield all
the way in.

2. Click the Access Stage button to bring the ACDU stage to the front.
a. Open an experiment, if one is not already open, and create a sort layout for any of the tubes.

b. Inthe Sort Layout view, click the Access Stage button to move the stage to the front of the sort
collection chamber.

3. Attach the recirculating water tubing to the ACDU stage.

Note: The tubing ports are labeled In and Out. Attach the input tubing to the port on the left side of the
stage, and the output tubing to the port on the right side.

To attach the tubing, push it into the port until the tubing snaps into place.

Tubing ports

Input tubing Output tubing
If you need to remove the tubing, push in the orange collar as you pull the tubing out of the port.
4. Install the appropriate collection device on the stage.
5. Close the sort collection chamber door and start up the water bath.

Starting up the water bath

Note: To ensure that the sample collection device is at the correct temperature, start up the water bath (115-V
and 110-V models) at least 90 minutes before you start sorting.

1. Switch on the main power on the water bath control panel.

Main power
switch
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2. Use the up or down arrow keys to set the required temperature.

Note: To achieve the required sample temperature, you will need to set the water bath temperature slightly
higher or lower as shown in the following table. These settings might need adjustment depending on the
ambient temperature in your laboratory. We recommend that you calibrate the water bath for your
operating environment.

Required Sample Water Bath Setting (°C) at Room Water Bath Setting (°C) at Room
Temp (°C) Temperature of 15 °C Temperature of 30 °C

4 2 2

37 43 41

42 52 45

3. Wait at least 90 minutes to allow the recirculating water to reach the required temperature. The duration
may be longer if switching over a large temperature range or when attempting to cool the sample.

Maintenance

To maintain the recirculating water bath, see the documentation provided by the manufacturer.

Tube holders

Remove the tube holders when you are finished using them, and clean them periodically before storage.

A When you detach the recirculating water tubing from the tube holder, any fluid remaining in the
tubing can leak into the sort collection chamber. To ensure that fluid is aspirated from the sort
collection chamber, make sure that the sort chamber aspirator pump is on (do not turn off the
instrument main power) before you detach the tubing. Use caution when handling tubing containing
hot water.

To detach the recirculating water tubing, push in the orange collar as you pull the tubing out of the port.
Clean the temperature control tube holders by wiping them down with an appropriate cleaning fluid (for
example, 70% ethanol, 5% bleach, or DI water). Dry them with a lint-free cloth before storage.
Recirculating water tubing

Inspect the tubing periodically for leaks, plugs, or contaminants. If needed, remove the tubing and clean it with
an appropriate cleaning solution, or replace the tubing. Contact your BD Biosciences service representative for
replacement tubing.
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Specifications

Specifications for the recirculating water bath are as follows.

Note: The following specifications are for the US version only.

The BD FACSymphony™ S6 Temperature Control Option includes the Lauda® Ecoline cooling/heating bath,
model RE 106.

¢ Operating temperature range: —20-+20 °C

e Ambient temperature range: 5-40 °C

¢ Heater power for 115 V/60 Hz: 1.3 kW

¢ Maximum flow rate at pump output of 5: 17 L/min

¢ Maximum bath volume: 4-6 L

e Power consumption for 115 V/60 Hz: 1.4 kW

For more information, see the manufacturer’s documentation.
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containers 15

holders
controls 56 collection tube 22,121, 220
daily shutdown 140 sample tube 18
level indicators 58 Home Device 70, 133-134
power 29 hydrodynamic focusing 35
shutdown 57, 142
startup 34, 56,90 I
system 34 . :
> index sorting
fluidics cart .
description 136
cord 91 ]
setting up for 136
power 29

Initial mode 53



installing

collection tube holders 121, 220

nozzle 155

plates 132, 221

sample line filter 159

sample tubes 18

slides 132, 221

splash shield 132
instrument See cytometer 13
integrated nozzle

about 19

changing 155

cleaning 156

replacing seal 158
interrogation point 19

L

label-specific tubes 109
labels, parameter 112
labware, parts list 190
lasers

about 26

delay 42,116

diode 49

shutting down 140, 143

starting 88

warmup time 88
layout See sort layouts 73
leaks, troubleshooting 181
LED indicators

AMS 210

BSC 209
lens, strobe 164
levels

fluid 58

sample 17
lever, nozzle 91, 156
light

injection chamber 17

scatter signals 36

voltage warning 20
limitations 9

Link & Save 111
Load button 68
loading tubes 18, 35
long clean 181
longpass filters 38

M

maintenance
AMO 196
BSC 213
scheduled 144
temperature control option 222
unscheduled 155
managing aerosols 21
AMO 193
AMS 211
Masks
about 50
default precision modes 52
Phase 51
Purity 51
Yield 50
Master DAQ overflow error 182
micrometer dial 125-126
mirrors, dichroic 38
mismatch dialog
configuration 103
modes
defining 53
deleting 54
sort precision 50, 52
monitoring sorts 75, 129

N

ND filters 39, 168
neutral density filters 39, 168
nozzles

about 19

changing 155

cleaning 156

integrated 19

lever 91,156

Index

231



232 | BD FACSymphony™ S6 Cell Sorter User Guide
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